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Introduction 

The Ecopath with Ecosim (EwE) approach and modelling framework is designed for 
straightforward construction, parameterization and analysis of mass-balance trophic models of 
aquatic and terrestrial ecosystems. Focus is on using the models for fisheries management, and a 
suite of tools are included for this aim. This User Guide describes how to use the Ecopath software 
system, while background information and theory is available in an accompanying textbook. 

The Ecopath mass-balance modelling system is built on an approach initially presented by J.J. 
Polovina for estimating biomass and food consumption of the elements (species or groups of 
species) of an aquatic ecosystem. Subsequently it was combined with various approaches from 
theoretical ecology, notably those proposed by R.E. Ulanowicz, for the analysis of flows between 
the elements of ecosystems. However, the system has been developed much further, including 
for direct use in fisheries management and for addressing environmental questions including 
climate change through the inclusion of the temporal dynamic model, Ecosim, the spatial dynamic 
model, Ecospace, and the Ecotracer model for tracking persistent compounds.  EwE is now used 
increasingly in multi-disciplinary settings, including for a wider range of application as illustrated 
below. 
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The development of EwE is coordinated by the Ecopath International Research and Development Consortium 
through the Ecopath International Initiative in Barcelona. 
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Licensing Information 

This work is licensed under a CC-BY-NC-SA license 

 

You are free to: 

• Share — copy and redistribute the material in any medium or format 
• Adapt — remix, transform, and build upon the material for any purpose, even commercially. 

The licensor cannot revoke these freedoms as long as you follow the license terms. 

Under the following terms: 

• Attribution — You must give appropriate credit, provide a link to the license, and indicate if 
changes were made. You may do so in any reasonable manner, but not in any way that 
suggests the licensor endorses you or your use. 

• NonCommercial — You may not use the material for commercial purposes. 
• ShareAlike — If you remix, transform, or build upon the material, you must distribute your 

contributions under the same license as the original. 

No additional restrictions — You may not apply legal terms or technological measures that legally 
restrict others from doing anything the license permits. 

Adaption 

This book is adapted from the unpublished EwE User Guide (2008) by Christensen V, C Walters, 
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D Pauly, R Forrest. Ecopath with Ecosim unless otherwise noted under the chapter “Adaption” 
heading. 

Citation 

Christensen V and Steenbeek J. User Guide for Ecopath with Ecosim (EwE). Vancouver, BC: The 
University of British Columbia. Available from https://pressbooks.bccampus.ca/eweguide/. 
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Disclaimers 

The user guide provided herewith pertains to Ecopath with Ecosim (EwE), an open-source 
ecosystem modeling software tool. It is essential to recognize the limitations and boundaries 
associated with both this document and the software itself. 

1. No Warranty: This user guide is furnished “as is,” without any representation or warranty, 
whether expressed or implied. The developers, contributors, and maintainers of EwE make 
no guarantee regarding the accuracy, reliability, or adequacy of the content within this guide. 
Users are solely accountable for their actions based on the information provided. 

2. Software Dynamics: EwE is an ever-evolving open-source project, and its attributes, 
functions, and interface may undergo modifications over time. While endeavors have been 
made to ensure the relevance of this user guide, it might not reflect the latest version of the 
software. Users are encouraged to consult the official EwE documentation and community 
resources for the most up-to-date information. 

3. Use at Your Discretion: The use of EwE involves inherent risks, encompassing potential data 
loss, system instability, and security vulnerabilities. Users must exercise prudence and 
implement proper safeguards before utilizing the software for production or with critical 
data. The developers and contributors disclaim responsibility for any damages, losses, or 
liabilities stemming from the utilization of EwE. 

4. Third-Party Contributions: This user guide could reference third-party websites, resources, 
and tools. These references are furnished solely for convenience and informative purposes. 
The developers and contributors do not endorse, control, or guarantee the accuracy or 
dependability of third-party content. Users should exercise their judgment when accessing 
such content. 

5. Community Support: EwE receives support from a community of volunteers and 
contributors who may provide assistance through forums, chats, and similar platforms. 
Although community members strive to furnish valuable advice, their suggestions may not 
universally suit every circumstance or be entirely accurate. Users should validate advice 
received and make informed decisions. 

6. Software Modifications and Distribution: EwE is distributed under an open-source license, 
allowing users to modify and distribute it. However, any modifications or distributions are 
subject to the terms of the pertinent open-source license. Users must understand and 
comply with the license terms before making modifications or distributing the software. 

In conclusion, this user guide endeavors to enhance user comprehension of EwE. However, users 
must exercise caution, diligence, and consider seeking professional guidance when suitable. The 
use of EwE signifies users’ acknowledgment and acceptance of the terms of this disclaimer. 
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For the most precise and current information, please consult the official EwE documentation and 
community resources. 

EwE is a collaborative result of the open-source community’s contributions and dedication. We 
appreciate your understanding, contributions, and feedback. 

On behalf of the Ecopath International Inititative & the Ecopath Research and Development 
Consortium, 

Villy Christensen & Jeroen Steenbeek 
09 August 2023 

This text was generated in part with GPT-3, OpenAI’s large-scale language-generation model. Upon 
generating draft language, the editors reviewed, edited, and revised the language to their own liking and 
takes ultimate responsibility for the content. 
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Getting Started 

How to Obtain the Ecopath with Ecosim Software 

The setup programme for Ecopath with Ecosim 6 (EwE6) can be downloaded from 
www.ecopath.org. Simply download the setup file and follow the prompts. 

Software Support, Copyright and Liability 

The software is copyrighted but not copy-protected. You may freely copy and distribute the 
program as long as this is not done commercially. 

Installing and Running Ecopath with Ecosim 

Installation is done via a customized third-party setup program. Simply click on the link to the 
setup programme on the Ecopath website (www.ecopath.org) and choose Run. Some browsers will 
give a warning that the software is from an unknown publisher, click Run if you get this warning. 
Then follow the prompts to for installing the software. 

When installing, note that there are options for installing plug-in (utilities providing extra 
capabilities) – check those you want installed. 

Currently EwE6 will only run only on the Windows platforms. For Mac/Linux versions we 
recommend the Parallel virtualization software, it provides a straightforward and easy-to-use-
and-maintain approach for running EwE smoothly. Unfortunately, it is not free. 

We are working to raise funds for a new version of EwE (7), and are committed to making that 
version platform independent. 

If you have any other problems with installation, please contact us through the user support 
section of www.ecopath.org. 
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Previous Versions 

Any model built using a version of EwE5 later than version 1.67 can be converted to EwE6 format 
using the Ecopath database conversion wizard. 
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ECOPATH 
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Ecopath Input 

The first task in building an ecosystem model is to clearly define the question(s) that the model is 
to answer. Once this is in place, it becomes much clearer what the model structure should be like. 
Assuming that is done, you can go ahead with the practical aspects of getting your model defined 
in EwE. That’s what this chapter deals with. 

Before entering data, you are encouraged to read the introductory material on the mass balance 
approach to ecosystem modelling for information about how the input parameters are used in the 
model. 

Be aware that generally, leaving an input blank on a data entry form implies it is unknown. For 
some required parameters defaults are supplied and leaving such in place means accepting the 
default values. This is for instance the case for biomass accumulation, detritus import, landings, 
discards, migrations and prices (for all of which the default value is 0). You should be aware that 
opting for default values is as much a modelling decision as setting values – default values will 
not necessarily be appropriate for your model.  But one upside is that you generally don’t have to 
explain the EwE default values when publishing your model. 

Model Parameters 

The Ecopath > Input > Model parameters form is used to define some basic settings and record 
basic information about your model. 

Model 

This descriptive part is for recording some basic information, including the model area (in km2). 
All model stock sizes and flow rates are expressed per unit area (km-2), and stock and flow 
calculations in Ecopath, Ecosim, Ecospace and Ecotracer are all expressed per that unit area. 
There is, however, one exception. The value chain analysis works with quantities, so it, e.g., sums 
of how much the landings (in t km-2 year-1) are for the ecosystem in question and then multiplies 
this with the model area (km-2) to get the quantity (t year-1). The value chain will then work with 
these quantities for all calculations. It makes sense, once the seafood is landed, the quantity is 
what matters, not how big the area was it came from or what the densities were in that area. 
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The spatial extent (N, S, W and E) can also be entered here. If this is done, the area will be known 
in Ecospace where it is used to calculate the cell dimensions considering the model latitude. 

Classification 

If values are selected here from the drop down listings, the information can be used by the 
ecosystem model collection in Ecobase, Related, when you  have published an Ecopath model, you 
are strongly encouraged to submit it to Ecobase. This can be done from the menu File > Export 
model > To Ecobase. Ecobase models are available at www.ecobase.ecopath.org and can also be 
downloaded directly from File > Import model > From Ecobase. 

Basic Input 

We provide only a cursory introduction and explanations for the various input fields as many are 
self-explanatory. 

Define Groups 

You must define whether a functional group is a primary producer, consumer or detritus by 
checking the appropriate box. 

• Primary producers (producers) obtain all of their energy from photosynthesis. By definition, 
their trophic level is 1. 

• Consumers obtain their energy by consuming other organisms. They have trophic level > 1. 
• You must enter at least one detritus group and you can have as many detritus groups as you 

like. Detritus groups must be placed after all living groups (i.e., they must have a higher 
group number than the last living group). You must also specify where the surplus detritus 
(left over after feeding by detritivores) will go using the Ecopath > input > Detritus fate form. 

Define Multi-Stanza Groups 

The Edit groups form allows you to create groups representing life history stages or stanzas for 
species that have complex trophic ontogeny. 
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To define a multi-stanza group, add the stanzas as separate groups using the Insert button. Note 
that each stanza must have a unique group name (e.g., Juvenile cod; Adult cod). Name the multi-
stanza group as a whole (e.g., Cod) in the Multi-stanza group name column. Once you have created 
a multi-stanza group name, it is added to a pull-down menu in the Multi-stanza group name 
column. Enter the start-age of each stanza in months in the Stanza age (in months) column. Note 
that your youngest stanza must have a start-age of zero months. If you do not have an age-zero 
stanza, Ecopath will set the youngest stanza’s start age to zero (a message box will inform you of 
this). After defining a multi-stanza group(s), you must set the values of additional parameters for 
the group(s). 

Edit Multi-Stanza Groups 

Multi-stanza groups represent life history stages or stanzas for species that have complex trophic 
ontogeny. Mortality rates (M0, predation, fishing) and diet composition are assumed to be similar 
for individuals within each stanza (e.g., larvae having high mortality and feeding on zooplankton, 
juveniles having lower mortality and feeding on benthic insects, adults having still lower mortality 
and feeding on fish). For Ecosim and Ecospace it is advised to split groups of special interest 
into multi-stanza groups as this makes their dynamics more realistic, provides insights on stock-
recruitment relationships, and allows consideration of stanza-specific habitat use. 

Once you have defined a multi-stanza group(s) you must go to the Ecopath > Input > Basic Input 
> Edit multi-stanza form to set the parameters needed to calculate the biomass and numbers in 
each age category. 

You must enter baseline estimates of total mortality rate Z (i.e., P/B) and diet composition for each 
stanza, and biomass and consumption/biomass ratio (Q/B) for one ‘leading’ stanza only (can be 
any stanza). Biomass and consumption are then computed for the other stanzas, assuming a stable 
age distribution. 
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Figure 1 – Ecopath > Input > Basic input > Edit multi-stanza form used for parameterizing multi-stanza groups. 
Input includes a (leading) biomass for one stanza, and a (leading) Q/B for one stanza. The remaining biomasses 
and Q/B are then calculated to ensure consistency. Setting the spawning (proportion) to 0 ensures that the 
stanza will not spawn even if the stanza reaches Wmaturity. 

Curvature Parameter, K 

Set the von Bertalanffy growth rate. Note that it is assumed that body growth for the species as a 
whole follows a von Bertalanffy growth curve with weight proportional to length-cubed. 

Recruitment Power 

This parameter is used by Ecosim and sets the degree of density dependence in juvenile survival 
for juveniles outside the modelled area.Set a low value, (e.g., 0.1-0.5) for this parameter if the 
juveniles for a group spend some time ‘outside’ the system in a nursery area where they are 
subject to density-dependent juvenile mortality rate, (e.g., juvenile Pacific salmon abundance may 
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be limited by freshwater nursery habitat, so that numbers recruiting to a coastal oceanic area can 
be practically independent of adult abundance in the oceanic area, especially if juvenile production 
is ‘enhanced’ by hatchery systems). 

Note that you should not need to change other basic parameters defining trophic ontogeny for 
split groups. When it is the very early juvenile stage that is spent in some rearing habitat outside 
your modelled area (e.g. a stream or coastal lagoon), you may model the effect of limiting factors 
within that rearing habitat just by adjusting the recruitment power parameter, without bothering 
to accountfactors such as ‘Import’ of food to the juvenile biomass while juveniles are in the rearing 
area (cumulative effect of such trophic development are automatically calculated when scaling 
the juvenile body sizes within Ecosim based on Ecopath juvenile pool biomass).You can also use 
a low recruitment power parameter to make juvenile recruitment ‘flat’ with respect to modelled 
adult biomass due to recruitment of juveniles from some adult population ‘egg source’ outside the 
modelled area. 

Recruitment Stanza 

Is used only for coupled stanza groups, where, e.g., males and females are modelled as separate 
stanza groups, (see linked stanza recruitment). In that case one can let the recruitment of males be 
a function of the abundance of spawning females. We’ve used that to model crabs where fisheries 
only retains males. 

Relative Biomass Accumulation Rate (BA/B) 

The BA/B term represents effect on the numbers at age of the population growth rate, (e.g., the 
cohort born one year ago should be smaller by the factor exp(-a BA/B) than the cohort born a 
years ago. 

Wmaturity/Winf 

Set the mean weight at maturity relative to w∞. Note that it is assumed that body growth for the 
species as a whole follows a von Bertalanffy growth curve with weight proportional to length-
cubed. 
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Forcing Function Number for Hatchery Stocking 

Multi-stanza populations can be designated as hatchery populations, and hatchery production 
can be varied over time in Ecosim using time forcing functions. To turn off natural reproduction 
select the hatchery forcing function from the pull-down menu in the Forcing function number 
for hatchery stocking box. For this, you must already have a forcing time series loaded in Ecosim. 
Forcing functions to represent historical changes in stocking rates can be entered via the same 
CSV files as used to set up historical fishing and model fitting scenarios. Enter stocking rates as 
values relative to the stocking rate of 1.0 assumed for the Ecopath base year. 

At each simulation time step, the base recruitment for the population (calculated from Ecopath 
input parameters) will be multiplied by the current time value for the designated forcing function. 
If it is desired to simulate stocking of older fish (e.g., 18 months), the first stanza for the population 
should be set to have this duration, the mortality rate (Z or P/B) for the stanza should be set to 
0.001, and the diet for the stanza should be set to 1.0 imported (i.e., no feeding in the modelled 
ecosystem). 

Fixed Fecundity 

Some types of organism (e.g., marine mammals or some sharks) may have a fixed number of 
young each year, regardless of adult bodyweight. Checking the Fixed fecundity check box fixes the 
number of recruits. 

Biomass 

You must enter estimated absolute biomass (in appropriate units) for one ‘leading’ stanza. 

Z (Production/Biomass) 

You must enter estimated total mortality rates for each stanza. 
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Consumption/Biomass 

You must enter estimated consumption/biomass (Q/B) for one ‘leading’ stanza. 

Habitat Area 

This is the fraction of the total area in which the group occurs, that is, the fraction of the total 
area to which the biomass in habitat area pertains. Default is that the habitat area is 1, i.e. that the 
group occurs in the total area. 

Biomass in Habitat Area 

The average biomass per unit area in the habitat area where the group occurs. It is assumed that 
an average value can be used to represent the biomass of each group. Appropriate units should 
be used, (e.g., t km-2) for the biomasses. Entry of biomasses is optional for living groups, but 
biomass(es) should be entered for the detritus group(s). However, if biomasses are unknown for 
all living groups and there are no exports from any of the groups, it is necessary to enter at least 
one biomass estimate, preferably of a top predator. (But in such a hypothetical case: what is the 
purpose of that model?) 

Biomasses should be entered relative to the habitat area where the group occurs. An example: 
assume a species for instance has a biomass of 1 t km-2 in its habitat area, and the habitat area is 
100 km², while the total area in your model is 1000 km². You could then enter a habitat area of 0.1 
and a biomass in habitat area of 1 t km–² as the biomass for the group in your model. 

Biomass 

This is the Biomass in habitat area x Habitat area. 

Production/Biomass 

Enter the Production/Biomass (P/B) ratio for each group using consistent units, e.g., per year. The 
P/B ratio is equivalent to the instantaneous rate of total mortality (Z) used in fisheries assessments 
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1(Allen 1971). Entry of P/B ratios is optional, but should as a rule be entered – don’t leave it to 
estimation using the mass-balancing routine. 

Production includes fishery yield (considered export in network analysis) plus predation plus net 
migration plus biomass change plus other mortality; or as expressed in the second Ecopath Master 
Equation, 

Estimation of P/B is discussed in the EwE textbook 

Consumption/Biomass 

Consumption/biomass (Q/B) ratios are entered using the same units as for P/B. Entry of 
consumption/biomass ratios is optional, but it is strongly advised to enter P/B for all groups, not 
to let it be estimated by the mass-balance routine. 

The Q/B input box will be blocked (blue colour) for primary producers. If your model unit is 
carbon, you can however, click the blue input box, and enter a Q/B value, which will be used to 
calculate respiration for the group. 

Estimation of Q/B is discussed in the EwE textbook 

Ecotrophic Efficiency 

The ecotrophic efficiency (EE) is the fraction of the production that your model describe the fate 
of in the system, i.e. that is passed up the food web, used for biomass accumulation, migration 
or export (such as fished). Ecotrophic efficiency is difficult to measure directly. It varies between 
0 and 1 and can be expected to approach 1 for groups with considerable predation pressure. 
The part of the production that is not included in the EE is often called ‘other mortality’. EE is 
dimensionless, and the entry of EE values is optional. 

The ecotrophic efficiency of a detritus group is defined as the ratio between the flow out of 
a detritus box to the flow into the same box. EE for detritus cannot be entered, it is always 
calculated. 
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Other Mortality 

Corresponds to 1-EE, if the other mortality is entered, EE will be blocked and vice versa. 

Production/Consumption 

The ratio between production (P) and consumption (Q) and is a dimensionless parameter. P/Q
corresponds to what may be called the gross food conversion efficiency (g). This ratio is by default 
considered constant in Ecosim where Q is estimated and P deduced. 

There are physiological constraints for the P/Q ratio, which in most cases will range from 0.05 
to 0.3. Exceptions are top predators, e.g., marine mammals, which can have lower P/Q values, 
and small fast-growing fish larvae or nauplii or bacteria, which can have higher P/Q values (up 
to around 0.5). The value of the ratio is checked during the mass-balance routine, and warnings 
are given if production exceeds consumption (as can occur in organisms with symbiotic algae, 
such as corals and giant clams), or if the production exceeds half the consumption (which may be 
acceptable for bacteria, small nauplii and fish larvae, but usually not for other groups). 

P/Q can only be entered if P/B and/or Q/B is left blank. If P/Q is entered along with, e.g., P/B, 
then Q/B will be calculated as Q/B = (P/B) / (P/Q). 

Unassimilated Consumption 

An estimate of the fraction of the food that is not assimilated must be entered if the currency 
of your model is energy-related. Following Winberg 2, a default value of 0.2 is suggested for 
carnivorous fish groups if other estimates are not available. Thus, 80% of the consumption is 
assumed to be physiologically useful while the non-assimilated food (consisting of faeces) is 
directed to the detritus. For herbivores, the proportion not assimilated may be considerably 
higher, e.g., up to 0.4 in zooplankton. 

If the currency is a nutrient, there is no respiration, and the fraction of the food that is not 
assimilated is calculated as (1 – production / consumption). In this case, it is not possible to input 
the fraction of the food that is not assimilated. 

The parameter for unassimilated food is dimensionless, it is entered as a proportion. A routine 
checks whether the sum of gross efficiency plus proportion of food not assimilated exceeds 1, and 
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displays a warning if so. Then, a new and consistent proportion for the non-assimilated food must 
be entered. 

Detritus Import 

If there is import of detritus to the system, enter the quantity as a rate with a unit of, e.g., t km-2 

year-1. 

Diet Composition 

In Ecopath predation links together the different groups in the model and diet composition must 
be entered for all consumer groups. While quantitative information on diet composition overall is 
sparse, there is a considerable amount of information in FishBase and SeaLifeBase. Unfortunately, 
much of the available information on diet compositions is expressed on a ‘percent occurrence’ 
basis or as ‘dominance’, both of which are of little use for quantification of diets, though there 
is a correlation with the preferable forms where diet inputs represent weight, volume or energy 
content of the preys 3. 

At the Ecopath > Input > Diet composition form enter diet composition for all consumers, column 
by column (i.e., predators are represented by column and their prey by row). The diet 
compositions of each group should sum to 1. For guidance, the current sum of the fractions 
representing the food composition is summed at the second-but-last row (Sum). The last row (1 – 
Sum) shows the proportion of prey still to be entered. You can use the Sum to one button at the top 
of the Diet composition screen to raise a diet to unity. If diets do not sum to unity when you start 
basic estimation (i.e., try to balance the model) you will be given the option of having the software 
do the raising for you, or to return to the diet to do it yourself. 

In Ecopath ‘import’ to a system is the consumption of preys that are not a part of the system as 
it is defined (for example for species that spend parts of the year feeding outside the area of the 
model, e.g., gulls feeding on fields during harvest time). 

Note that import is different from migration Migration, which is a production term. Import is 
treated as a ‘prey’ in the diet composition, and should be entered as a fraction of the total diet. See 
the section on Dealing with open system problems in the chapter on Defining the ecosystem in the 
EwE textbook for more information on how to treat groups that feed both within and outside of 
the modelled area. 
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A warning about zero order cycles, i.e., groups that feed on themselves (‘cannibalism’). Avoid 
situations where the fraction of the food of a group taken from that same group exceeds ~0.1. 
This may occur when adults feed on their own juveniles. In such cases, it is advised to split the 
box into groups representing predator and prey stanzas, e.g., in adults and juveniles. This will not 
only reduce or eliminate a zero-order cycle, and the bothersome computational problems usually 
associated with such cycles, but also lead to groups with better-defined characteristics (because 
adults usually have much lower production and consumption rates than those of juveniles). 

Detritus Fate 

At the Ecopath > Input > Detritus fate form you must, f there is more than one detritus group in the 
system,  specify where the detritus left over after the detritivores have covered their food intake is 
to be directed. Surplus detritus can be directed to the same detritus group (equivalent to ‘biomass 
accumulation’) or to other groups, by entering the appropriate fractions directed to each detritus 
groups. If these fractions sum to less than 1, the remaining part of the surplus detritus will be 
exported out of the system. 

Other Production 

Other production refers to production represented in Ecopath by migration and biomass 
accumulation. Migration is not the same as import – emigration and immigration are production 
factors, while import is food consumption. 

If B, P/B, Q/B and EE are entered for a group, a prompt will appear during parameterization asking 
if you want to estimate biomass accumulation. If you answer no to this, a new prompt will ask if 
you want to estimate net migration. If you answer yes, the program will estimate net migration. 

The net migration is calculated as emigration less immigration. This means that net migration will 
be negative if there is more coming into the system than leaving it. This may seem contradictory 
but it should be remembered that a negative mortality can yield an increase in population. If the 
net migration is positive (immigration > emigration), but not entered, the main effect will depend 
on the previous entries: 

• if the production had been entered, the fraction of production directed toward the detritus 
will be overestimated; or 

• if production was to be estimated, this estimate will be underestimated. 
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Immigration 

Migration into the area covered by the model. Must be entered as a non-negative value. Unit is a 
flow, e.g., t km–² year-1. 

Emigration 

Migration out of the area. Must be entered as a non-negative value. Unit is a flow, e.g., t km–² 
year-1. 

Emigration Rate 

Emigration can also be presented as the proportion of the population emigrating from the system 
in a year (unit is year-1). The immigration rate can be entered by setting the emigration rate to a 
negative value. 

Biomass Accumulation 

Ecopath is not a steady-state model. If the biomass for a group is known, e.g., at the beginning of 
the year and at the beginning of the next year, the biomass accumulation (BA) can be calculated as 
the difference between these biomasses. BA is a production term that can be entered for all living 
groups (default is 0), but is calculated for detritus groups. BA is a flow term, with a rate unit of, 
e.g., t km–² year-1. The default value for BA is zero indicating no biomass accumulation. A negative 
value signifies biomass depletion (biomass decreased during period modelled). 

If B, P/B, Q/B and EE are entered for a group, a prompt will ask during parameterization if you 
want to estimate BA. If you answer yes to this question the BA will be calculated, overruling any BA
you may have entered. 

If you have a BA is your Ecopath model, Ecosim and Ecospace will pick up these values and it will 
set both models on a trajectory when a model run starts. A negative BA value may for instance 
inform Ecosim that the fishing pressure in Ecopath is unsustainable and Ecosim will hence predict 
a decline over time in the species concerned. 

Biomass accumulation rate 
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Biomass accumulation can also be represented as a rate relative to the total biomass, BA/B. The 
unit is (t km-2 year-1) / (t km-2) = year-1. 

Fishery 

At the Ecopath > Input > Fishery > Fleets > Define fleets…  form you must first of all define your 
fishing fleets, then at the mother Ecopath > Input > Fishery > Fleets form set basic fleet cost 
parameters. Notice that the economic analysis that can be done with these basic cost factors is 
quite limited in comparison to what can be done with the full value chain analysis in EwE , see 
Ecopath > Output > Tools > Value chain. 

Fixed Cost 

Fixed cost is the cost of operating a fleet unit, independent of effort, in the unit time defined 
in Ecopath (typically on an annual basis). The definition of ‘fixed’ costs depends on the actual 
situation being modelled. To illustrate this consider some examples: 

The Ecospace optimization module, Ecoseed, allows for effort reduction to nil in connection 
with simulated increase in protected areas from 0 to 100% of total model area. As the last boats 
operating in a fleet cannot cover the total ‘fixed’ costs of the total fleet; they should only bear the 
‘fixed’ costs that are independent of effort. For this type of application use the ‘fixed costs’ only for 
costs that are independent of effort at the fleet scale, for instance for the costs of management 
and monitoring, (and subsidies if there are fixed subsidies to the fleet). Costs that are capacity 
dependent in this situation should beconsidered effort-related variable costs instead. 

Effort can also be changed in Ecosim: 

• If the changes are relatively small and intended to represent changes in effort with constant 
capacity, the fixed costs can beseen to represent all costs that are effort-independent at the 
boat- level. Examples are costs for management, monitoring, licenses, capitalization, and 
insurance. 

• If the changes are major, the procedure outline for Ecoseed above should be adopted instead. 
Hence, consider the fixed costs to be effort-independent at the fleet level. 
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Effort Related Cost 

Represents costs that are a function of effort. The examples above give some guidance to how 
these should be defined. Enter the costs as a percentage of the total value of the fishery in the 
given year. Simulation in Ecosim with changes in fishing effort are entered relative to the base 
effort, hence if the effort is increased with, e.g., 10% the variable costs are assumed to increase 
10% as well, whereas the fixed costs are assumed unchanged. 

Ecosim: use Effort related costs for all variable costs (e.g., fuel, gear costs and crew wages); 

Ecospace: use Effort related costs for variable costs that depend on effort, e.g., for gear costs (which 
mainly depend on how many hours the gears is used), but not for costs that depend on spatial 
effort allocation, e.g., sailing costs. See next section. 

Sailing Related Cost 

For Ecospace applications it is recommended to use two separate forms for variable costs: effort-
related and spatially-related (i.e., sailing related). Do not enter sailing related costs if you are only 
using Ecosim, then use effort related costs for all variable costs. 

If you are using Ecospace, use Effort related costs for variable costs that depend on effort, e.g., for 
gear costs. Enter costs that depend directly on spatial effort allocation, e.g., fuel costs and crew 
wages as Sailing related costs. 

Profit 

Profit is calculated as percentage of value, calculated from total value less all costs. It cannot be 
entered directly. 

Total value 

The total value is the value of all landings (as entered on subsequent forms). It is displayed here 
only to indicate that the ‘100 %’ relates to value, not to total costs. 
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Landings 

Landings and catches are not the same, as discarding is an integral part of most fishing operations. 
Ecopath calculates: Catch = landings + discards. 

You should therefore enter only the landings here – while any discards should be entered on the 
discards form. Landings must be expressed as flows, typically in t km-² year-1. The area to be 
used should be the total area of your model, not  just habitat area, or the area in which the fleet 
operates. For instance, if you are entering information for a coastal shrimp fishery, the landings 
(and discards) should be calculated relative to the total area of the model – even if most of it is too 
deep for trawling. 

In a model of an ecosystem exploited by a fishery, the catch is the total extractions over the time 
period considered in the model, (e.g., a year), for each of the groups modelled. Similarly, in an 
aquaculture system the ‘catch’ is the harvest from each group over the time period considered, 
(e.g., a growing season considered representative for a year). 

Fishery catches are normally based on landing statistics. This may cause a problem as official 
statistics are generally on a regional basis, not on an ecosystem basis. This can be of importance 
when defining the system to be modelled, either as a geographical/political region or as an 
ecosystem. It is necessary to consider the availability of appropriate catch data when taking 
such decisions. Sea Around Us data may be useful if you don’t have access to local data or for 
comparison with local data. 

The catches together with other export sum up to the total export. Catches are also used to 
estimate the fraction of primary production that is utilized in the system (i.e., the ‘gross efficiency 
of the fishery’). 

Discards 

Discarding is (or was) a normal practice in most fisheries, though this has changed with the 
EU Landing Obligation regulations. If you do not enter any information, you are assuming that 
discarding does not take place. If discarding does take place this is worse than guessing! Therefore, 
it is better to use information from similar fisheries in other areas or perhaps based on interviews 
with fishers in your area – or from the Sea Around Us . 

Discarding may affect trophic and population dynamics. For example, in shrimp fisheries where 
the discards include predators on shrimps that may be turned into food for shrimps, an ecosystem 
model can be used to quantify the ecological role of discarding. 
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Discard Mortality 

Discard mortality is a mortality rate in the [0,1] range, where by default the assumption is that all 
discards die. 

Discard Fate 

Ecopath needs to be told what to do with the discards you enter as part of the catches. Discards 
can either go to a detritus group or be exported. Discard fate is entered as a proportion, i.e., a 
value between and including 0 and 1, representing the fraction of the discards directed to a given 
detritus group (or exported). 

If you are interested in quantifying the ecological impact of discarding it is recommended that you 
make a special detritus group called, e.g., ‘Discarded fish’ and direct the discards to this group. 

Off-Vessel Price 

Enter the market value (in the specified monetary unit per unit catch) for each group for each 
gear (fleet). It is generally not important whether the market values are entered in, e.g., €/kg or 
€/tonnes, as long as the entries are consistent among groups. This is, however, important for 
Value chain analysis, which are designed to quantify the total socio-economic benefits and costs 
of ecosystem usage. 

The off-vessel prices are fleet-specific on the entry forms, as quality and hence price varies more 
between fleets than within fleets. 

As per EwE version 6.7, negative off-vessel prices can be specified to impose quota penalties. 

Non-Market Price 

Shadow price or non-market price represents the value of a resource in the ecosystem, e.g., for 
non-exploitative uses. Values should be expressed in monetary units per unit biomass. At present 
it is assumed that there is a linear relationship between the biomass of a resource and its non-
market price (if there is any). Hence, for groups with a non-market price it is assumed that a 
doubling in biomass will lead to a doubling of the resource’s non-market value. 
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Pedigree 

Figure 2 – Screenshot of pedigree table 

Resources 

There is a Quick guide on how to calculate P/B and Q/B for EwE models by Daniel Vilas, Marta Coll, 
Chiara Piroddi, Jeroen Steenbeek, developed for the EC Safenet Project, available at this link. 

Notes 

1. Allen, K. R. 1971. Relation between production and biomass. J. Fish. Res. Board Can., 28:1573-1581. 
https://doi.org/10.1139/f71-23 

2. Winberg, G. G., 1956. Rate of metabolism and food requirements of fishes. In: Transl. Fish. Res. Board Can., 
Translation Series 194. pp. 1-253. https://waves-vagues.dfo-mpo.gc.ca/library-bibliotheque/38248.pdf 

3. MacDonald, J. S., and Green, R. H. 1983. Redundancy of variables used to describe importance of prey 
species in fish diets. Can. J. Fish. Aquat. Sci., 40:635-637. https://doi.org/10.1139/f83-083 
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Linked Stanza Recruitment 
JEROEN STEENBEEK 

Background 

Occasionally, ecosystem modellers run into issues where gender‐split populations need explicit 
modelling. This can occur when empirical data is only available for male or female specimens, 
or when males and females of key species have markedly different behaviours. We have made a 
small modification to the Ecopath with Ecosim (EwE) multi‐stanza model 1, that allows linking 
recruitment to ensure proportional spawning between two multi‐stanza groups, and thus 
connecting two gender‐spilt populations at their foundation. 

Implementation 

At the first Ecosim and Ecospace time steps, a base scalar is calculated: 

where 𝑎 is the scalar, i is a multi‐stanza group whose recruitment is driven by multi‐stanza group 
j, and NAge1 is the number of individuals at age 1, e.g., the number of recruits, for multi‐stanza 
groups i and j. This base scalar serves to maintain the ratio between the number of gender‐split 
recruits during the simulations. 

For every consecutive time step, the number of multi‐stanza group i recruits is then set as follows: 

Changes to the EwE computations were minimal; the most challenging code changes were made 
in the Ecospace IBM model 2, where parallel computations was reorganized to ensure that 
multi‐stanza recruitment is calculated in the correct order. Ecospace does not yet calculate 
recruitment success from spatial overlap of the gender‐split stanza; this could be a future 
refinement if needed. 

An example of the impact of linked recruitment is shown in Figure 1. Here, Ecosim is executed for 
a model that contains separate multi‐stanza groups for male and female snow crab Chionoecetes 
opilio. Both multi‐stanza groups consist of two life stages each: juveniles and adults. Only the 
male snow crabs are fished. The model contains no change in environment and fishing other than 
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gradually intensifying effort of the snow crab fishery. Figure 1 shows three simulations: in the left 
panel, multi‐stanza recruitment is not linked. In the middle panel, female recruitment is obtained 
from the male multi‐stanza group. In the right panel, male recruitment is obtained from the female 
multi‐stanza group. 

 

Figure 1 ‐ Three Ecosim simulations with different recruitment linkage configurations for snow crab: no linked 
recruitment (Left), female recruitment linked to the fished males (Center), and fished male recruitment linked to 
non‐fished females (Right). Note that both juvenile groups are identically parameterized in this specific case, and 
therefore their biomass estimates exactly overlap in the Center and Right plots. 

Configuring Linked Stanza Recruitment 

First, define the male and female multi‐stanza configurations in the Define groups interface (Figure 
4). 
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Figure 2 ‐ Define gender‐split multi‐stanza groups 

Second, configure the two gender‐split multi‐stanza groups in the “Edit multi‐stanza” interface 
(not shown here). 

Third, link recruitment in the “Edit multi‐stanza” interface. In the figure below, female snow crab 
recruitment is linked to the males. A multi‐stanza group whose recruitment is linked will have its 
recruitment calculations overwritten, and therefore the “Recruitment Power” parameter becomes 
inactive (Figure 5). 
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Figure 3 ‐ Linking the recruitment of a multi‐stanza configuration to another multi‐stanza. 

Attribution 

Linked stanza recruitment was implemented by Jeroen Steenbeek after an idea by Villy 
Christensen under project EISA: Ecology and management of the invasive snow crab. 

Notes 

1. Christensen and Walters, 2004, op. cit. 

2. Walters, C., Christensen, V., Walters, W., Rose, K., 2010. Representation of multistanza life histories in 
Ecospace models for spatial organization of ecosystem trophic interaction patterns. Bulletin of Marine 
Science 86, 439–459. 

Linked Stanza Recruitment  |  25

https://ecopathinternational.org/project/eisa/
https://ecopathinternational.org/project/eisa/
https://www.researchgate.net/publication/233559683_Representation_of_multistanza_life_histories_in_Ecospace_models_for_spatial_organization_of_ecosystem_trophic_interaction_patterns
https://www.researchgate.net/publication/233559683_Representation_of_multistanza_life_histories_in_Ecospace_models_for_spatial_organization_of_ecosystem_trophic_interaction_patterns


Ecopath Output 

It’s a fascinating aspect of food web models that one can deduct quite a bit about the ecosystem 
form and functioning simply from the flows and state variables in the food web, from the 
ecosystem flow chart.  This is different though from what can be deducted from a more complex 
dynamic model. You could think of it as the difference between analyzing a single picture and 
watching a movie. It’s different things, different questions, all with their value. The value of the 
food web representation comes from it being simple, well rather simple, it can be complex or 
messy given enough functional groups. But there are lessons to be drawn from such simple 
representations. 

To get to those lessons, we need indicators. The food web per se is indeed quite messy to examine, 
and we use indicators to make sense of such messiness.  The field of network analysis is built 
around this, what can one deduct from a network such as represented by a food web?  EwE to that 
effect has a network analysis plug-in with the more complex analysis, while a suite of indicators 
are given in the Ecopath > Output forms, which is the topic of this chapter. 

Once you have entered sufficient input parameters, you can proceed to the output forms where on 
the Ecopath > Output > Basic estimates form, the missing parameters will be estimated so that mass 
balance is achieved. Both input (black font) and calculated (blue font) parameters are displayed. 

If Ecopath has NOT been balanced already since opening or making changes to the input 
parameters, selecting any of the output forms will cause Ecopath to attempt to balance the model. 
Note also that you will not be able to balance your model if the sum of the diet composition for 
each consumer group does not sum to 1. Return to the Ecopath > Input > Diet composition form and 
fix the problem if this is the case.When you create an Ecopath model and need to mass-balance it, 
know that uncertainty can be dealt with later. To get started, we need a plausible model, not the 
correct model (which doesn’t exist) but one that can be used for, e.g., making thousands of models 
based on parameter uncertainty. 

Problems in parameter estimation will be shown in the Status panel. Two types of message may be 
displayed in the Status panel while you are balancing your model 

• Information messages provide feedback on regular events in EwE. Information events are 
confirmations of things that went well. Examples are opening the model; successful edits; 
and successful balancing (i.e., parameterization) of the model. 

• Warning messages when EwE was not able to complete an action and requires the user to fix 
a problem, usually with the input data. For example, one of the most important of these is 
when parameterization fails (i..e., the model failed to balance). When this occurs, you will get 
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the message “Your model is NOT balanced! Computed Ecotrophic Efficiencies (EE) invalid for 
one or more group(s).” Clicking on the “+” icon next to this message expands the message to 
show which groups are causing the problem. 

Basic Estimates 

Most of the parameters on this screen are input values and therefore discussed in that section of 
this guide. 

Trophic Level 

Lindeman 1 introduced the concept of trophic levels. In Ecopath, the trophic levels are not 
necessarily integers (1, 2, 3…) as proposed by Lindeman, but can be fractional (e.g., 1.3, 2.7, etc.) 
as introduced by Odum and Heald 2. A routine assigns definitional trophic levels (TL) of 1 to 
producers and detritus and a trophic level of 1 + [the weighted average of the preys’ trophic level] 
to consumers. 

Following this approach, a consumer eating 40% plants (with TL = 1) and 60% herbivores (with 
TL = 2) will have a trophic level of 1 + [0.4 · 1 + 0.6 · 2] = 2.6. The fishery is assigned a trophic 
level corresponding to the average trophic level of the catch, i.e. without adding 1 as is done for 
‘ordinary’ predators. 

The trophic level is a dimensionless index. 

Key Indices 

Net Migration 

The net migration, E,  is calculated as emigration less immigration. This means that net migration 
will be negative if there is more coming into the system than leaving it, i.e. it will be a negative 
production term, which perhaps may balance a higher fishing mortality or an increase in biomass 
accumulation. 
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Flow to Detritus (FlowToDet) 

For each group, the flow to the detritus consists of what is egested or excreted (the non-
assimilated food) and those elements of the group that die of old age, diseases, etc., (i.e., of sources 
of ‘other mortality’, expressed by 1 – EE). The flow to the detritus, expressed, e.g., in t km-2 year-1, 
should be positive for all groups. 

Estimation of Q/B for Detritivores 
It is not possible to estimate the Q/B ratio for groups that feed exclusively on detritus. For detritus, the 
production is not defined, and for such detritivores it will be necessary to input Q/B (or P/B and an 
estimate for gross food conversion efficiency, g, as Q/B = P/B / g). 
Remember, it is not a good idea to estimate P/B or Q/B for any group, make them input instead. 

Net Efficiency 

The net food conversion efficiency is calculated as the production divided by the assimilated part 
of the food, i.e., 

Net efficiency = P/B / (Q/B · (1 – U)) 

where P/B is the production / biomass ratio, Q/B is the consumption / biomass ratio, and U is 
the proportion of the food that is not assimilated (but egested or excreted). 

The net efficiency can also be expressed, 

Net efficiency = production / (production + respiration) 

The net efficiency is a dimensionless fraction. It is positive and, in nearly all cases, less than 1, the 
exceptions being groups with intermediate trophic modes, e.g., groups with symbiotic algae. The 
net efficiency cannot be lower than the gross food conversion efficiency, g. 

Omnivory Index 

The ‘omnivory index’ was introduced in 1987 (Pauly et al., 1993a) in the initial, unreleased version 
of the Ecopath II software. This index (OIj) is calculated as the variance of the trophic level of a 
consumer’s (j) prey groups (i). Thus 
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where, TLi is the trophic level of prey i, TLj is the trophic level of the predator j, and, DCji is the 
proportion prey i constitutes to the diet of predator j. 

When the value of the omnivory index is zero, the consumer in question is specialized, i.e., it feeds 
on a single trophic level. A large value indicates that the consumer feeds on many trophic levels. 
The omnivory index is dimensionless. 

The square root of the omnivory index is the standard error of the trophic level, and a measure of 
the uncertainty about its precise value due to both omnivory and sampling variability. 

Mortality Rates 

The three forms in this node are arguably the most important reference for the user during the 
model-balancing process, as they can be used to indicate which mortality components are most 
likely to be causing problems. 

Mortalities 

The mortality coefficients form (Figure 1) is one of the most important forms on the 
Parameterization menu and it is, as a rule, the first that should be checked when balancing a 
model. 

 

Ecopath Output  |  29



Figure 1 – Mortalities form, Ecopath > Output > Mortality rates > Mortalities. The form neatly lists the second 
Ecopath Master Equation, with production = fishing + predation + biomass accumulation + net migration + other 
mortality, with all terms expressed as rates (i.e. relative to biomass, unit year-1).  This form is the first to check 
when balancing a model. 

Components of Mortality in Ecopath 

Under equilibrium assumptions, each group can be represented by an average organism, with 
an average weight. This makes it possible to use equations for estimating mortality in numbers, 
even when dealing with biomass. One such equation is  where N0 is a number 
of organism at time 0; Nt is the number of survivors at time t; and Z is the instantaneous rate of 
mortality (year-1). 

Under the assumption that Zi, the mortality of group i, is constant for the organisms included in 
i it turns out that for a large number of growth functions (including the von Bertalanffy Growth 
Function, or VBGF) 

or instantaneous mortality equals total production over mean biomass 3. 

The mortality coefficient can be split into its components following a well-known procedure, i.e., 
the second Ecopath Master Equation, 

Zi = (P/B)i = Fishing mortality + Predation mortality + Biomass accumulation + Net migration + Other 
mortality 

or 

Where for group I, 
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• Fi is the fishing mortality rate; 
• M2i is the predation mortality rate; 
• BAi is the biomass accumulation rate (actually BAi/Bi); 
• Ei is the net migration rate (emigration less immigration).M0i is the other mortality rate. 

All are with the unit year-1 as they are rates (t km-2 year-1) relative to biomass (t km-2). 

In some models, (notably the Multispecies Virtual Population Analysis), the ‘other mortality’ 
component is split between M1, i.e., predation by predators not included in the model, and M0, 
‘other mortality’, caused by diseases, senescence, etc. In Ecopath, M1 is included in M0, as models 
often are intended to describe the major components of predation mortality explicitly (so M1 is 
likely to be minimal). Further, M0 is not entered directly, but is computed from the ecotrophic 
efficiency, EE. 

Ecopath-predicted values for these coefficients are given on the Mortality coefficients form. The 
mortality coefficients are estimated from the following equations: 

where (Q/B)j is the consumption/biomass ratio of predator j; DCji is the proportion prey i 
contributes to the diet of predator j, Bi is the average biomass of i, and Ci is the catch of i. The 
biomass accumulation term, BAi, is a basic input term. 

Predation Mortality 

The predation mortality of a group i is the sum of the consumption of i by all groups (including i), 
divided by the biomass of group i. Predation mortality is calculated from (7), i.e., it is not an input 
parameter. 

When you balance a model, and you have a group that does not balance (EE >1), the first thing to 
do is to check the Ecopath > Output > Mortality rates > Mortalities form (as described above in this 
chapter) to evaluate if the problem is due to fishing or predation (one of which or both often being 
the culprit). If it is due to predation, the next step is to check the Ecopath > Output > Mortality 
rates > Predation mortality rates form (Figure 8). 
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Figure 2 – Predation mortality form (Ecopath > Output > Mortality rates > Predation mortality rates)  for 
Anchovy Bay with seal biomass increased 100 times. The model is not balanced for cod and whiting (highlighted). 
Make it rule to examine this form, here to find the problem with predation mortality rates (M2) due to seal’s 
erroneously high biomass, but also generally for models to balance to learn who they important predators are for 
each group. The M2s are rates (year-1) that can be summed up by row to give the total M2 by group. 

 

The form will guide you to particular mortality coefficients that are causing problems with 
balancing. If predation mortality is too high then the form will help you identify which predators 
that are causing the problem for a particular prey group. 

To help you identify possible problem predators, cells with unusually high predation mortalities 
will be shown with a different-coloured background instead of the usual background (as is the 
case for seals predation on cod and whiting in Figure 1). 

Consumption 

The Ecopath estimates of consumption (food intake) can be found at Ecopath > Output > 
Consumption. The consumption of a living group is the product of its biomass (B) times its 
consumption/biomass ratio (Q/B). The food intake is a flow rate expressed, e.g., as t km-2 year-1. 

The consumption table also displays all flows to the detritus group(s) even though it is not 
consumption, (we had to put it somewhere). 
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Respiration 

The Ecopath estimates of respiration are at Ecopath > Output > Respiration. The Respiration form 
displays the predicted values for respiration and assimilation of food by all groups. 

Respiration 

Respiration includes all non-usable ‘model currency’ that leaves the box representing a group. 

When the currency is energy or carbon, the bulk of the assimilated food will end up as respiration. 
If, however, a nutrient (e.g. phosphorus or nitrogen) is used as currency, all nutrients that leave the 
box is re-utilized; in this case, respiration is nil. 

Primary producers will not have respiration if the unit is energy based. 

Since assimilated food ends up as either production or respiration, only one of these two 
quantities needs to be estimated, as the other – here respiration – can be calculated as a 
difference. In Ecopath, this is calculated as the difference between the assimilated part of the 
consumption and that part of production that is not attributable to primary production (i.e., 1 
– TM). Thus, for groups with intermediate values of TM, i.e., for mixed producers/consumers, 
only that part of the production that is not attributable to primary production is subtracted. For 
reasons of consistency, in Ecopath, detritus is assumed not to respire, although it would if bacteria 
were considered part of the detritus, (which is one reason why it is better to create one or more 
separate groups for the detritus-feeding bacteria if this difficult group is to be considered at all). 

The respiration of any living group (i) can be expressed as, 

where Respi is the respiration of group i, Ui is the fraction of i‘s consumption that is not 
assimilated, Qi is the consumption of i, and TMi is the proportion of the production that can 
be attributed to primary production. If the unit is a nutrient, TMi is equal to zero, irrespective 
of whether the group is an autotroph or not (nutrients are not produced), and, Pi is the total 
production of group i. 

Respiration is used, in Ecopath, only for balancing the flows between groups. Thus, it is not 
possible to enter respiration data. However, known respiration values (i.e., the metabolic rate) of a 
group can be compared with the output, and the input parameters adjusted to achieve the desired 
respiration. 
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Respiration is a non-negative flow expressed, e.g., in t km-2 year-1. If the currency is a nutrient, 
(e.g., nitrogen or phosphorus), respiration is zero: nutrients are not respired, but egested or 
excreted and recycled within systems. 

Assimilation 

The part of the food intake that is assimilated is computed for each consumer group from 

where Bi is the biomass of group i; (Q/B)i is the consumption / biomass ratio of group i; and Ui is 
the part of the consumption that is not assimilated. 

The three parameters needed for the estimation are all input parameters. Assimilation is a flow 
expressed, e.g., in t km-2 year-1. 

Respiration/Assimilation 

The (dimensionless) ratio of respiration to assimilation cannot exceed 1 as respiration cannot 
exceed assimilation. For top predators, whose production is relatively low, the respiration/
assimilation ratio can be expected to be close to 1, while it will tend to be lower, but still positive, 
for organisms at lower trophic levels. 

Production/Respiration 

The (dimensionless) ratio production / respiration express the fate of the assimilated food. 
Computationally, this ratio can take any positive value, though thermodynamic constraints limit 
the realized range of this ratio to values lower than 1. 

Respiration/Biomass 

The R/B ratio can be seen as an expression of the activity of the group. The higher the activity-
level is for a given group, the higher the ratio. The R/B ratio is strongly impacted by the assumed 
fraction of the food that is not assimilated, see the basic input form. If the ratio is too high, this 
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may be due to GS being too low. The R/B ratio may be available in the physiological literature for 
 some species/groups. 

The ratio respiration / biomass can take any positive value, and has the dimension year-1. 

Niche Overlap 

Niche overlap indices for Ecopath models are available at three Ecopath > Output > Niche 
overlap forms 

For this, a simple niche overlap index is adopted, and it is shown how it can serve as a starting 
point for the development of a new (predator) niche overlap index incorporating predation. The 
procedure involved in deriving a predator niche overlap index (from a prey niche overlap index) 
should be generally applicable, i.e., not limited to the type of index presented below. 

Pianka (1973) suggested the use of an overlap index derived from the competition coefficients of 
the Lotka-Volterra equations. This index, Ojk, which has been used for many descriptions of niche 
overlap, can be estimated, for two species/groups j and k, from 

where Pji and Pki are the proportions of the resource i used by species j and k, respectively. The 
index is symmetrical and assumes values between 0 and 1. A value of 0 suggests that the two 
species do not share resources, 1 indicates complete overlap, and intermediate values show partial 
overlap in resource utilization. 

Closer examination of the Pianka overlap index shows it to have an unwanted characteristic and it 
is therefore slightly modified here. If one of the groups (say j) only overlaps with one other group 
k then Pji will be zero for all values of i but i = k, where it will reach a value of 1. In such a case, the 
denominator of (12) will always be 1, and the overlap index will equal Pki, whereas a value between 
Pki and Pji would be more reasonable. This behaviour is caused by the geometric mean implied in 
the denominator of (12) , and can be circumvented by the use of an arithmetic mean. For this, (12) 
is changed to 

where the index and all of its terms can be interpreted as above. This version of the Pianka overlap 
index is used subsequently. 
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The niche overlap index can be used to describe various kinds of niche partitioning. Here attention 
will be focused on the trophic aspects. In this case, the Pki and Pji in (13) can be interpreted as the 
fraction prey i contributes to the diets of j and k, respectively. 

Using an approach similar to that above, it is possible to quantify the predation on all preys m and 
n by all predators l, and to derive a ‘predator’ composition, estimated from 

and 

Here Xml can be interpreted as the fraction the predation by l contributes to the total 
predation on m, while Ql is the total consumption for predator l. The predator compositions given 
above correspond to what Augoustinovics 4 defined, in the context of input-output analysis, as 
‘technical coefficients’. 

Based on the predator composition a ‘predator overlap index’ (P) can be derived as 

the values of this predator overlap index range between 0 and 1 and can be interpreted in the same 
way as those of the prey overlap index, given in (13) . 

In the present version, only one type of niche overlap index is incorporated, but both predator and 
prey niche overlap is given for this index. If of interest, more indices may be included in upcoming 
versions of EwE. 

 

36  |  Ecopath Output



Figure 3 – Niche overlap plot for Anchovy Bay model. Here, groups 3 and 4 (cod and whiting) have similar 
predator and prey overlap indices. The same holds for 5 and 6 (mackerel and anchovy), while 7 and 8 (shrimp and 
benthos) have little overlap with regards do predators and prey. The niche overlap can be used to identify 
potential candidate groups for merging in models with (too) many models.  Groups with overlap indices < 0.1 are 
not included in the plot. 

Electivity 

The electivity (selection index) describe a predator’s preference for prey. It scales from -1 to 1; 
where -1 indicates total avoidance of a prey; 0 indicates that a prey is taken in proportion to its 
abundance in the ecosystem; and 1 indicates total preference for a prey. The electivity values are 
highlighted using a colour scale for the background, scaling from –1 (white) to 1 (red) using shades 
of red for intermediate values. The electivity index displayed is the standardized forage ration of 
Chesson 5(1983), see below. 
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One of the most widely used indices for selection is the Ivlev electivity index, Ei 6 defined for a 
group i as: 

where ri is the relative abundance of a prey in a predator’s diet and Pi is the prey’s relative 
abundance in the ecosystem. Ei is scaled so that Ei = -1 corresponds to total avoidance of, Ei = 0 
represents non-selective feeding on, and Ei = 1 shows exclusive feeding on a given prey i. Note that 
within Ecopath, ri and Pi refer to biomass, not numbers. 

The Ivlev electivity index while widely used has a major shortcoming, seriously limiting its 
usefulness as a selection index, it is not independent of prey density. A more versatile approach is 
to use the standardized forage ratio (Si) as suggested by Chesson 7. This index is independent of 
prey availability, and is given by 

where ri and Pi are defined as above, and n is the number of groups in the system. The 
standardized forage ratio as originally presented takes values between 0 and 1, with Si = 0 
representing avoidance and Si = 1 exclusive feeding. As implemented in EwE, the forage ratio has 
been transformed (linearly) such as to vary between -1 and 1, so that -1, 0 and 1 can be interpreted 
as for the Ivlev index. 
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Figure 4 – . Electivity plot for the Anchovy Bay ecosystem model. Here, whales have a very strong preference for 
mackerel (0.821) while benthos is eaten, but a negative preference for benthos (-0.817) indicating that the 
proportion of benthos in the whale diet is much lower than the proportion of the benthos biomass relative to the 
total ecosystem biomass . 

Search Rates 

A useful feature of the system of linear equations underlying the Ecopath approach (link) is that 
it can be used to estimate the Lotka-Volterra mass-action term a, which has the dimension of 
a volume searched per unit time by a given predator j seeking a certain prey i. Building on the 
second Ecopath Master Equation 

where B is biomass, P production rate, EE the ecotrophic efficiency, C the catch rate, BA the 
biomass accumulation rate, E the net migration rate, Q the consumption rate, DCji the proportion 
i contributes to the diet of j (each of the consumers). Separating the biomass accumulation rate, 
BA, and re-expressing as a differential equation 

where Qji expresses the consumption rate for consumer j of prey i. We can then solve for aji = 
Qji/(Bj Bi), which defines the Lotka-Volterra mass-action term a as the quotient of the amount of i 
consumed by j, divided by the product of their biomasses. 
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This mass-action term is a proportionality factor used in Ecosim to estimate consumption rate for 
consumers, given the changing biomasses of their preys, and their own changing biomasses. 

The values of a depend obviously on the units used, and the biomass units used in Ecopath 
render difficult a direct interpretation of the numbers in the Ecopath > Output > Search rates table. 
However, they can easily be converted into values of a applying to single organisms, given that the 
ratio of the individual prey and predator weights are divided into the values of a for each pair of 
prey and predator. 

Fishery 

The Ecopath > Output > Fishery > Catch form and Ecopath > Output > Fishery > Value form 
summarizes total catch by quantity and value for each fished group by fleet. In connection with the 
EU Landing Obligation regulations, considerable capacity to handle discard dynamics have been 
added to EwE, and part of this are presented in the Ecopath > Output > Fishery > Discard mortality, 
Ecopath > Output > Fishery > Discard survival and Ecopath > Output > Fishery > Computed landings
forms. 

Catch 

The Ecopath < Output < Fishery > Catch from shows total catch for fished groups by fleet, where 

Catch = Landings + Discards 

where landings and discards are entered as inputs at the Ecopath < Input < Fishery > Landings
and Discards forms, respectively. The form also displays the trophic level of each fleet and of 
the fishery in total. For this, the trophic level is calculated similarly to how the trophic level is 
calculated for functional groups – as the average trophic level of the catch + 1. 

Value 

The Value form shows the calculated value for fished groups (i) by fleet (g), where 

Valuei,g = Market pricei,g x Landingsi,g 

where market price and landings are input from the Ecopath < Input < Fishery > Off-vessel price and 
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Ecopath < Input < Fishery > Landings forms, respectively. The market value is with unit monetary 
value per year. 

The non-market value of each resource is also shown in a separate column on the Ecopath > 
Output > Fishery > Value form (if any non-market prices have been defined on the Ecopath > Input 
> Fishery > Non-market value form. The non-market value is calculated for group i as 

Non-market valuei = Non-market pricei x Biomassi 

The non-market value is with unit monetary value per year. 

Discard Mortality 

Discard mortality is at the Ecopath > Output > Fishery > Discard mortality form and is for group i 
caught by fleet g calculated as, 

Discard mortalityi,g = Discardi,g x Discard mortality ratei,g 

where the discard and discard mortality rate is obtained from Ecopath < Input < Fishery > Discards
and Ecopath < Input < Fishery > Discard mortality rate respectively. Discard mortality is a flow rate 
with unit t km-2 year-1. 

Discard Survival 

Discard survival is at the Ecopath > Output > Fishery > Discard survival form and is for group i 
caught by fleet g calculated as, 

Discard mortalityi,g = Discardi,g x (1 – Discard mortality ratei,g) 

where the discard and discard mortality rate is obtained from Ecopath < Input < Fishery > Discards
and Ecopath < Input < Fishery > Discard mortality rate respectively. Discard survival is a flow rate 
with unit t km-2 year-1. 

Computed Landings 

The computed landings at the Ecopath > Output > Fishery > Computed landings form should 
correspond closely to the input landings at the Ecopath > Input > Fishery > Landings form and I am 
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not sure why the computed landings have been added. The computed landings are flow rates with 
unit unit t km-2 year-1. 

Particle size distribution 

later gator – REMOVE? 
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Ecopath Tools 

Flow Diagram 

One of the characteristics of food web models is that all flows and biomasses can be represented 
in a single graph. 

The traditional method of representing trophic flow in ecosystem models, usually by 
scattering interconnected boxes across a page, both under-utilizes the potential 
descriptive and explanatory power of graphical representations and makes it difficult to 
compare different system representations. Often, trophic models are drawn such that the 
boxes representing organisms low in the food web are placed in the lower part of the 
graph, along with the plants, while the boxes representing organisms high in the food web 
are put higher up. 

In the flow chart incorporated in Ecopath, explicit use is made of this mode of graphing, i.e., to plot 
the boxes representing the organisms of an ecosystem such that the horizontal axis of symmetry 
of each box is aligned with the (functional) trophic level of the box in question. Using trophic level 
as the Y-axis is not sufficient to define the relative position of the elements of a model, and two 
approaches may be considered for ordering the boxes along the X-axis: 

• arranging the boxes such that they do not overlap, and/or with emphasis on some 
symmetry, such that the resulting graph is aesthetically pleasing, or, 

• arranging the boxes such that the arrows linking the boxes cross each other as little as 
possible, hence maximizing clarity of the graph. 

You might consider (i) and (ii) when constructing flow charts using the flow diagram in 
this version of Ecopath. The size of each (round) box is proportional to the biomass it 
represents. This trick is particularly useful in helping to visualize the relative role and 
impact of the organisms in each box. 

Another rule of construction was incorporated in the flow chart design of Ecopath. Flows 
entering a box do this on the lower half of the box, while flows exiting a box do it from the 
upper half. Flows that enter a box can be combined, while flows that leave a box cannot 
branch, but can be merged with flows exiting other boxes. This ensures compatibility with 
electronic hardware design, and more importantly, it simplifies the flow chart. 

‘Cannibalism’ or zero-order flows can be shown as arrows originating from the top half of 
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a box, and moving in an incomplete circle before entering the lower half. The flow chart 
routine of Ecopath will label all connecting arrows with their respective flows. 

EwE6 automatically builds a trophic flow diagram. Right click on the Flow diagram form 
and select Settings to set the colour of the nodes, colours, width and types of lines, the 
shape of the nodes (square or circular) and whether the nodes are to be scaled or not. 

Hover your mouse over a node to see its connections. Trophic levels are shown in the 
background. 

 

Figure 1 – Ecopath flow diagram. 
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Using Ecosampler 
JEROEN STEENBEEK AND MARTA COLL 

Ecosampler is a utility for Ecopath with Ecosim (EwE) that records alternate balanced Ecopath 
parameter sets (referred to as ‘samples’) produced by the EwE Monte Carlo routines. Ecosampler 
can then run these samples through the EwE core modules Ecopath, Ecosim and Ecospace, and 
any active plug-in. Any saved model output can then be used to assess the impact of Ecopath input 
parameter uncertainty onto predictions of any EwE module. 

Figure 1 – The Ecosampler interface upon launch 
with the main toolbar (1), sample list (2), sample 
management section (3), and batch run section (4). 
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Obtaining the Plug-in 

Ecosampler is distributed as part of EwE version 6.6+. For any issues, contact the EwE 
development team at ewedevteam@gmail.com. 

Interface 

The Ecosampler interface is launched by choosing Navigator > Tools > Ecosampler. The Ecosampler 
interface offers the following elements (Figure 1): 

1. A toolbar that offers options to turn sample recording on and off, and to import samples 
stored elsewhere. 

2. A overview with the list of recorded samples, and for each sample a sequential number, 
whether a sample is currently loaded in the EwE user interface, and the data and computer 
system the sample was recorded on. 

3. A sample management section where samples can be loaded, unloaded, and deleted. 
4. A batch run section to run a number of samples through EwE and any loaded module and 

active plug-ins.. 

Recording Samples 

Ecosampler records samples from the Monte Carlo routine that ships with the EwE desktop 
software.  Toggle the Record button (Figure 2) to enable and disable record mode. 
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Figure 2 – Ecosampler record mode is on, and many samples 
have been recorded from Monte Carlo. Sample 9 is loaded in 
EwE, and the sample can be unloaded or deleted. 

To record samples, do the following: 
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1. Turn recording on in Ecosampler by clicking the inactive Record button until its icon turns 
red, indicating that record mode is active. A black record option indicates that Ecosampler 
recording is off. 

2. Run the Monte Carlo routine built into EwE. 

While recording, Ecosampler listens to the execution of Monte Carlo, and intercepts and stores 
any alternate mass-balanced parameter found by Monte Carla as a “sample” in the currently 
loaded model database. The samples immediately appear in the samples list, showing the current 
date and the name of the computer EwE is executed on. 

To stop recording samples, do the following: 

1. Turn recording off by clicking the active “Record” button until its icon turns black, indicating 
that record mode is inactive. 

Managing Samples 

A stored sample can be loaded in the EwE interface to assess its validity. 

To load a sample, do the following: 

1. Select a sample in the samples list 
2. Press Load. 

The sample list will indicate which sample is loaded, and when a loaded sample is selected, the 
load button text will read Unload. 

To unload a sample and restore the original Ecopath parameter values, do the following: 

1. Select the loaded sample 
2. Press Unload. 

A stored sample can be deleted if it produces unrealistic or outlying behaviour. 

To delete a sample, do the following: 

1. Select the sample to delete 
2. Press Delete. 
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Ecosampler contains a safety feature that prevents users from accidentally overwriting their original 
parameters with a loaded sample. If a sample is then modified, and then saved, Ecosampler will first restore 
the original parameters.However, it is possible to save a loaded sample as a new Ecopath base model. To do 
so, save a model with a loaded sample using the “Save As” function (“Menu > File > Save as…”). This writes 
the model under a new name, using the sample content as new Ecopath base line inputs. 

Importing Samples 

Recording a large number of samples may take considerable time, especially when Monte Carlo 
is configured to perturb the diet composition matrix and when the chances to randomly find 
alternate mass-balanced models are slim. In this case, it makes sense to record samples for 
the same model simultaneously on multiple computers. Once all recording is complete, the 
Import Samples functionality can then be used to bring all generated samples – generated by the 
Ecosampler runs in different copies of the EwE model – back into one model. 

It is NOT recommended to run multiple copies of Ecosampler on the same computer and the same EwE 
model. Microsoft Access models are not designed for concurrent writing (e.g., having multiple programs 
save changes to the same database at the same time).  If you wish to run multiple Ecosampler copies on one 
computer, then each Ecosampler copy MUST operate on its own copy of the EwE model file! 

 

To import models from another model do the following: 

1. Click Import. 
2. Select From another model. 
3. Browse to the model. 
4. Press OK. 

The sample list will be updated with samples found in the selected model. 
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Ecosampler will import samples from any model without any safety checks It is the ultimate responsibility 
of the user to check whether the import process makes sense, e.g., whether the import source and 
destination models are the same. 

The import option also provides an option to import samples generated and stored by the Cefas MSE 
routines. This logic has not been implemented yet. 

Expiring Samples 

Samples are alternate mass-balanced configurations for one specific set of values of an Ecopath 
model. If any Ecopath input parameter is changed by the user and this change is saved, all stored 
samples in principle become invalid. In this case, Ecosampler will prompt the user whether stored 
samples should be deleted. 

Running Samples 

The second aim of Ecosampler is to run samples though various components of EwE and collect 
output. 

To run Ecosampler samples through EwE, do the following: 

1. Load the desired Ecosim and Ecospace scenarios are correctly loaded. 
2. Activate desired plug-ins. 
3. Enable data auto-saving (Menu > Tools > Options > File Management) for every component 

that you wish to gather output data for. 
4. Enter the number of samples to run in the Batch run panel. 
5. Press Run. 

When a batch run is started, Ecosampler will execute the current model configuration as a 
baseline sample, and will store this in a subfolder Sample_baseline under the default core output 
path. If Ecopath does not balance, the user is notified, and the batch run is aborted. 

If Ecopath did balance, then Ecosampler checks if Ecosim, Ecospace and Ecotracer are loaded. 
Ecosampler will start processing the list of samples, starting at the first stored sample up to the 
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end of the list or until the number of requested samples has been processed. It will run each 
sample in turn. 

When running a sample, EcoSampler performs the following steps: 

• Append the current core output path with a subfolder Sample_[sample number] for the 
loaded sample. This reroutes all auto-saving component output to a unique folder per 
sample; 

• Load the sampled parameter set into Ecopath; 
• Run Ecopath, and if Ecopath balances for the loaded sample, run Ecosim (if loaded) and 

Ecospace (if loaded) with Ecotracer enabled (if loaded). Any connected component that is 
configured to auto-save its output will now do so. 

Ecosampler is a simple tool that only reruns the present EwE configuration. Ecosampler has no means to 
decide which data may need saving, and has no means to control which plug-ins will run. Instead, it relies 
on the current configuration of the EwE software to take care of this. For instance, if the Ecological 
Indicators plug-in is set to run with Ecopath and Ecospace, and Ecospace is set to autosave ASCII output 
maps in Ecospace parameters, these settings will also apply to every sample ran by Ecosampler. 

Using the Ecosampler Output 

The output of Ecosampler is an organized series of folders – a baseline output folder and a unique 
folder per executed sample – under the current EwE output directory, with regular file-based 
output for the components that were activated. Each sample folder contains the various output 
files written by EwE components set to automatically write their output to file when Ecosampler 
was executed. 

Troubleshooting 

Ecosampler writes its activities to the Ecopath log file, which can be viewed by choosing Main 
Menu > About > View Log File. 
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Further Development 

A series of future changes can be foreseen: 

• Prompt user when deleting a sample because delete cannot be undone; 
• Hide System column when there are no samples from another computer; 
• Implement a system to rate samples, where the rating may be used for randomly selected 

samples during batch runs; 
• Automatically rate or score samples when they are generated? 
• Build to logic to import samples generated by the Cefas MSE plug-in. 

Ecosampler was built by Ecopath International Initiative and has been added to the Ecopath with Ecosim 
source code repository. 

Ecosampler was realized through funding from the European Commission through the Marie Curie Career 
Integration Grant Fellowships PCIG10-GA- 2011-303534 – to the BIOWEB project. This study is a 
contribution to the projects SafeNET (EU-DGMARE MARE/2014/41) and MERCES (European Union’s 
Horizon research and innovation programme grant agreement No 689518). X. Corrales was supported by an 
IOLR scholarship under the DESSIM project (“A Decision Support System for the management of Israel’s 
Mediterranean Exclusive Economic Zone”). 
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ECOSIM 
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Density-dependent catchability 

In fisheries modelling we usually represent the fishing mortality rate F as a product of catchability 
q times fishing effort f: 

Here the catchability q represents the mortality rate caused by a unit of fishing effort, or in 
intuitive terms the proportion of the stock harvested by a unit of fishing effort. A useful way to 
think about q is in terms of the spatial or effort response power ganization of fishing: if each unit of 
effort ‘sweeps’ an area a while the stock is distributed over a total area A, and if effort is randomly 
distributed within A, then q=a/A. There are two problems with this formulation: 

• A is generally seen by both fish and fishers as a much smaller area than the map area over 
which you might display a stock’s range (neither fish nor fishing are randomly distributed, so 
A is generally much smaller than the map range area for a stock), so we usually cannot 
predict q from simple analysis of gear swept area and total range area; and 

• almost always, the actual area A occupied by fish and fishers decreases with decreasing fish 
abundance, (i.e., the occupied range ‘collapses’ as stock size decreases) due to fish behaviours 
like shoaling and also cumulative effects of localized stock depletion events. The second 
problem is particularly important for fisheries analysis, since it implies that q increases, 
sometimes grossly, as A decreases (q = a / A increases when A decreases) whether or not 
there is a change in fishing technology as represented in the area swept per unit effort. 

On entry to Ecosim, Ecopath has provided a base fishing rate Fo = Catch / (Ecopath biomass). You 
can specify time scenarios for F (Ft, t > 0) relative to this Fo by using either the fishing effort ‘sketch 
pad’ interface (Ecosim > Input > Fishing effort) or by using time reference data files (time series). 
The Ecosim default is to treat your time series values as relative or absolute fishing rates without 
reference to changes in q. But you can also treat the time input values as relative fishing efforts ft, 
where fo = Fo (efforts scaled so base qo= 1). Then to create density-dependent catchability effects, 
set a value greater than 1.0 for the Qmax/Qo ratio(s) at the Ecosim > Input > Group info form. 

For example, setting a value of 5 represents assuming that q can be as much as 5 times higher than 
the q that led to the Ecopath base Fo, if stock size is very low. That is, suppose you set Qmax/Qo = 
5, then run a scenario where you shape the relative fishing rate over time (now treated as relative 
effort) so as to cause a gross stock depletion followed by a return to ft = fo. In this scenario, the 
‘realized’ fishing rate Ft can be as much as 5 times Fo even for ft = fo, due to density-dependent 
decrease in the effective area A occupied by the depleted stock. 

Internally, Ecosim represents the density-dependent effect by calculating time dependent fishing 
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rate Ft using the equation Ft = ft QRo / [1 + (QRo – 1) Bt / Bo], where QRo = Qmax/Qo is your specified 
catchability increase ratio, Bt is stock biomass, and Bo is Ecopath base biomass. 

Note that this dependence is applied to the individual group fishing rates rather than the relative 
efforts by fishing fleets, to represent the idea that decreases in area occupied by a stock (A) 
when biomass Bt is less than the Ecopath base biomass Bo are likely to result in concentration of 
efforts by fishers in general. If you need to represent a differential change in availability of fish to 
some particular fleet(s) but not others, you will need to develop an Ecospace model that explicitly 
represents spatial distinctions in where particular gears can operate. Note further that the QR
parameter is not used in Ecospace: we assume random distribution of effort within each Ecospace 
cell, recognizing that Ecospace can already represent larger-scale range changes and associated 
changes in the spatial concentration of fishing effort. 

In Ecosim scenarios where you do choose to treat the time input fishing information as relative 
fishing efforts ft rather than absolute fishing rates Ft, you should be quite careful to recognize that 
catchability often increases quite dramatically for low values of Bt/Bo. QR values (Qmax/Qo) of 5 to 
10 are not uncommon in the fishery literature, especially for shoaling fishes like herring, sardine, 
and spawning cod. Further, modern fishing technologies like side-scan sonar and GPS are making 
fishers ever better at concentrating their swept areas a within the actual areas A where fish are 
concentrated (probability of a sweep of area a not being within the occupied area A has decreased 
dramatically). Even where there are not such technological changes, fishers are generally capable 
of making very good assessments of A just by combining their own search information with 
observation of where other fishers are doing well. 

Note that you generally do not want to set QR > 1 for ‘reconstruction’ scenarios where you 
have provided historical Ft estimates based on single-species assessment methods such as virtual 
population analysis (VPA) or stock synthesis. Presumably these methods have already accounted 
for density dependent effects on q, by calculating Ft=(historical catch)/(estimated stock biomass) 
without regard to whether the historical catch was high relative to biomass because of catchability 
changes or changes in total fishing effort. But you should check the single species assessment 
method carefully, to insure that the method did not make an inappropriate assumption about 
stability of q in its reconstruction of historical biomass, (e.g., was fitted to the data using historical 
effort data under a constant q assumption, or was ‘tuned’ to historical catch per effort data 
uncorrected for temporal/stock dependent changes in q). 
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Price Elasticity 
JEROEN STEENBEEK 

We have implemented price elasticity in Ecosim as outlined in this chapter. For background 
descriptions of how EwE is implemented in EwE please see the Ecosystem Modelling with EwE 
textbook. 

Elasticity is based on landings (Figure 1) and off-vessel price (Figure 2). 

 

Figure 1 – EwE landings form available at Ecopath < Input < Fishery < Landings. 
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Figure 2 – EwE off-vessel price, available at Ecopath < Input < Fishery < Off-vessel price. 

Users configure price elasticity through the Ecosim > Price Elasticity node in the navigation tree 
(Figure 3). In this form users define elasticity curves or ‘shapes’, and use these shapes to determine 
how (combinations of) landings affect the price of a given landing. 

The procedure is as follows: 

1. Define one or more price elasticity mediation curves, or bluntly called ‘shapes’ in EwE. As 
with every shape interface in EwE, users can alter the contour of shapes by sketching with a 
mouse, by Copy / Pasting values into the Values interface, or by selecting a mathematical 
primitive in the Change Shape interface. The result is always stunning (Figure 3).The dashed 
blue line can be moved with the mouse cursor, and indicates the mediation baseline point – 
the point where the price equals the Ecopath base value. 
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Figure 3 – Ecosim price elasticity interface, available at Ecosim < Input < Price elasticity. The 
price elasticity is used in Ecosim and inherited by policy optimizations, value chains, MSE, 
Ecospace, indeed wherever landed value is estimated in EwE. 

2. Select the supply to drive the prices via a mediation curve. To do so, select a curve in the 
price elasticity interface and press Define Supply. This opens – surprisingly – the EwE Define 
Supply form (Figure 4). Here, one or more landings (supplies) can be assigned and weighted 
to drive the prices using the selected curve.Select an available landing and press the arrow 
that points right. The landing is added as a price driver with a relative weight equal to the 
off-vessel price of that landing. The weights can be modified.The pie chart shows the 
weighted landed amounts, and thus provides a graphical overview how each landing 
contributes to overall price elasticity. The pie segments obtain the colour from the landed 
group. 
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Figure 4 – EwE Define supply interface available at Ecosim < Input < Price elasticity > Define supply. 

3. Once the Define supply form is closed, the main Price elasticity form will update to display 
supply assigned to the selected shape when the shape is selected. The shape itself will 
display the weighted supply total at the Ecopath mediation base line point (Figure 5, dotted 
blue line). Now, the supply must be applied to a landing to drive price elasticity. This is done 
via the Apply Price Elasticity node in the navigation tree, which opens the form shown in 
Figure 6. 
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Figure 5 – Defined supply for an elasticity curve. 
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Figure 6 – EwE Apply price elasticity interface available at Ecosim > Input > Price elasticity > 
Apply price elasticity. 

4. To apply price elasticity to a landing (i.e gear – functional group combination), now click a 
landing in the Apply price elasticity interface and select a supply curve that was configured in 
the previous steps. 

Elasticity is now applied and used throughout EwE. 

Note, however, that EwE does not yet have an explicit way to show how prices change. EwE will 
need this functionality, both in a plot that shows changing off-vessel prices, and written to CSV 
file when Ecosim auto-saves information. Let us know if you need it badly … 
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Vulnerability Multiplier Estimator 
CARL J. WALTERS 

Simple estimator of minimum vulnerability multiplier needed to allow a predator to rebuild by 
some assumed amount after removal of all fishing effort 

The Ecosim vulnerability multiplier interface at Ecosim > Input > Vulnerabilities > Estimate 
vulnerabilities allows users to obtain an initial estimate of the average prey vulnerability multiplier 
needed to allow a predator population to recover to some much higher level (e.g., a much higher 
historical abundance than the Ecopath base abundance) if fishing mortality were removed.  This 
initial estimate is derived by assuming that the predator will not deplete any prey populations 
when it recovers, i.e. total prey biomass Bo will remain similar to the Ecopath base value. 

Given this assumption about no prey depletion, an approximation for the predator biomass 
dynamics is given by the simple differential equation 

where the food conversion efficiency g is the ratio of two Ecopath input, g = (P/B)/(Q/B) = 
Zo/(Q0/P0), and the total food consumption rate Q summed over prey types is predicted from 
vulnerable prey biomass as Q=aVP where vulnerable prey biomass V is given by 

The vulnerability exchange rate v is calculated in Ecosim as 

where K is the vulnerability multiplier entered by the user, Q0 is Ecopath base predator 
consumption, and B0 is Ecopath base prey biomass (Ecopath base predation rate is Q0/B0, and the 
maximum predation rate v is assumed to be a multiple (K) of this base predation rate).  On entry to 
Ecosim, the predator rate of effective search a is estimated from K and base predator abundance 
P0 as 

Note that v in (3) and a in (4) both depend on the vulnerability multiplier K. 

In order to derive a simple estimator for the multiplier K, we simply set dP/dt=0 in (1), while setting 
Z=Z0-F  (i.e. set Z to just the natural mortality rate) and P equal to the unfished P or more simply 
to P=RP0 where R is the ratio of the unfished biomass that we want to achieve to the Ecopath 
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base biomass (e.g. R=10 means we want the predator P to be able to grow by a factor of 10 if 
fishing mortality rate F is set to 0).  Setting dP/dt=0 creates the algebraic condition eQ=ZP.  Next, 
we substitute (2) to (4) into this condition, and solve the resulting equation for K.   A few tedious 
algebraic steps then result in the Ecosim estimator for K used in the interface: 

where H=Z/(eB0). Note again in this equation R=P/P0, implying that we need to assume 
proportionally larger K values for larger values of K.  This equation can be parameterized in 
other ways using Ecopath input values, e.g., by noting that Q0 is estimated in Ecopath as input 
consumption per biomass (Q/B=Q0/P0) times P0. 

Most predators in Ecosim models feed on multiple prey types.  The predicted consumption rate 
Q(p) of each prey type p as predator and prey biomasses vary can be expressed using Kerim Aydin’s 
1 parameterization of the Ecosim consumption rate equation 2 

Provided the K(p) are similar for all prey types that contribute significantly to the predator diet 
and that none show substantial depletion (B(p)/B0(p) stays near 1.0 as P grows, for all p), total 
consumption rate per predator ∑pQ(p)/P will behave the same (all Q(p) will increase by the same 
function of P/Po, diet composition will not change) as if there were just one prey type as assumed 
in the basic derivation above.  That is, the really critical assumption for (5) to work is that all 
important prey types have similar K(p) and are not depleted (or changed in biomass due to other 
factors like fishing) as the predator biomass P recovers from its initial level P0. 

Note that absent dynamic changes in prey biomasses B(p) due to factors other than changes in 
P/P0, (5) represents a minimum estimate of K needed to allow an assumed growth ratio R.  If 
increases in P/P0 do cause some decreases in key prey type abundances, K will need to be set 
to higher values in order to reach the target R, and there may in fact be no K value for which 
some high assumed R (Punfished/P0) can be achieved, i.e. the modeled prey production rates may 
simply be incapable of supporting such a high assumed unfished predator biomass.  This happens 
for example in models where prey biomasses and net production at the Ecopath base system state 
are substantially lower (e.g., due to fishing) than the prey biomasses that supported the historically 
higher Punfished. 

A more elaborate, iterative approach is typically needed to set by-stanza K’s for multi-stanza 
populations represented in Ecosim by an age-structured model rather than a simple biomass rate 
equation.  Typically, fishing mortality rates for multistanza populations are substantial only for the 
older (larger) fish.  K’s for at least one juvenile stanza are typically set to low values in order to 
represent density dependent juvenile mortality (stock-recruitment relationship).  Biomass of older 
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fish can then be limited either by food availability or the number of recruits.  As a first iterative 
step, increases in biomass of older fish can be represented by setting high K’s for older stanzas, 
so that removal of fishing basically just results in increased biomass-per-recruit (due to increased 
longevity).  If that biomass-per-recruit response is insufficient to predict assumed recovery of 
biomass of older fish, it will then be necessary as a second iterative step to increase the K’s for 
at least one unfished juvenile stanza, in order to allow both increased numerical recruitment and 
maintenance of juvenile growth rates. 

Notes 

1. Aydin, K.Y., 2004. Age structure or functional response? Reconciling the energetics of surplus production 
between single-species models and ECOSIM. African Journal of Marine Science, 26, pp.289-301. 
https://doi.org/10.2989/18142320409504062 

2. see also Whitehouse, G.A. and Aydin, K.Y., 2020. Assessing the sensitivity of three Alaska marine food webs 
to perturbations: an example of Ecosim simulations using Rpath. Ecological Modelling, 429, p.109074. 
https://doi.org/10.1016/j.ecolmodel.2020.109074 
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Time Series 
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Time Series Type Unit Abbreviation Type Pool Code Pool 
Code 2 

Driver or 
Reference 

Biomass, relative BiomassRel 0 Group Reference 

Biomass, absolute t km-2 BiomassAbs 1 Group Reference 

Biomass, forced t km-2 BiomassForcing -1 Group Driver 

Forcing function TimeForcing 2 Function # Driver 

Fishing effort FishingEffort 3 Fleet Driver 

Fishing mortality year-1 FishingMortality 4 Group Driver 

Total mortality year-1 TotalMortality 5 Group Reference 

Total mortality, 
constant year-1 ConstantTotalMortality -5 Group Driver 

Catches t km-2 

year-1 Catches 6 Group Reference 

Catches, forced t km-2 

year-1 CatchesForcing -6 Group Driver 

Catches, relative CatchesRel 61 Group Reference 

Average weight AverageWeight 7 Multi-stanza 
group Reference 

Ecotracer, relative 
concentration 1 EcotracerConcRel 8 Group Reference 

Ecotracer, absolute 
concentration 1 EcotracerConcAbs 9 Group Reference 

Discard proportion, 
absolute DiscardProportion 10 Fleet Group Driver 

Discard mortality 
rate, absolute year-1 DiscardMortality 11 Fleet Group Driver 

Landings, absolute t km-2 

year-1 Landings 12 Fleet Group Reference 

Discards, absolute t km-2 

year-1 Discards 13 Fleet Group Reference 

Catchabilities 2 Catchabilities 14 Fleet Group Driver 

Table 1 - List of time series types and their abbreviations that can be used in Ecosim along with 
description. Notice that for reference time series, the CSV file weight can be [0, ∞] while the weight is 
not used for driver time series (so just set it to 0).  Where no unit is indicated, the time series is a 
relative value (so no unit). Pool code and Pool code 2 should be numbers. 
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Time Series Type Unit Abbreviation Type Pool Code Pool 
Code 2 

Driver or 
Reference 

Off-vessel price, 
absolute $/t OffVesselPrice 15 Fleet Group Driver 

Off-vessel price, 
relative OffVesselPriceRel -15 Fleet Group Driver 

Effort cost, absolute 
3 % EffortCost 16 Fleet Group Driver 

Effort cost multiplier 
3 EffortCostRel -16 Fleet Group Driver 

Sailing cost, absolute 
3 % SailCost 17 Fleet Driver 

Sailing cost 
multiplier, relative 3 SailCostRel -17 Fleet Driver 

Fixed cost, absolute 3 % FixedCost 18 Fleet Driver 

Fixed cost multiplier 
3 FixedCostRel -18 Fleet Driver 

Fishing mortality FishingMortalityRef 104 Group Reference 

Diet composition 1 Diet Group 
(predator) 

Group 
(prey) Reference 

Table 1 - List of time series types and their abbreviations that can be used in Ecosim along with 
description. Notice that for reference time series, the CSV file weight can be [0, ∞] while the weight is 
not used for driver time series (so just set it to 0).  Where no unit is indicated, the time series is a 
relative value (so no unit). Pool code and Pool code 2 should be numbers. 

1 Not yet implemented in EwE 

2 Time series 14 replaces the catch abilities input interface in EwE 6.6 

3 These time series vary the Ecopath > Input > Fleet cost proportions 
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Time Series Fitting 

Ecosim can incorporate (and indeed benefits from) time series data. For many of the groups to 
be incorporated in the model the time series data will be available from single species stock 
assessments. EwE thus builds on the more traditional stock assessment, using much of the 
information available from these, while integrating to the ecosystem level. 

When an Ecosim model is loaded, you can load time series “reference” data on relative and 
absolute biomasses of various pools over a particular historical period, along with estimates of 
changes in fishing impacts over that period. After such data have been loaded and applied (using 
the Time series form), a statistical measure of goodness of fit to these data is generated each 
time Ecosim is run (using the Run Ecosim form). This goodness of fit measure is a weighted sum 
of squared deviations (SS) of log biomasses from log predicted biomasses, scaled in the case of 
relative abundance data by the maximum likelihood estimate of the relative abundance scaling 
factor q in the equation y = qB (y = relative abundance, B = absolute abundance). 

Each reference data series can be assigned a relative weight using a simple spreadsheet in the 
search interface, representing a prior assessment by the user about relatively how variable or 
reliable that type of data is compared to the other reference time series (low weights imply 
relatively high variance, unreliable data). 

The time series fitting uses either fishing effort or fishing mortality data as driving factors for the 
Ecosim model runs. A statistical measure of goodness of fit to the time series data outlined above 
is generated each time Ecosim is run. The model allows four types of analysis with the SS measure 
(see Fit to time series for help with implementing these analyses): 

• Determine sensitivity of SS to the critical Ecosim vulnerability parameters by changing each 
one slightly (1%) then rerunning the model to see how much SS is changed, (i.e., how 
sensitive the time series predictions ‘supported’ by data are to the vulnerabilities); 

• Search for vulnerability estimates that give better “fits” of Ecosim to the time series data 
(lower SS), with vulnerabilities ‘blocked’ by the user into sets that are expected to be similar; 

• Search for time series values of annual relative primary productivity that may represent 
historical productivity ‘regime shifts’ impacting biomasses throughout the ecosystem; 

• Estimate a probability distribution for the null hypothesis that all of the deviations between 
model and predicted abundances are due to chance alone, i.e. under the hypothesis that 
there are no real productivity anomalies. 

In addition to the nonlinear optimization routines described above the fit to data can also be 
improved in a feedback-process by examining some of the crucial ecological parameters in the 
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EwE model (notably total mortality rates and the settings for top-down/bottom-up control). It 
is important to note here that such fitting does not include any “fiddling-factors” internal to the 
model, instead the type of question that is addressed after each run is “which species parameters 
or ecological settings are not set such that the model captures the observed trends over time 
adequately?” 

The inclusion of time series data in EwE facilitates its use for exploring policy options for 
ecosystem-based management of fisheries. An important preliminary conclusion from 
applications to various ecosystems is that the model is capable of producing a reasonable fit, (i.e. 
fits that can be compared to those obtained using single species models) for all available time 
series related to the ecological resources of an ecosystem in one go. This indicates a capability 
or at least a potential to replicate the known history of the ecosystems. In turn this lends some 
confidence to how the model can be used for policy exploration. It is also indicated that the fitting 
of time series in Ecosim may be used not just for identification of ecosystem effects of fishing but 
also to address questions of environmental impact at the ecosystem level (as well as for individual 
groups of course). 

Time Series Fitting  |  69



Hints for time series fitting 

If a model can’t reproduce the past, how credible is it that it can predict the future? 

If it can reproduce the past, maybe one can a bit less skeptical about its ability to predict the future? 

A critical step in development of credible models for policy analysis is to show that they can at 
least reproduce observed historical responses to disturbances such as fishing. 

This demonstration necessarily involves an iterative exercise in ‘fitting’ the model to data, by 
correcting parameter estimates and time series forcing information so as to show what values 
(or ranges of values, or alternative hypotheses about key processes) could explain the observed 
historical patterns . For any such fitting exercise, it is critical to have as long a reference period, 
with as many different disturbance patterns, as is possible to assemble. Note though, that only 
where a time series is used to ‘drive’ the model, (i.e. fishing mortalities and effort series) is it 
necessary to have information for all years in the time series. 

Estimates of relative abundance, catches, etc. are not required for all years. Short reference data 
series carry little information about responses to some disturbances, and hence ability of a model 
to fit such short series 

is no test at all of its ability to make useful predictions about disturbances not represented in 
the reference data. In more vivid terms, many model errors (structure and parameter values) will 
only reveal themselves (make themselves evident through strong departures of predicted from 
observed patterns) when the model is challenged to reproduce very long time series of responses. 

Here we recommend an iterative, stepwise procedure for model fitting. It is generally not possible, 
or even wise, to try fitting a large ecosystem model using one big nonlinear estimation scheme 
that simultaneously varies all uncertain model parameters and inputs. There are simply too many 
inputs, some of the parameters are constrained in complex ways by mass balance considerations, 
and many model errors involve qualitative omissions of interaction terms (or processes, or 
disturbing inputs) entirely. Such possible omissions are most productively viewed as ‘alternative 
hypotheses’ about what processes and inputs have been important in shaping historical ecosystem 
behaviour. 

The basic idea in this procedure is as follows. Set up an Ecosim model and reference time 
series (of forcing inputs like fishing rates, and indices of temporal system response like relative 
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biomasses and estimated total mortality rates). Examine the simulated and observed time patterns 
of response indices, look for groups that show large discrepancies in time pattern (trend), with 
particular emphasis on groups that have high biomass and are important prey or predator for 
other groups. As an example, sardines and anchovy in a Benguela model (Shannon et al., 2004) 
showed upward trend in data but not in initial simulation results. Focus in turn on each such 
group, and examine alternative hypotheses for the discrepancy (by varying appropriate 
parameters to see if the model fit is improved). The following are common hypotheses that should 
be examined in roughly the order listed: 

Bad trend data — it is possible that the model predictions are sound, but that the trend 
data are misleading for some reason, (e.g., increasing catchability in CPUE indices). 

Incomplete or incorrect forcing data, especially for fishing mortality rates—Ecosim- 
simulated patterns for exploited species will obviously not track observed patterns if those 
patterns have been caused by fishing, but no good time pattern of fishing mortalities (or at 
least fishing efforts) have been provided. 

Inappropriate vulnerability parameters for the group’s prey — low vulnerability multiplier 
settings (e.g., the 2.0 default) for a group’s column in the vulnerability matrix (of its prey 
to it) can cause two errors: (i) failure of the group to increase following reductions in 
mortality (due to preventing the group from increasing its total food intake); (ii) and/or 
failure of the group to decrease following increases in mortality, due to overestimates 
of compensatory Q/B responses to decreased intraspecific competition. Check this by 
clicking the ‘sensitivity of SS to vulnerabilities’ button in the Fit to time series form to 
determine whether vulnerability changes would cause changes in goodness of fit, and 
consider using the fitting interface to search for improved vulnerability estimates. See 
Effect of P/B (Z) and vulnerability for time series fitting for more information. 

Incorrect P/B (Z) setting in Ecopath for the group—it is common to see P/B, i.e. Z values 
set far too large in the Ecopath inputs, resulting in low EE and hence low sensitivity of a 
group to changes in mortality agents. Check the simulated time plot of total, fishing, and 
predation mortality rate components on the Ecosim Run Ecosim form to see if the total 
mortality rate and its partitioning among factors are reasonable. See Effect of P/B (Z) and 
vulnerability for time series fitting for more information. 

Changes in system productivity—in some systems we have seen correlated declines or 
increases across a variety of species, despite differences among species in harvesting 
impacts, which might be explained by changes in basic productivity due to factors like 
upwelling. The Ecosim Fit to time series form can be used to ‘reconstruct’ an apparent 
temporal pattern in primary productivity, by fitting the model to time series for all groups 
while varying a time series of productivity ‘anomalies’. 
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Trophic mediation effects—evaluate the possibility that changes in consumption and 
mortality have been caused by ‘indirect’ or ‘mediation’ effects, such as groups providing 
hiding places for other groups or driving behaviour of groups so as to make those groups 
more or less vulnerable to other predators. In systems that have benthic and pelagic 
primary producers, note that shading effects by phytoplankton on benthic plants are 
not represented explicitly in Ecosim, and must be modelled as mediation effects (by 
setting up a mediation function that causes negative effects on benthic plant production 
as phytoplankton biomass increases). This is also the case with turbidity and decreased 
foraging efficiency of visual predators that can be caused by phytoplankton. 

If none of these hypotheses produces predicted patterns similar to the data, look closely at the 
Ecosim predicted patterns of change in consumption, growth, and mortality rates, and try to 
evaluate how these rates would have to change in order to produce observed trend patterns. 
Examine the observed time series for other groups, particularly prey and predators of the group 
under study, to see if those time series suggest changes in trophic conditions (growth, mortality) 
that have not yet been captured by the model due to inappropriate parameter settings for the 
other groups. 

Repeat the multiple hypothesis evaluation steps above for each group, with initial emphasis on 
those groups for which the model predictions depart strongly from the data. Note that ‘correcting’ 
the parameters and time inputs for any one group can either improve or degrade the model fits 
for other groups, including groups for which good fits have already been obtained. This means 
that the fitting/evaluation process is necessarily iterative, requiring several passes or tries to 
obtain an overall valid model. For example, in the Benguela model example, obtaining good fits 
to strong time trends in sardine and anchovy biomass (using hypotheses (3) and/or (5) above) 
resulted in predicted increases in several predator populations, particularly hakes, for which the 
data do not indicate such increase. An interesting question then arose about why the predators did 
not show responses to the apparently large prey increases, and this question led to examination 
of a variety of hypotheses about why the response did not occur (limitation of recruitment due 
to cannibalism, undetected increases in fishing impact as responses started to occur so as to 
prevent those responses from being expressed, errors in initial estimates of diet composition and 
dependency on sardines and anchovy by the predators, etc.). 

It is possible for the step-wise, iterative process of hypothesis evaluation and model testing/
fitting described above to fail completely, in at least two basic ways. First, it may result in an 
apparently endless cycle back and forth between groups, with each step in the cycle resulting in 
improvement in fit to one group at the expense of poor fit to others. Such cycles have not yet been 
seen in case studies, but would indicate either ‘contradictory data’, where the model structure is 
valid but one or more trend data sets are misleading and apparently contradict the others, or a 
fundamental failure of the model structure to represent some important interactions or processes. 
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Second, the model may fail to capture (due to lack of correct input data or structural error) the 
dynamics of some particular, important group that has driven the dynamics of several others, and 
inability to simulate this one group may contaminate a variety of model predictions. For example, 
in models of the Bering Sea ecosystem, we have had trouble simulating (explaining) declines that 
apparently occurred in small, inshore pelagic fish species in the late 1970s and early 1980s. These 
declines were associated with onset of a rapid decline in Stellar Sea Lion, and onset of a strong 
upward trend in jellyfish (which compete with small pelagic fish for zooplankton). In that model, 
simply forcing the small pelagics to decline (with an arbitrary fake fishery) results in considerably 
better fits to the data for the other groups. In several models of relatively small oceanic regions 
(North Sea, West Coast of Vancouver Island), we have had to deal with apparently unpredictable 
biomass dynamics of species (especially mackerels) that have apparently invaded the regions in 
conjunction with changing ocean climate regimes. In fact, it is probably a general principle that 
for any region that might be arbitrarily defined for analysis, there are at least some species that 
have potentially important impact (on predator-prey relationships) within the region but display 
changes that can only be explained by examining their dynamics (production, fishing impacts) 
over some much larger spatial domain. With respect to any small study region, it is appropriate 
to treat the abundances of such species as forcing functions provided policy choices made within 
the region are unlikely to affect the larger scale dynamics of those species. 

In most early Ecosim fitting exercises, the goal has been to find even one reasonably good fit to 
the data, i.e. to simply demonstrate whether the model is capable (flexible) of describing historical 
patterns. During such exercises, interesting alternative hypotheses and parameter changes that 
might have provided equally good explanations have not been thoroughly documented and 
pursued, nor have users typically even recorded the often simple research studies and auxiliary 
measurements that would be needed to test among alternatives (e.g., diet composition studies 
to detect rare prey in cases where an abundant predator may have big impacts on such prey 
despite such prey not being important to support of the predator). This failure to document the 
‘brainstorming’ process involved in model fitting/testing can be costly for people who then try to 
use the model for policy analysis for several reasons: 

Clear articulation of alternative hypotheses that could equally well explain historical 
changes is a critical part of adaptive policy design involving planned experimental 
comparisons of policy options; 

Analyses based on the model are left open to attack by stakeholders who have vested 
interest in presuming some particular hypothesis to be true (e.g. people who want to blame 
stock declines on environmental factors so as to avoid restrictions in fishing); and 

Potential value of the modelling to help guide and prioritize research projects is lost, and 
this is a very big issue indeed in situations where very limited scientific resources are 
expected to provide useful information for complex ecosystem management planning. 
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Documentation of alternative hypotheses and parameter-changes during the sequential fitting 
process would appear at first glance to be an exceedingly complex process, involving geometric 
increase in number of hypothesis combinations as more time series and groups are examined (e.g. 
if there are two ways to explain changes in group 1, and two ways to explain changes in group 
2, there are 4 possible ways to explain the joint dynamics). This ‘explosion’ in hypotheses is not 
that serious a problem in practice, for at least two reasons: (1) uncertainty about why a group has 
responded or not may be independent of uncertainty about why other groups have responded, e.g. 
we can examine hypotheses (and policy implications) about failure of hake to increase following 
sardine-anchovy increases in the Benguela system, without regard to what drove those increases 
in the first place; and (2) typically the alternative hypotheses involve ‘environmental forcing’ versus 
fishing effects, and the environmental forcing hypotheses are not independent for each group (i.e. 
hypotheses about increases or decreases in productivity due to factors like upwelling are expected 
to apply to a variety of groups). The main implication of point (2) is that we can generally identify 
just a few overall hypotheses for why an ecosystem has behaved as it has, each with very different 
policy implications. For example, in the Georgia Strait, B.C. models, two main hypotheses have 
emerged (can be made to fit the data using Ecosim) about why a whole suite of fish species has 
declined: either the system as a whole has experienced major decreases in primary production, or 
the observed dramatic growth in marine mammal populations (harbour seal) has had devastating 
impacts not reflected in the relatively crude diet information available from historical studies (in 
conjunction with modest declines in primary production). 

Impact of P/B (Z) and Vulnerability Multipliers on Time Series Fitting 

For the balancing it is useful to think of how growth and mortality is modelled in Ecosim. Mortality 
is considered a linear function of biomass (solid line in Figure 1), while the population increase 
will be a non-linear function of the biomass (dotted line in Figure 3.9). This non-linear function 
corresponds to the consumption times the gross food conversion efficiency (from Ecopath, where 
it is estimated as base production over base consumption). For a given biomass, the population 
will increase or decrease depending on the area between the lines. The growth/decline of a given 
population can hence be modified by changing either the mortality rate, or food consumption. 
Food consumption, in turn, is a function of complex predator-prey relationships modelled using a 
variable ‘vulnerability’ setting for top-down vs. bottom-up control. 
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Figure 1 – The solid line shows the predicted mortality calculated as Z · B, 
and the dotted line the population growth estimated as a function of the 
consumption. The area between the lines can be considered ‘surplus 
production’. 
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Multi-sim 

General Description 

This plug‐in was created with Dr. Alida Bundy, Fisheries and Oceans Canada to allow multiple 
simulations changing one or multiple forcing functions without having to upload files individually. 
This allows for selection of multiple files (.csv) to be read in collectively, as the plug‐in will run one 
simulation per file used as a forcing function. The file(s) can be used to alter one or more forcing 
functions within the model, using corresponding names to existing forcing functions. Input and 
output can be selected as monthly or annual time steps, and allowing one to choose which output 
files each simulation will generate. 

Setting Up CSV Files Before your Simulations 

This plug‐in was designed to alter a subset of forcing functions existing within the model to test 
the effects on the functional groups within the model. In order to correctly read in one or more 
forcing functions, there are a few criteria you must include in your csv file. It should be noted that 
the names of your csv files are not important to the program or plug‐in, only to the user. 

1. The name of the forcing function you are altering must match EXACTLY to the forcing 
function already existing within the model, so it will be applied correctly. Be sure your names 
are indicated as text, In order to be sure, you can add quotations to your names in excel so 
that a name such as Ice will look like “Ice”. The best way to check your names are indicated as 
text is to open them in notepad to be sure there are quotations around the names. 
Sometimes excel will read things as text, but not indicate this, so best to check in notepad. 

2. Your forcing function must be structured as either monthly or annual, with all csv files being 
read in at a time (as in step #2) being consistent. 

3. No labels are needed for time steps. Meaning if you are reading in 1 forcing function, only one 
column of data should exist in the csv, do not include a month or year column as names/
numbers 

4. The values for the first year should average 1 (as with any forcing function) 

Example: For a model with 2 existing forcing functions, “Temp” and “Ice” 
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Figure 1 – Forcing functions to be altered by Multi-sim 

If we were going to change only the “Ice” forcing function, the corresponding csv file would look 
like Figure 2A (for the first 24 time steps). Note: these are monthly time steps with the first 12 
months averaging 1. If we wanted to alter both “Temp” and “Ice”, the csv file would look like Figure 
2B. 
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Figure 2 – Changing one (A) or both (B) forcing functions 

How to Use: 
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Figure 3 – Finding Multi-sim in the EwE Navigator. 
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1. Open an Ecosim scenario within your existing model. Be sure to load your time‐series and 
double check all mediation functions, forcing functions, and fishing effort are already applied to 
the correct groups. Then select Ecosim > Tools > Multi‐sim (Figure 3). 

2. Selecting Input Files (Figure 4): Click on the choose button at the end of the source file line 
to select the source files containing the forcing functions to be changes during the simulations. 
Once you have pointed to the correct folder you may choose to select all files within the folder by 
selecting the all button, or you can select individual files by checking the boxes located to the left 
of the file name. Once you have selected all of the files you want to run, be sure to indicate whether 
the forcing functions should be read in as monthly or annual values. (see section on setting up 
files). 

 

Figure 4 – Selecting Multi-sim input files 

3. Selecting Output Files: Select the folder where the results of each simulation will be stored 
by clicking the choose button at the end of the output pathway and point to the correct folder. 
If you would like each simulation to generate its own folder (rather than all output files ending 
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up in one folder), check the create unique folder for every run box at the bottom of the page. 
Once the output path has been chosen, you may select which results you would like saved for 
each simulation. You may choose to select all options my clicking the all button in the lower right 
corner, or check the boxes next to individual files. 

 

Figure 5 – Select Multi-sim output files 

4. Interrupting simulations: Once steps 1‐3 are complete you may select the run button to start 
your simulations. Once simulations have started, there is the option to interrupt and cancel the 
application by using the stop button. This will halt the current simulation and prevent the plug‐in 
from completing further simulations. You will notice a little red circle at the bottom left of your 
screen once simulations have started indicating which simulation is running which corresponds 
to the source file name. 
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Figure 6 – Interrupting Multi-sim 
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Figure 1 – Original Contours Figure 2 – BetaPDF distribution 

Figure 3 – Exponential Distribution Figure 4 – Hyperbolic Distribution 

Function shapes 

The Ecosim and Ecospace modules contain forcing functions and mediation functions through 
which temporal dynamics of the model can be influenced. These functions can be arbitrarily 
sketched, obtained from external data where known, or derived from a series of predefined 
mathematical distributions. 

The EwE software offers the predefined distributions illustrated in Figures 1 to 10. In addition, 
efforts are under way to allow users to programmatically add their own distributions via plug-ins. 
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Figure 5 – Left Shoulder Distribution Figure 6 – Right Shoulder Distribution 

Figure 7 – Linear Distribution Figure 8 – Normal Distribution 

Figure 9 – Sigmoid Distribution Figure 10 – Trapezoid Distribution 

 

We illustrate the variables and use of forcing functions shape with an example, see Figure 11. 
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Figure 11 – Sigmoid response function in the Ecosim > Input > Forcing function > Change shape form. 

• X min – Minimum value of the X axis data 
• X max – Maximum value of the X axis data 
• X mid – Middle of the curve, where the sigmoid function returns 0.5. This does not have to 

be the mean value of the X axis data. 
• X opt – Point on the X axis where the sigmoid function returns 0.998, just short of 1.0 so the 

function doesn’t have to be completely flatten at this point. Entering this value cause the 
Steep parameter to be calculated, even if it has been entered. If X opt. is greater than X mid. 
then the shoulder is increasing to the right. If X opt. is less than X mid. then the shoulder will 
decrease to the right. 

• Steep – Steepness of the curve, high values will make the curve steeper 
• Y max – Maximum value on the Y axis. By default this is one. Included as a parameter so the 

sigmoid function shapes can be used as a forcing function, this allows for sigmoidal growth 
or decay in a forcing function. 

From a user’s perspective it would be good to set the X axis data range (X min. and X max.) in 
the Functional response to environmental forcing. In this dialogue the response function and the 
forcing data are both displayed in the Driver histogram & response function plot, there is also UI 
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elements for X min. and X max. and a button to set the Default X axis. Unfortunately, because of 
the way the Functional response to environmental forcing… dialog has been programmed, it is 
awkward to use these values to set the default X min. and X max. values. 

If X opt. has been entered then Steep parameter will always be calculated, even if it has been 
entered. To use the Steep parameter instead of X opt., clear the X opt. value and enter only Steep. 

Sigmoid functions from older version of EwE are still be included for backwards compatibility. 
They will appear as Sigmoid_Legacy in the Shape type list 
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Other Mortality Response Functions 
DAVID CHAGARIS; JOE BUSZOWSKI; AND JEROEN STEENBEEK 

Scope and Purpose 

This document provides usage instructions for the other mortality response function in the 
Ecopath with Ecosim food web modelling approach. 

Summary 

Aquatic ecosystems are often exposed to mass mortality events that can be caused by a variety 
of factors such as low dissolved oxygen, harmful algal blooms, extreme heat/cold events, 
contaminants, or noise pollution.  The EwE software includes the ability link environmental drivers 
to the ‘other mortality’ (M0) component (non fishing or predation) to simulate direct lethal effects 
of environmental stressors.  The MO response function can be used in combination with the 
habitat capacity model to capture both lethal and sublethal (feeding and movement) effects in the 
model.   An example application to red tide on the West Florida Shelf is provided in publication  by 
Vilas 1 and Vilas et al. 2 3. 

Computations 

The amount of other mortality that is to be added to the baseline M0 is determined by a user 
defined environment response function and input environment forcing time series (if in Ecosim) 
or driver maps (in Ecospace).  The forcing data must be continuous in nature, representing the 
concentration or intensity of the mortality agent. The M0 response function can take any shape, 
but must be constrained between 0 and 1 across all values of the mortality driver.  An example of 
the useful logistic response function is given in Figure 1. 
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Figure 1 – An example M0 response function assigned in the Ecospace environmental response form.  Here a 
logistic function is used to model the increasing mortality with higher concentrations of red tide as a mortality 
agent. 

The proportion of the total biomass that will experience mortality in a given time step and grid 
cell is given as , where x is the value of the mortality forcing function at the time 
step and grid cell and Pmort is calculated from the response curve at the value of x.  The proportion 
killed is converted to an annual instantaneous rate, , to match Ecopath M0 units (1).  The 

rate is then converted to a multiplier (M0mult) on the baseline M0 rate (M0base). 

In Ecosim and Ecospace, the M0 multiplier is included in the loss equation (3) at each time step 
and grid cell as, 

Where Q is the total consumption of group i by all predators, Ftime is the fraction of other mortality 
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sensitive to changes in feeding time, M0pred is the effect of predators on feeding time, E is the 
emigration rate, F is the fishing mortality rate, and B is biomass. 

Configuring M0 Environmental Response Functions 

First, the mortality agent must be loaded as a forcing function time series (in Ecosim) or as an 
environmental driver in Ecospace linked to external data.  Next, create a new response function 
using the Ecospace > Input > Environmental Responses interface (Figure 1).  From there, select 
the Define environmental response… button to open a new window, select the Other mortality 
radial button, then click on the mortality agent under the list of Spatial-temporal drivers, select 
a species or functional group, and click the plus button to apply the mortality response (Figure 
2).  Alternatively, one may go to the Apply mortality response under the Environmental Responses 
menus (Figures 1 and 3) to associate a functional groups with a mortality curve.  The total calculate 
loss due to other mortality forcing is saved as time series, summed over all grid cells by Ecospace 
region, or as ascii maps for biomass loss in each grid cell.  These output options must be selected 
in the Ecospace parameters save settings. 

 

Figure 2 -Linking a species to a mortality response curve can be accomplished in the Define environmental 
response… form, accessed from the Ecospace > Input > Ecospace environmental responses window (see Figure 1). 
Here all six age stanzas of gag are assigned a mortality response to red tide, as well as red group age-0. 
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Figure 3 – Linking a species to a mortality response curve can be accomplished in the Apply mortality response 
form under Ecospace > Input > Ecospace Environmental responses.  Here all six age stanzas of gag are assigned a 
mortality response to red tide. 
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Monte Carlo 

Ecosim includes a Monte Carlo approach to search for Ecopath parameter-combinations that 
improve the fit of the model totime series data (i.e., reduce the weighted sum of squared 
deviations, SS; see Time series fitting in Ecosim). The Monte Carlo approach can also be used to 
test for sensitivity of Ecosim’s outputs to Ecopath input parameters. 

To use the Monte Carlo interface, open the Monte Carlo run form (Ecosim > Output > Tools > Monte 
Carlo runs). 

Monte Carlo inputs 

Number of simulation trials 

Set the number of trials. Each trial represents an Ecosim run with a randomly-selected set 
of Ecopath parameters (B, P/B, EE, BA) foreach group. Parameters are drawn from a uniform 
distribution centred on the base Ecopath value with coefficient of variation (c.v.), which may be 
derived from pedigree. 

Show biomass trajectories on Ecosim plot 

Displays Ecosim results on the Biomass plot tab in the lower panel of the form. 

Apply time series 

Opens a dialogue box where you can apply time series that have been loaded into Ecosim (i.e., you 
do not have to return to the Time series form to apply time series). You can also remove time series 
from the analysis using this dialogue box. See Time series for moreinformation about loading time 
series in Ecosim. 

B, P/B, EE, BA 
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The Ecopath parameters tabs in the lower panel show the mean, lower limit and upper limit of 
the distribution used to draw randomvalues for B, P/B, EE and BA for each group in the model. 
The mean of the distribution is set as the base Ecopath value of the parameter. Users can set 
the coefficient of variation (c.v.) which is then used to calculate the upper and lower limits of 
the distribution (upper limit = mean + 2 * c.v. * mean; lower limit = mean – 2 * c.v. * mean). For 
parameters you do not wish to change, set the c.v. to zero. 

Note that the parameter combinations resulting from the random draw must result in a balanced 
Ecopath model (i.e., before running each trial, Ecosim keeps drawing new sets of parameters 
until a balanced Ecopath model is achieved). This means that the range of the parameter values 
actually used may be smaller than that set by the user. Users should check the range of the input 
parameters that wereactually used in the trials in the output .csv file(see below). 

Monte Carlo outputs 

Trial 

Tracks the current trial number. 

Ecopath runs 

Tracks the number of parameter-combinations tried until a balanced Ecopath model is achieved. 
Note that the maximum number of triesis 2000. If a trial reaches 2000 Ecopath runs then a 
balanced model could not be achieved with any parameter combinations and the simulation trial 
is run with an unbalanced model. 

This may indicate that the cv’s have been set too large, reducing the likelihood of finding 
parameter values that combine to produce a balanced model. 

SS measures 

At the top right-hand side of the form, the original (i.e., before the simulation) weighted sum of 
squared deviations (SS) is shown.Current SS shows the value of SS achieved for the current trial. 
Best SS shows the lowest SS achieved for any of the runs. 
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Data from best fitting trial 

After all trials have been completed, the parameter-values that resulted in the lowest SS are shown 
on the second-last tab in the lower panel of the form. When the trials are complete, the software 
automatically displays this tab. 

Biomass plot 

If the Show biomass trajectories on Ecosim plot box is checked, biomass trajectories are displayed 
for each trial on the Biomass plot tab. This tab is automatically displayed when you click Run trials. 

You can choose to overlay trajectories for each trial, switch from monthly to annual output and 
scale the results using check boxes.Show/hide groups, highlighting of trajectories for a single 
group and viewing of layers is also enabled, with the same functionality as for the Run Ecosim 
form. 

The Apply best fits button applies the parameter-values that resulted in the lowest SS (shown on 
the Data from best fitting trial tab) to your Ecopath model (i.e., overwrites the original values). 

Warning: it is a good idea to save a backup of your model using Save as on the File menu before you 
overwrite your original parameters using Apply best fits! 

 

Attribution 

This chapter is in part adapted from the unpublished EwE User Guide: Christensen V, C Walters, D Pauly, R 
Forrest. Ecopath with Ecosim. User Guide. November 2008. 
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Fishing policy exploration 

Parameters 

Discount rate: What is it worth for you today to get a million Euro next year, compared to getting 
it today? Economists discount the present value of future income by using a discount rate. The 
optimization routine uses a default a discount rate of 4%, which means that the current value of 
getting a Euro in one year is €0.96 (= (1+Discount rate)-1). (Use default if you don’t have a prescribed 
discount rate to use) 

Number of runs: If you set the Initialize using option to “Random F”, the optimization routine will 
use a random starting point. As the routine may get stuck on local minima, it makes sense to try 
several times. (perhaps 10). In nonlinear optimization practice, this is called “multiple shooting”. 

Initialize using: There are three options, 

1. Ecopath base F: Starts with the Ecopath base fishing effort, (which typically will be 1) 
2. Current F: when used with a base year that’s different from year 1, selecting this option will 

make the policy search start with the effort of the base year 
3. Random F: selects random effort for each fleet. This option is important to evaluate if there 

are local minima. The policy search can get stuck on local minima, and the best way to 
evaluate the risk of that is to run a number of trials, starting each with random effort. 
Note that if the Number of runs is set to more than 1, the Initialize using will change to 
using Random F. 

Max. no of evals: The optimization routine does a large number of Ecosim runs during an 
optimization, often several hundred. The parameter sets a limit for how many. (Use default setting 
unless your model won’t converge with this). 

Base year: By default this is year 1, and if so, your economic parameters should be for the Ecopath 
base year (= year 1). Assuming your model is fitted to time series data, e.g., for years 1 to n, it 
may make sense to do the optimization looking forward to the post-fitting period (year n+1 on). 
In that case, add, e.g., 20-30 year to the run time (Ecosim > Input > Ecosim parameters > Duration 
of simulation (years)), and change the Base year accordingly. If you increase the base year, the 
interface will block out (in black) the years prior to the base year, i.e. Ecosim will run with stored 
effort for those years, not try to estimate any. 

To minimize the risk that the optimization will result in overexploitation towards the end of the 
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simulation, the simulation routine will run for an additional 20 years beyond the last year, and the 
results for that last block of years will be included in the output. 

Max effort change: Provides a limit for how much effort is allowed to change from one year to 
the next. The parameter should be entered as a factor ⯑ ≥ 1. With a value of, e.g., ⯑ = 1.1, the 
routine will at most accept a change in effort for the following year in the range [0.909, 1.1]. With 
the default value of 0, there is no limit for how much effort can change. 

The changes are only for between-blocks years, for instance where there are several blocks for a 
given fleet, perhaps to have some additional years for rebuilding a stock followed by a different 
management patterns for later years. In that case, the max. effort change will be evaluated only 
when changing from one block of years to the next. 

Search using: Decides which search algorithm to use for the minimization, either DFPmin or 
Fletch, 

1. DFPmin: The Davidson-Fletcher-Powell 1 optimization procedure is a nonlinear optimization 
procedure to iteratively improve an objective function by changing relative fishing rates, 
where each colour-coded “year/fleet block” defines one parameter to be varied by the 
procedure, (e.g., setting four colour code blocks means a 4-parameter nonlinear search). 
DFP runs the Ecosim model repeatedly while varying these parameters; in the search output 
display, each simulation trial is labelled an “eval” or function evaluation.  So if you are running 
a large model for many years, where each simulation takes several seconds to do, the search 
may take quite a long time to do enough function evaluations to find a maximum for the 
objective function. 
The parameter variation scheme used by DFP is known as a ‘conjugate-gradient’ method, 
which involves testing alternative parameter values so as to locally approximate the objective 
function as a quadratic function of the parameter values, and using this approximation to 
make parameter update steps.  It is one of the more efficient algorithms for complex and 
highly nonlinear optimization problems like the one of finding a best fishing pattern over 
time for a nonlinear dynamic model. 

2. Fletch: An efficient non-linear search routine, older and less-well known than DFP, but faster 
and more efficient for many problems. Used by default. 

Use plug-in economic data: When defining a fleet in the Ecopath base model, there are input 
values for costs as a fraction of income (Ecopath > Input > Fishery > Fleets) based on which the 
baseline costs are obtained (default is that cost is 80% of revenue). The revenue is obtained from 
the Ecopath baseline landings times off-vessel price.  In Ecosim, revenue for each time step will be 
calculated the same way, while cost will change proportionally to effort. 

The checkbox will be enabled if a value chain has been defined for the model, and the “Run with 
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searches” option has been checked (at Ecopath > Output > Tools > Value chain > Parameters). If the 
Use plug-in economic data is checked, the fishing policy search routine will run the value chain 
for each run and obtain revenue and costs by fleet and time from there. 

Limit cost > earnings: When maximizing for jobs (landed value) the search routine can create 
rather extreme policies, often driving the system towards mono-culture system configuration or 
fishing at a loss (implied subsidy to increase jobs). For Anchovy Bay, as an example, this may result 
in higher landed value, comprised almost exclusively of shrimp and anchovies. This corresponds 
to a “sole owner” or societal approach (see textbox in Fishing policy exploration chapter), and it is 
implemented if you do not check the Limit cost > earnings option (default option). 

Checking the Limit cost > earnings option, leads to an optimization where the policy search will 
seek to make each fleet profitable, corresponding to a “multiple fishing rights” approach, (see 
textbox in Fishing policy exploration chapter). 

The Limit cost > earnings will only have impact if the Net economic value is included in the objective 
function. 

Maximize portfolio utility: As described in the Fishing policy exploration chapter, there are two 
alternative objective functions in the policy search. Checking the Maximize portfolio utility 
option invokes the alternative objective function that invokes risk-averse utility measures that 
favour a balanced ‘investment portfolio’ of fishing activities. See the Risk-averse portfolio utility 
chapter for details. 

Blocks 

This section of the interface is designed to set up how many fishing effort fleet-time blocks that 
the fishing policy search should try to optimize. A block is represented by a colour, and by default 
the routine searches for one fishing effort per fleet (one time block). The base year (by default year 
1) and any preceding year are by default coloured black, that means that the routine will not search 
for those years but instead retain whatever the fishing effort variable has in memory. 

If you as an example colour the whole spreadsheet with one colour, the policy search will find the 
one (relative) fishing effort across all fleets that optimizes the objective function 
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A colour in the block spreadsheet means:  “find me a fishing effort for this fleet/year combination”.  All 
blocks with a given colour will get the same relative fishing effort. 

No of blocks: Use this to get more colours = blocks 

Selected: With many colours (blocks) it can be difficult to see which one is selected. It can be 
easier to change the number of Selected to selectively set blocks. The horizontal slider under the 
colours indicate which one is selected. 

If the optimizations starts at a point where the system is degraded/overfished, it can make sense 
to have an initial rebuilding period followed by sustainable use. This can be set with by setting two 
colours blocks per fleet, one for the rebuilding period and one for the sustainable use period. 

Set block year and sequence 

This, somewhat complex part of the interface, can be used to set blocks of years. The default is 
that there is one block per fleet spanning from year 2 to the end, the optimization thus starting in 
Year 2 and ending in the last year of simulation. 

Year: Gives number of years per block. The default is number of years in simulation. Changing this, 
for instance to 10 years,  will signal that there should be one block for each 10 years simulated for 
each fleet 

Set: Clicking will set the number of blocks by fleet based on the Year setting. 

Start: Increasing the start year will result in the years prior be blocked (indicated in black) and not 
included in simulations 

End: Decreasing the end year will cause the following years to be blocked and not included in 
simulations. 

Objectives, iteration results and plot results 

The lower panel has three tabs, each explained next. 
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Objectives 

This tab will be displayed while setting up the policy scenario.  The objectives are described above, 
this section deals with how they are implemented.  The objectives are described in the Fishing 
policy exploration chapter of the EwE textbook. 

Search objective, relative weight: List the five objectives (or three if the Maximize portfolio utility 
option has been checked) with relative weights. Be aware that putting the same weight on two 
or more objectives does not translate into these objectives actually being balanced (see the Policy 
exploration procedure tutorial in the EwE textbook. This is because changing for instance how 
much Ecosystem structure may change will be much harder than changing Net economic value. 
 To get an overview of the range for each objective it may be advisable to conduct a series of 
optimizations placing weight on one objective at the time. 

If the Maximize portfolio utility option is checked, there will be three objectives listed: Net 
economic value, Prediction variance and Existence value.  The details of these are explained in the 
Risk-averse portfolio utility chapter in the EwE textbook. 

Jobs/catch value: This parameter implements the Social value (employment) objective, and can be 
obtained from economic analysis, e.g., through value chain analysis. If such data are not available, 
consider the assumption that the number of jobs is proportional to the value of the catch. The 
default parameter (1) is based on this assumption. 

A tweak: If instead of entering landed value in your Ecopath model, you enter the trophic level of 
each group in the Ecopath > Input > Fishery > Off-vessel price form, the optimization can be for 
Trophic level of the catch instead of for Social value. 

Mandated relative biomass:  The default parameter for this parameter is 0 for all groups, which 
means that by default, the Mandated rebuilding will not be considered in the optimization even if 
there’s a wight entered in the Search objective spreadsheet.  If you want to invoke the objective, 
change the Mandated relative biomass for groups where you want to invoke the Mandated 
rebuilding objective to a minimum acceptable biomass (often called Blim) and give considerable 
weight to the Mandated rebuilding objective to make sure that this objective is considered fully. 

Structure relative weight: This objective is used to implement the Ecosystem structure objective, 
and is by default parameterized with the inverse production/biomass (unit: year) for group with 
a P/B (year-1) lower than ~5 year-1.  The objective thus implements one of the ecosystem maturity 
parameters. 

The default values can be replaced, e.g., by other network analysis indicators. An example could 
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be the trophic level of the group, or it could be indicators such as the number of species in a 
functional group to bring in more biodiversity aspects. 

Maximum fishing mortality: This parameter is not linked to any of the objectives, but if a Max F 
is entered on this spreadsheet, the search routine will penalize runs where the Max F is exceeded. 
This parameter can thus be used to reduce the risk of collapse of fished groups. 

The default value is set so high (1000 year=1)  that it does not have any impact. 
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CEFAS Management Strategy Evaluation 
(CEFAS-MSE) 
STEVEN MACKINSON; MARK PLATTS; CLEMENT GARCIA; AND CHRISTOPHER LYNAM 

Overview 

Management strategy evaluation (MSE) has become a major tool for evaluating and comparing 
management options, mainly for single-species management.  The basic concept in MSE is to 
set up a basic “operating model” or set of models, then simulate the year-to-year management 
of model species by first representing estimation of abundances (stock assessments) each year, 
then application of harvest control rules (HCRs) to set fishing policies within that year.  HCRs 
are basically feedback rules for varying target fishing mortality rates or allowable catches with 
changes in target species abundance, typically by specifying population sizes below which 
harvesting should not be allowed and above which harvesting should be at rates that come 
close to maximizing average long term yield.  Alternative HCRs are typically compared over 
simulations using a variety of performance measures representing fishery values and risk of having 
dangerously low population sizes due to effects of environmental variation and overestimation of 
abundance by stock assessments. 

EwE has two modules for doing MSE simulations, one developed by Mackinson et al. at CEFAS1, 
and another programmed earlier for EwE6.  The CEFAS version aims to represent “output control” 
of harvesting via quotas or total allowable catches/bycatches, while the older EwE model uses 
an optimization method called linear programming to find optimum fishing efforts within each 
simulation year. 

This chapter provides a general overview of the MSE structure and components (Figure 1), and 
details shared by both of the MSE modules.  The following chapter provides a bit more detail about 
the linear programming procedure used to optimize fishing efforts within each year. 
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Figure 1. Flow chart showing an overview of the two main stages of management strategy 
evaluation setup. 

The Ecopath with Ecosim (EwE) CEFAS plug-in has two main stages of execution (Figure 1). 
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• Stage 1: Create possible EwE Models – uses user-specified probability distributions to sample 
the input parameters of which an EwE model is comprised, and saves them to disk. 

• Stage 2: Evaluate Management Strategies (Figure 2) gets input from the user about Harvest 
Control Rules, Discards Policies, Quota shares for each fleet, Number of Years to Project, 
Observation and Implementation Errors, Maximum fractional increase in effort and Biomass 
limits. Applying these settings, Ecosim is then run for all selected combinations of strategies 
and models created in stage 1, and providing the results are plausible, they are saved to disk. 

Figure 2. Flowchart for the evaluation of management strategies. 
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Creating alternative ecosystem models 

The process of creating alternative Ecopath models involves sampling the basic input parameters 
for biomass, biomass accumulation, ecotrophic efficiency (EE), production/biomass (P/B) and 
consumption/ biomass (Q/B) parameters using a truncated normal distribution. In addition, 
the diet proportions for each predator are sampled using a Dirichlet distribution. Together the 
sampled Ecopath and diet proportions are checked to see that they meet the criteria for EE<1, 
positive respiration and P/Q<0.5. The sampling process is repeated until a valid model is 
determined. 

For each of the Ecopath models created, a set of Ecosim parameters comprising of density 
dependent catchability, feeding time adjustment rate, max relative feeding time, fraction of other 
mortality sensitive to changes in feeding time, predator effect on feeding time, QBMax/QBo and 
switching power are generated by sampling either a uniform or triangular distribution. Discard 
survival proportions, or more explicitly, the proportions of discards that survive are sampled for 
each fleet species combination using a beta distribution. The vulnerability parameters are sampled 
for all possible interactions, using the formula (Gaichas et al. 2012): 

Where vrk is the vulnerability, r is the predator, k is the prey, and U is a value sampled from a 
standard uniform distribution. 

A single set of all the Ecopath and associated Ecosim parameters are combined to form a single 
EwE model. Multiple sets combined form an approximate representation of the probability 
distribution for all possible EwE parameterisations. By running strategies (see next section) across 
all these models, strategies are tested for robustness to parameter uncertainty. 

Evaluating the management strategies 

Strategies are evaluated by running each one across the entire range of possible ecosystem 
models to produce a single outcome for each strategy-model pair. If a model produces a biomass 
trajectory beyond a plausible range for any strategy the model is excluded from the analysis. 

The management loop, core to the evaluation, becomes active as soon as the model projects into 
the future, the methodological steps of which are described below. 
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Estimate a biomass from scientific surveys – the simulated ‘Survey 
Biomass’ 

At the beginning of the year the average biomass predicted by the model over the previous 12 
months is calculated. Observation error sampled from a log-normal distribution parametrised 
using a user specified coefficient of variation is then added to it, giving an estimate of biomass 
at the beginning of the year. This is the simulated ‘Survey Biomass’ which is used by the stock 
assessment (see next section). 

Performing stock assessment 

The results of complex assessments (which are not practical to simulate for multiple functional 
groups in the Ecosim MSE framework) are simulated by approximating the results of stock 
assessments as a weighted average of the predicted biomass and biomass estimated from surveys 
(Walters 2004, equations 1-6): 

Where Bt|t is the best (minimum variance) estimate of Bt given all of the data up to time t, Bt|t-1 

is the best prediction of the biomass at time t given only the data up to time t-1, Kt
* is the 

Kalman gain and Bt* is the simulated “Survey” biomass at time t. The prediction (Bt|t-1) comes 
from Schnute’s generalization of the original Deriso model (Schnute, J. 1985), with a simplified 
representation of biomass dynamics: 

Where g is the growth rate, EcopathBA is Ecopath biomass accumulation, EcopathB is the Ecopath 
Biomass, RecruitOverPop is the percentage of total population that will recruit, and wRt is the 
biomass recruited estimated using the Beverton-Holt Stock Recruit model: 
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Where RatioBt is the Ratio of biomass at time to Ecopath base biomass for 50% of recruitment, 
and RecruitCV is the coefficient of variation of the actual recruits around the predicted recruits 
from the stock recruit model. 

The Kalman gain is the proportion that the predicted biomass variance (Var(Bt|t-1) is of the total 
predicted and observed biomass variances: 

Determine the Quota using the HCR 

A quota is determined for each functional group that has a HCR using: 

F_i = \begin{cases} 0, &amp; \text{if $B_{i,t|t} &lt; B_i^{min}$}  \\ \frac{B_{i,t|t}-
B_i^{min}}{B_i^{max}-B_i^{min}}\cdot F_i^{max}, &amp;\text{if $B_i^{min} &lt; B_{i,t|t} &lt; 
B_i^{max}$} \\ F_i^{max}, &amp;\text{if $B_i^{max} &lt; B_{i,t|t}$} \end{cases}\tag{11} 

Where Fi is the instantaneous landings mortality rate, Bi,t|t is the stock assessment estimate of the 
biomass for species i, Bi

min is the biomass at which the F from the HCR declines to zero and Bi
max 

is the biomass at which the HCR F arrives at Fi
max, the maximum F, which is in many cases is MSY 

F. 

This F_i is then converted into quotas for each fleet-species combination using: 

Where qi,j is the share of the quota of species i assigned to fleet j. 

HCRs can be specified as either Target HCRs or Conservation HCRs: 

• Target HCRs – normal HCRs, used as above to determine an F given the biomass of a 
functional group. 

• Conservation HCRs – calculates an upper limit for the Target HCR F, so that if it is above 
Conservation HCR F the Conservation HCR F will be used instead. 

Both Target and Conservation HCRs can be specified as a traditional HCR (Figure 3) or as a Multi-
level HCRs (Figure 4) which allow a greater degree of flexibility in the HCR shape by enabling the 
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specification of a minimum fishing mortality as well as a biomass level known in the plugin as the 
“Biomass step” at which the F steps down to the minimum fishing mortality. 

Figure 3. Screenshot of a traditional HCR plotted by the MSE Plugin 

Figure 4. Screenshot of a Multi-level HCR plotted by the MSE Plugin. 
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Determine maximum effort for the year 

The increase in effort is limited between years to represent realistic limits in the rate of growth of 
fishing capacity. As a consequence the maximum effort for a given year is calculated as follows: 

Where ljmax is the maximum effort for fleet j, ljprev is the effort at last time step of the previous 
year, and κj is the maximum percentage increase in the effort between years. 

Determine relative effort and discard rates according to regulations 

Regulations are settings that can be applied uniquely to each fleet and specify whether the fleet 
is subject to a discard ban or not. They are also a way of specifying how the fleet might behave in 
response to a discard ban, that is, whether or not they are able to avoid species to prevent them 
becoming choke species. 

Accurately modelling fleet behaviour is extremely difficult. To overcome this problem two 
regulation methods were specified, the ‘Weakest stock’ and ‘Selective Fishing’, both of which 
represent different degrees of implementation of (or fleet response to) a no discard policy. The 
‘Weakest stock’ represents the possibility that fleets are incapable of being selective of its catch 
composition while ‘Selective Fishing’ represents the possibility that fleets are 100% capable of 
selecting their catch composition. While both scenarios are unlikely to be true, it is a fair 
assumption that the reality is somewhere between these two possibilities. Consequently the 
results from these two regulations should be considered together as a range of what is possible 
given a no discard policy. 

‘Weakest stock’ (=Strict no discarding) 

The weakest stock regulation represents a no-discards policy. The effort required to catch 1/
12th of the quota of each species is calculated each month (each time step) and then set equal to 
the minimum effort value calculated (the effort required to catch the ‘weakest stock’), to ensure 
that none of the quotas will be exceeded throughout a year. The weakest stock is calculated each 
month and in some cases may change over the course of a year. This is due to fluctuations in the 
biomass of each species, causing the effort required to catch its quota to vary; as the biomass of 
a species increases or decreases, catching it becomes easier or harder respectively and therefore 
the effort required decreases or increases respectively. 
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The fleet has no ability to alter its catch composition (i.e. unselective), meaning that the species 
that requires the least effort to fulfil its quota becomes the bottleneck or ‘choke species’ and 
determines the amount of effort deployed. Note that species that are defined as non-target 
species without a quota are exempt from being a ‘choke species’ and can be discarded. Presently, 
discards are allowed for fish below minimum size if they have been specified in the basic Ecopath 
model. 

Step-by-step explanation 
For each fleet that has a quota for at least one functional group, at each time step: 

1. Cycle through each functional group for which the fleet has a quota and calculate the effort 
required to catch the 1/12th of the functional group’s yearly quota using: 

Where Ej
T is target effort, qi,j is the quota share, qi

T is 1/12th of the yearly target quota, Mi is 
the density dependent catchability multiplier at current timestep, Fi,j is the fishing mortality, 
Bi is the biomass. 

2. Repeat step 1 with any conservation HCR Fs using: 

Where Ej
C is the conservation effort, qi

C is the conservation quota. 
3. If the target effort is less than the conservation effort use the target effort, otherwise use the 

conservation effort. 
4. From all the efforts calculated for a fleet, apply the lowest to the current time-step. By 

applying the lowest we ensure that the main objective of this regulation is achieved, to never 
catch beyond the quota of any functional group. 
If the effort is outside the upper effort limit reset the effort to the upper limit (see section 
Determine relative effort limits for the year) 

5. Set the proportions landed and discarded to the proportion in the EwE model 
6. Set the proportion surviving being discarded to the survivability value sampled for the 

current model 

‘Highest value’ (=Continued discarding) 

The highest value regulation is a discard permitting policy that assumes that the fleet will catch 
the entirety of the highest valued quota. The highest value quota in the fleets’ portfolio is 
calculated at the beginning of each year based on quota and price. The effort required to catch 1/
12 of the highest values quota is calculated each month. Any fish caught beyond quota for other 
stocks are discarded. 
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Step-by-step explanation 
For each fleet that has a quota for at least one functional group: 

1. At the beginning of each year determine which functional group has the highest value quota 
(where value = price x quota) 

2. For each timestep 

1. Calculate the effort that would land the quota 

Where Ei,j
T is the effort to catch the target quota, mi,j

l is the proportion of the catch that 
is landed, and i is the index of the highest value group. 

2. Calculate the effort required to catch the conservation quota for this highest value 
group if a conservation quota exists: 

3. Let 

1. If the effort is outside the upper and lower limits reset the effort to the breached 
limit 

2. For each functional group for which the fleet has a quota: 

1. Estimate the catch if the fleet was to fish at the current level for 12 months 

2. if the catch is greater than the smallest quota from either the conservation and 
target HCR/prop landed as set in EwE then 

1. Set the proportion landed to quota/catch 
2. Set the proportion surviving being discarded to the value sampled for the 

current model 
3. If the catch is not greater than the smallest quota 

1. Set the proportion landed to the proportion in the EwE model 

Note that there are some inaccuracies in the proportions of the catch discarded. These 
inaccuracies are rooted in the problem of combining discard proportions specified in the EwE 
model and the discard proportions calculated by the plug-in. The EwE discard rate represents 
discards for a variety of reasons including catches beyond quota. The MSE Plugin discard rate 
is calculated dynamically and represents only catches beyond quota. Summing the two would 
result in a double accounting of discards due to catches beyond quota. Because there is no way 
of knowing what proportion of the EwE discard rate relates to catches beyond quota, we have no 
way of knowing what to subtract from the summation of both rates to prevent this. 
Because of this a pragmatic decision was made to use only the EwE discard rate for any years 
where the total catch is below quota, and use the MSE dynamic discard rate for any years where 
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the total catch is above quota. This has the slight effect of overestimating discards when catches 
are below quota and underestimating discards when catches are above quota. In further work, we 
hope to address this issue. 

 ‘Selective Fishing’ (=Avoiding discarding) 

The selective fishing is a discard prohibiting policy, which mimics the fleet being able to avoid 
catching species beyond their allocated quota, by whatever means. Fleets target the highest value 
quota (as above) and can continue fishing until this species’ quota is exhausted. The ability to be 
selective only applies to species that have an HCR. Therefore if avoiding the catch of a species that 
does not typically get assigned a quota is desired, then a HCR with a zero F must be applied to that 
species. 

Step-by-step explanation 

For each fleet that has a quota for at least one functional group: 

1. Determine which functional group has the highest value quota 
2. Calculate the effort that would land the highest value quota 

3. Calculate the effort required to catch the conservation quota for this highest value group if a 
conservation quota exists: 

4. If conservation quota exists: 

5. If the effort is outside the upper and lower limits reset the effort to the breached limit 
6. For each functional group for which the fleet has a quota: 

1. Estimate the catch if the fleet was to fish at the current level for 12 months 

2. If the catch is greater than the smallest quota from either the conservation or target 
HCR/prop landed as set in EwE then 

1. Set the proportion landed to quota/catch 
2. Set the proportion of the catch that is discarded and dies to: 

Where mi,j(d) is the proportion of the catch that dies, Ci,j
L is the catch required to 

land the quota, Ci,j
S is the catch that would have been caught if the fleet had not 

altered its mortality rate by being selective. 
Note: The equation for the ProportionCatchDying has the effect of making the 
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difference between the actual catch and CatchifNotSelective to all be discarded and 
survive, essentially as if it had never been caught. This is not an intuitive approach, 
but accurately represents the fleet avoiding catching a species once it has landed its 
entire quota. 

3. If the catch is not greater than the smallest quota from either the conservation and 
target HCR/prop landed as set in EwE then 

1. Set the proportion landed to the proportion in the EwE model 
2. Set the proportion surviving being discarded to the survival proportion sampled for 

the given model. 

Note that in all these cases the quota is the quota as calculated at the beginning of each year; it 
is not the remaining quota after catches and therefore does not decrease throughout the year. 
Consequently the relative effort calculated using this quota is the effort that will, based on the 
biomass and density dependent catchability at the current time-step, catch a proportion of 1/12 
(since each time step represents a month) of the quota. Applying these calculated efforts at each 
time-step throughout the year will catch the entire quota except for when the effort is unable to 
adequately change due to the maximum change in the effort. 

‘NONE’ 

Fleets regulated by ‘None’ have their effort maintained at a constant level equal to that at the end 
of the hindcast. Proportions surviving discarding are as sampled (see section Creating alternative 
ecosystem models). 

‘No Fishing’ 

Fleets with this regulation setting do not fish throughout the entire projection period. This is 
achieved by setting the efforts for these fleets to zero. 

Add implementation error 

Typically the historic difference between catch and quota is used to set implementation error as 
a proxy. Since fleet behaviour, the regulation settings, conservation quota’s and limits to changes 
in effort already represent many of the mechanisms that create implementation error, a value of 
zero was used. 
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Each regulation method produces implementation error for different reasons because fleets 
respond differently to them. In the case of the “highest value regulation” catches can be less than 
quota because applying effort to catch the highest value species does not fully utilise another 
species quota. In other cases though, it can lead to catches exceeding quota because catching 
the highest value quota results in catching more than the quota of another species. The “weakest 
stock regulation” tends to lead to underfishing in most cases, because fleets are only able to 
catch the entire quota of a single species. Similarly, the “selective regulation” also tends to lead to 
underfishing, because fleets are restricted from landing beyond quota. However, when regulated 
by either the “weakest stock regulation” or the “selective regulation” for some species there can be 
slight overfishing. This happens because a small amount of discarding is allowed to occur, meaning 
fleets need to catch slightly beyond quota to land up to quota (Platts & Mackinson section 5.3). 

Note that there are some slight inconsistencies in the way that proportions of the catch discarded 
are calculated for each regulation method. These inconsistencies are rooted in the discard 
proportions specified in the EwE model, the discard proportions calculated by the plug-in and the 
problem of combining them. There are various reasons that a fleet discards: no remaining quota, 
undersized catch and high-grading being the most significant causes. The values in the EwE model 
specify as a fixed value the proportion discarded for all these reasons. The plug-in builds on this 
by calculating the discards dynamically, however this calculation is only of the discards due to 
no remaining quota. The inconsistencies arise because of the difficultly of combining these two 
discard proportions in an attempt to account for all elements of discarding while trying to avoid 
double accounting (Platts & Mackinson section 5.3). 

Handling applied forcing F time series 

When forcing F time series are applied in the hindcast of an ecosim model it ends abruptly 
at the beginning of the forecast, which creates a technical problem for matching a smoothly 
transition in F. The problem is that the forcing F values cannot be created by multiplying the 
baseline catchabilities by any combination of fleet efforts. The reason for this is that the forcing Fs 
commonly reflect changes in the catchabilities and therefore the baseline catchabilities multiplied 
with the efforts no longer align with them. To solve this problem up-to-date catchabilities must 
be estimated, but to do this we must make an assumption about how the forced F is partitioned 
into fleet Fs. The assumption made is that: 

F_{i,j}^*=\frac{F_{i,j}} {\sum_j F_{i,j}}  F_i^T\tag{24} 

Where Fi,j
* is the partial F which is used to determine an up-to-date estimate of catchability, Fi,j is 

what the F would have been on group i by fleet j if the effort at the last time step of the hindcast 
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was applied with the baseline catchability and Fi
T is the F at the forcing F at the last time step of 

the hindcast. 

Since landings and discards can now be calculated on a per fleet basis, updated catchabilities can 
be calculated using: 

Where qi,j is the catchability, Li,j and Di,j are the landings and discards respectively of the last time 
step of the hindcast, Bi is the biomass at the last time step of the hindcast and Ej is the effort at the 
last time step of the hindcast. 

Screening the Results 

Before the results of a model are saved to file, a test is performed to check whether the results are 
plausible. To do this, the biomass trajectories are checked to be within upper and lower biomass 
bounds. Any model that contains a functional group with a biomass outside these bounds for any 
strategy has its results discarded. 

Attribution This chapter is based on the supplementary materials for Mackinson S, Platts M, Garcia C, 
Lynam C. (2018). Evaluating the fishery and ecological consequences of the proposed North Sea multi-
annual plan. PLoS ONE13(1): e0190015. https:// doi.org/10.1371/journal.pone.0190015. Rather than citing this 
chapter, please cite the source. 

Notes 

1. Mackinson S,Platts M,Garcia C,Lynam C(2018) Evaluating thefishery andecological 
consequencesoftheproposed North Seamultiannual plan. PLoS ONE13(1): e0190015. https:// doi.org/
10.1371/journal.pone.0190015 
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MSE LP Constrained Optimization of 
Fishing Effort 
CARL J. WALTERS 

Optimization methods like Ecosim’s policy optimization search procedure have been used to 
find by-fleet fishing efforts that maximize various multi criteria benefit functions for ecosystem 
management, with criteria ranging from total profits to total employment and maintenance of 
ecosystem structure.   These optimization methods work by running an ecosystem model that 
includes fishing mortality rates for multiple biomass groups by the multiple fleets, for long enough 
simulation periods for production and trophic interaction effects to play out.  Fishing efforts by 
fleet are varied across simulation runs so as to seek the effort combination that maximizes the 
long term benefit function.  The result is a vector EOPTj,  j=1,…,nf, of optimum long term efforts 
for the nf fleets included in the model. 

Unfortunately, these optimum long term efforts typically cannot be used directly in management 
strategy evaluations, since they ignore constraints associated with fishery development (how fast 
efforts can grow or be reduced) and more importantly typically involve fishing efforts that would 
cause ecosystem simplification (overfishing of weaker stocks, even use of fleets to cull some 
species so as to increase productivity of others).  In at least some jurisdictions like the United 
States, there is a strict legal mandate not to allow overharvesting (fishing rate exceeding Fmsy) for 
any species.  Further, in modeling management decision making over time, it is often necessary 
to represent the use of ‘control rules’ that prescribe reduced fishing mortality rates for particular 
stocks when those stocks are below desired reference biomass levels. 

A relatively simple linear programming method could theoretically be used to find long-term 
efforts that are constrained to be at or below the long term optima EOPTj, while respecting the 
relative fishery values represented in the long term optimization and also constraints associated 
with fishing mortality rate targets or upper limits by species.  But more importantly, the same 
optimization procedure can also be used to set annual effort limits in MSE simulations, as an 
option to use effort input controls rather than the output (quota) controls assumed in the CEFAS 
MSE module.  This chapter explains the basic linear programming formulation. 

Suppose that the fleets harvest i=1,…,ns species (or biomass groups), with each unit of effort for 
fleet j causing a fishing mortality rate qij on species i (qij is the catchability coefficient for species 
i by fleet j, and is also the Ecopath base fishing mortality rate for i,j).  Suppose that for each 
species i, there is a target or maximum allowable fishing mortality rate FTARGETi, summed over 
all fleets that cause fishing mortality (landings and/or discards) on i.  Suppose that we assign 
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an ‘importance weight’ vj to effort by fleet j, where vj reflects the relative value of increasing (or 
maintaining) effort for fleet j because of its contribution to overall long term ecosystem value 
and/or its legal entitlement to fish.  Then the linear programming optimization can be formulated 
simply, as, maximize, 

by varying the Ej subject to the constraints, 

EMIN_j &lt; E_j &lt; EOPTj \qquad for \;  j=1,...,nf\tag{2}\label{2} 

\sum \limits _{ j=1}^{nf} q_{ij}E_j \leq FTARGET_i   \qquad for \;  j=1,...,nf  \tag{3}\label{3} 

That is, try to make the efforts Ej as large as possible without exceeding EOPTj, while allowing 
efforts of at least EMINj and not allowing the sums of qijEj to exceed target fishing rate for any 
species i.  An alternative formulation for recognizing fishery development rate constraints would 
be to replace the first set of nf constraints (2) with, 

Where the EMIN and EMAX are allowed to vary from year to year by limited increments from the 
previous year’s values, and are not allowed to exceed EOPT. 

Figure 1 illustrates the kind of complicated solutions that can arise from this optimization, even for 
a very simple case where two fishing fleets pursue just two species, with one fleet having higher 
catchability for one of the species and the other fleet having higher catchability for the other 
species. 
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Figure 1 – Graphical representation of the linear programming problem.  Each line represents 
a constraint (vertical and horizontal lines are the EOPT constraints, sloped lines are the 
FTARGET constraints. 

The lines in Figure 1 represent effort levels that exactly meet the constraints; efforts must be to 
the left and below each line in order to be feasible.  Thus the feasible effort combinations are only 
those in the polygon from the graph origin out to the first constraint lines met.  Since efforts are 
to be as large as possible, the solution has to lie along one of those first lines met, and in fact has 
to be on one of the three vertices marked A, B, C. 

• Effort combination A represents Fleet 1 being severely restricted, but Fleet 2 operating at its 
EOPT. 

• Effort combination C represents Fleet 2 being severely restricted but Fleet 1 operating at its 
EOPT, and 

• Effort combination B represents a ‘balanced’ policy choice where both fleets are restricted to 
below EOPT in order to ‘share the burden’ of avoiding exceeding either of the two FTARGET 
species constraints. 

Which of these three combinations will be chosen (solve the linear programming maximization) 
depends on the value weights vj in (1).  If v1 is much higher than v2, combination C will be chosen, 
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combination A will be chosen if v2 is larger, and setting the two v’s equal will more likely lead to 
the balanced combination B.  Note also in Figure 1 that as the FTARGET constraints are ‘relaxed’ 
(increased so the sloped lines move upward and to the right), it becomes more likely that the 
optimum effort combination will lie near EOPT for both fleets; likewise, as these constraints are 
‘tightened’ (reduced so the sloped lines move down and to the left), it becomes more likely that the 
EOPTs will not be in the feasible region so that the optimum solution will lie either with a mixed 
effort combination or with one or another of the fleets shut down entirely. 

Using the linear programming formulation, it is simple to evaluate the cost, in terms of lost 
total value, of introducing more restrictive constraints on species harvest rates.  In the overall 
management strategy evaluation setup for Ecosim, the only other way to evaluate this cost is to 
do policy runs with and without ‘weakest stock’ constraints on fleet quotas, where all fleets are 
assumed to share equally in reductions needed to meet such constraints.  The linear programming 
solution may well demonstrate that such equal sharing of the conservation burden is in fact far 
from optimum. 

The linear programming formulation can also be used to demonstrate potential increases in 
fishery value from selective fishing practices that change the species-specific catchabilities qij. 
For example, if q12 and q21  (catchability of species 1 by fleet 2 and of species 2 by fleet 1) could 
be greatly reduced in the Figure 1 example, the slopes of the two FTARGET constraint lines would 
decrease/increase so as to move the solution toward higher total efforts (move point B up and to 
the right, closer to the EOPT1-EOPT2 intersection) and thus higher total value. 

The key to getting useful results from the linear programming exercise is to make wise choice of 
the fleet value weights vj.  One objective option for doing this each year (assuming a management 
strategy where biomass and perhaps catchability qij estimates are being updated regularly) is to 
set each weight to be 

where Pij is the landed price for species i by fleet j and Bi is the current estimated biomass of 
species i.  Using this formula, vj is just the sum over species of predicted catches per effort times 
prices, so that vjBj represents the (short term) predicted total value of landings by fleet j and the 
overall linear programming objective function just becomes the predicted total landed value of all 
catches. 

An option in the management strategy evaluation interface allows users to replace the 
complicated CEFAS rules for setting quotas for each simulation year to limit mortality rates to 
acceptable levels, to instead use annual LP optimization each year during each MSE simulation 
run so as to limit fishing efforts rather than quotas.  The basic idea is to replace the single EOPTj 
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values in the equations above with time-varying values calculated for each year and group, and to 
use an annual value for the FTARGETi target fishing rate for each group i  for that year, calculated 
from the estimated biomass of the group and the group’s harvest control rule that specifies how 
target fishing rate for the group should vary with stock size. This option can lead to complex policy 
changes over time when the FTARGETi decrease with decreases in biomasses Bi. 
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Other mortality forcing 

A forcing multiplier has been added to the other mortality term of the Ecosim biomass loss 
equation. This allows the Ecopath baseline other mortality rate to vary over time. This new 
functionality allows you to simulate a die-off event by changing the baseline other mortality rate. 

The biomass loss is now calculated for group i at time stop t as, 

Further, M0multi = The new other mortality forcing multiplier for this group at this time step; 

Eatenofi = total biomass lost to predation on this group. This is the result of foraging arena biomass 
flows, all summed up into one number. This is the actual biomass not a rate; 

M0i = (1-EE) * PBi (Other mortality rate in the Ecopath Mortalities rates grid); 

M0Predi =  Fraction of other mortality sensitive to changes in feeding time  Ecosim > Group info; 

Ftimeit = Feeding time predation risk modifier. Usually around 1.0 but gets set at each timestep 
based on the Ecosim parameters Minimum foraging time, Group info Feeding time adjustment rate 
and Group info Predator effect on feeding time. If these are all left at their default values then this 
will be basically 1.0; 

Emigi = Emigration rate from Ecopath > Other Production > Emig. Rate (year-1); 

FishTimei = F, fishing mortality rate (year-1), again all summed into one rate for this group; 

Biomassit = biomass of this group at this time step. 
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Discussion 

Figure 1 – Forcing function user interface with an Other Mortality forcing spike defined. 

Other Mortality forcing has been implemented as a straight multiplier on M0 by group in Ecosim, 
rather than an Environmental Response Function that is applied to MOi instead of the feeding 
rates. This means they fall under the Forcing function user interface in Ecosim rather than the 
Functional response form. The creation of an other mortality forcing function, from a time series of 
environmental data, will have to be done outside of EwE. To do this step, one will need to figure out 
how large of an other mortality multiplier it will take to achieve the desired mortality in response 
to the environmental driver.  This will vary a lot depending on the base other mortality rate, which 
is displayed in the user interface under Ecopath > Output > Mortality rates > Mortalities > + Other 
mortality rate (year-1) and the growth rate of the group. If either the growth rate is high, or the 
other mortality is low, the multiplier will need to be large to simulate a large die-off event. 

Currently there’s no functionality in Ecosim to help you choose a suitable other mortality 
multiplier for a specific event. To do this you will need to calculate the appropriate size multiplier 
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from the Ecopath baseline growth and mortality rates. 
For an Other Mortality forcing value to be considered as valid it will need to be non-zero. Zero 
values will be skipped, and no multiplier will be applied. Values are applied as a straight multiplier, 
this means values less than one will decrease the Other Mortality rate. This allows you to include 
a short term spike in Other Mortality without affecting the majority of the run. 

The application of Other mortality forcing functions has its own Apply FF (other mortality) user 
interface grid. 

Figure 2 – Application of an Other mortality forcing function. 
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Figure 3 – Ecosim run with a one-month spike Other mortality forcing 

The Figure 3 legend points out that one can see the drop in one group and the increase in another 
– one can, but it is really difficult to see who’s who. You can get around that by using random 
colours for groups instead of the default colour scale. This is done where you define the groups at 
Ecopath > Input > Basic Input > Define groups. 
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Environmental Productivity 

Primary Production 

For primary producers the production is estimated as a function of the producers’ biomass, Bi, 
from a simple saturating relationship 

where, ri is the maximum production/biomass ratio that can be realized (for low Bi’s), and ri/hi 

is the maximum net primary production when the biomass is not limiting to production (high 
Bi’s). For parameterization it is only necessary to provide an estimate of ri/(P/B)i, i.e., a factor 
expressing how much primary production can be increased compared to the base model state. If 
a forcing function is applied to primary production, it multiplies the r parameter in (1). 

Nutrient Cycling and Nutrient Limitation in Ecosim 

Ecosim uses a very simple strategy to represent nutrient cycling and potential nutrient limitation 
of primary production rates.  It is assumed that at any instant in time the system has a total 
nutrient concentration NT, which is partitioned between nutrient ‘bound’ in biomass versus free 
in the environment (accessible to plants for nutrient uptake).  That is, T is represented as the sum 

ŋ

,where ŋi is (fixed) nutrient content per unit of group i biomass, and Nf is free nutrient 
concentration.  Then assuming that NT varies as dNT/dt = I – vNT, where I is total inflow rate to 
the system from all nutrient loading sources and v is total loss rate from the system due to all loss 
agents (volume exchange, sedimentation, export in harvests, etc.), and that v is relatively large, NT 
is approximated in Ecosim by the (possibly moving) equilibrium value NT = I/v. 

Changes in nutrient loading can be simulated by assigning a time forcing function number to NTon 
the Ecosim > Input > Ecosim parameters form, in which case NT is calculated as NT = ft NTowhere 
NTo is the Ecopath base estimate of NT (at the start of each simulation) and ft is a time multiplier 
(ft  = 1 implies Ecopath base value of >NT) supplied by the user the same as any other time forcing 
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function.  Note that under the moving equilibrium assumption, changes in ft can be viewed as 
caused by either changes in input rate I or nutrient loss rate v. 

The Ecopath base estimate NTo of total nutrient is entered by specifying the base free nutrient 
proportion Ρf = Nf / NTo on entry to Ecosim (at Ecosim >Input > Ecosim parameters), from which 
the Ecosim initialization can calculate NTo as simply, 

ŋ

Note here that the units of nutrient concentration are contained in the per-biomass relative 
nutrient concentrations ŋi, and these need not be specified in any particular absolute units. 
During each simulation, Nf is varied dynamically by setting it equal at any time to 

ŋ

so that accumulation of nutrient in any biomass pool(s) can reduce free nutrient available to 
promote primary production. 

Primary production rates for producer pools j are linked to free nutrient concentration during 
each simulation through assumed Michaelis-Menten uptake relationships of the form 

where the parameters P/Bmax,j and Kj are calculated as part of the Ecosim initialization using input 
estimates by the user of the ratios P/Bmax,j / P/BEcopath,j (Ecosim > Input > Group info form). 
The Michaelis constant Kj is set so that P/Bj =P/BEcopath,j when Nf is at the initial concentration 
determined by 

ŋ

when all Bi are at Ecopath base values. One can increase sensitivity to changes in nutrient 
concentration (make P/Bj more variable with changes in NT and Nf) by increasing the input (P/
B)max,j) / (P/B)Ecopath,j ratio. 

The default free nutrient proportion pf is set at unity, which causes Nf to be virtually constant 
over time (and hence P/Bj’s to be virtually independent of nutrient concentration changes).  Thus 
to “turn on” nutrient limitation effects, you must set a lower value for ρf, (e.g., 0.3) on the Ecosim 
parameters form. 

Be aware that this simple approach to accounting for nutrient limitation can interact with the 
numerical method used to simulate very fast phytoplankton dynamics over time, to cause 
numerical instability or “chattering” in the values of phytoplankton biomass.  This happens mainly 
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in cases where ρf is low, so that Nf is initially small.  Then any biomass decline in the system (e.g., 
due to decline in zooplankton biomass) results in a relatively large increase in Nf, which can cause 
an over-response in the calculated phytoplankton biomass(es) Bj, which then drives Nf to near 
zero, which in turn causes too large a decrease in calculated Bj for the next monthly Ecosim time 
step. 

Chattering can be reduced by using the Runge-Kutta integration option and/or higher pf settings. 
Improved numerical integration procedures should allow us to avoid the problem entirely in future 
Ecosim versions, but at present the computational cost of avoiding the problem by ‘brute force’ 
(shorter simulation time steps) would be prohibitively expensive of computer time. 

Note further that the single free nutrient concentration Nf is linked to all primary producer groups 
in the model (through the uptake kinetics-P/B relationships), implying competition among all 
plant types in the model for free nutrients.  This can cause major shifts in primary production 
structure over time, e.g., between benthic and pelagic primary production and between grazeable 
and non-grazeable algal types. 
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Results Extractor 

Introduction 

The Results Extractor was developed in response to the need users have, to easily retrieve data 
and  parameter values from within EwE6. This chapter will explain how to use the Results Extractor 
to  do this. 

In most cases the language used for titles of options is explained in this EwE User Guide. Only 
where the language and functionality is new will an explanation be given here. 

Starting the Results Extractor 

The Results Extractor can only be started after Ecosim has been run. After Ecosim has been run, 
it can be started by selecting Menu > Tools > Results Extractor. After the Results Extractor has been 
started, you will be presented with a window of checkboxes. 
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Figure 1 – Results Extractor start-up interface for settings. 

Simply check all boxes for the data and parameter values that you would like to retrieve from 
within EwE. 

Selection Windows 

For some checkboxes a selection window will be opened. Figure 2 shows the selection window 
that opens when you click on Biomass. 
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These selection windows are how you select which functional groups and fleets you want the data 
and parameter values for. Simply double click on a group or use the arrows at the bottom to move 
the groups you want output for. 

Figure 2 – Selection window, here anchovy has been selected. 

Some selection windows have three columns like this window that opens when you click on 
Consumption as you need to select both predators and prey. So, when you are getting output for 
Consumption, you first select which predators you are interested, and then for each predator you 
have selected, you select which prey you want consumption values for. 

Option Groupings 

The checkboxes have been visually grouped together in a box. An example is the Functional groups 
only top left section in Figure 1. When the checkboxes that are grouped together in a box that 
has a Change Selection button, it  means that whatever selection is made in the selection window, 
will apply to all other checked  options within that group. Selections can also be modified for that 
group by clicking on the Change  Selection button to re-open the selection window. 

Biomass Integrated Checkbox 

Biomass integrated has been introduced as a quantity that can be used to compare two different 
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management strategies. It works by subtracting the initial biomass from the biomass at each time 
step to give the change from initial biomass. The area under the time series for change from initial 
biomass is then calculated. 

This is helpful because it indicates not just what the difference is between the initial and final 
biomass but also incorporates what the biomass has been throughout the time series. The benefit 
of  this can best be seen by imagining two different biomass time series, A and B, each being the 
result  of a different management strategy. Each time series starts and finishes at the same point, 
but time series A spends most of the time above the initial biomass, whilst time series B spends 
most of the time below the initial biomass. If we just compared the two management strategies 
by comparing  the final biomass values or initial/final biomass the indicator calculated would 
suggest no preference between the two strategies, whilst the integrated method would suggest 
that strategy A would be the preferable strategy as it leads to a higher biomass on average over 
the time period. 

Consumption 

The Consumption option retrieves the values required to calculate the rate of consumption of a 
predator on a prey and outputs the calculated result. Consumption is given as an absolute rate of 
consumption not a relative rate of consumption. The equation used for calculation is, 

Where Qji is consumption rate of predator j on prey i, Bj the biomass of predator j, (Q/B)j is the 
consumption/biomass ratio for predator j,  and DCji  is the percentage of predator j’s diet  that is 
prey i. 

Fitting Statistics 

The first option is the residual option. As the name suggests this produces output for the time 
series  of residuals for each functional group. This can be helpful in identifying where in a time 
series the  model differs most from the data. 

The second option is the SS or sum of squares option. This gives output of the sum of squares for 
all  function groups as well as an overall SS value for the whole model. 
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Yearly 

When you select this option the Results Extractor will calculate and output the values for each 
year  rather than each month for all time series outputs. This is done by calculating the mean over 
the  year. 

All Options 

You can click on this option if you want the Results Extractor to retrieve everything (i.e. tick all 
boxes). After you have clicked on it, you will be taken through all the selection windows required 
to  select all options. When this process is complete, all options will be checked. 

References 

The Results Extractor was developed by CEFAS 
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ECOSPACE 
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Do You Need Ecospace? 

Ecospace is a versatile simulation and modeling tool that can be applied to a broad range of 
research and management questions that require inclusion of a spatially-explicit component. 
Before deciding to construct a relatively complex spatial-dynamic ecosystem model, one must 
critically assess whether the complexity of Ecospace is justified to answer the research questions 
at hand. Simpler tools may exist for applications that do not require explicit or implicit 
consideration of trophic interactions over time and space. For example, there are many species 
distribution models capable of predicting past and future spatial patterns of species abundance 
based solely on oceanographic variables, and there are approaches for simulating spatial harvest 
policies in single- and multi-species fisheries that do not require modeling complex species 
interaction processes. Marine spatial planning tools that combine spatial information on basic 
ecological processes, threats, and socio-economics are also available for conservation planning 
and optimization (e.g. Marxan with Zones). All these approaches are useful when interactions 
(trophic and non-trophic) among species are far less important than oceanographic or 
anthropogenic pressures in determining the spatio-temporal dynamics of species under study. 

Yet, Ecospace is one of the few modeling frameworks that can combine species distributions, 
spatial harvest policies, and spatial planning while considering species interactions throughout 
complete marine food webs over space and time. Therefore, within a single modeling framework, 
Ecospace allows accounting for trophic dynamics, seasonality, primary production distributions, 
ecological niches, habitat suitability, environmental impacts, and species movement related to 
advection and migration, while also providing a suite of options (notably alternative future 
scenarios) to evaluate spatial-temporal management of fisheries and other anthropogenic 
pressures under a context of global change. It can therefore provide comprehensive assessments 
of ecosystem productivity, cumulative environmental and human impacts, and multi-sector 
tradeoffs that arise through food-web interactions in scenarios of multiple human activities. 

However, the host of capabilities come with an added cost of increased complexity, increased 
needs for input parameters and validation data with associated uncertainty and data 
requirements, and computational demands that should be considered carefully prior to choosing 
Ecospace. 

Adaption 

The chapter was adapted, with permission, from: 
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De Mutsert K, Marta Coll, Jeroen Steenbeek, Cameron Ainsworth, Joe Buszowski, David Chagaris, 
Villy Christensen, Sheila J.J. Heymans, Kristy A. Lewis, Simone Libralato, Greig Oldford, Chiara 
Piroddi, Giovanni Romagnoni, Natalia Serpetti, Michael Spence, Carl Walters. 2023. Advances 
in spatial-temporal coastal and marine ecosystem modeling using Ecopath with Ecosim and 
Ecospace. Treatise on Estuarine and Coastal Science, 2nd Edition. Elsevier. 
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What Transfers from Ecosim to Ecospace? 

Ecospace inherits settings, parameters, and data from Ecosim (which in turn has inherited some 
parameter values from Ecopath), and requires expression of additional parameters that explain 
how the food web and fisheries utilize space. Butt Ecospace cannot use all Ecosim values, but only 
parameters that either do not have an explicit spatial component (such as vulnerability settings, 
mediation effects and environmental response functions) or that Ecospace can spatialize (such as 
total functional group biomasses and fishing effort intensity). Driver and reference time series in 
Ecosim do not transfer to Ecospace as these time series lack a spatial component explaining how 
their impacts are distributed, and Ecospace does not have sufficient basic structure to spatialize 
these drivers. Instead, Ecospace requires the user to re-express these drivers and reference time 
series as explicit maps that have both spatial distribution and magnitude patterns. 

Biomass 

The total biomass per functional group is used from the base Ecopath model at initialization. 
During the initialization of a run, Ecospace will distribute the functional group biomasses based 
on the HFC model settings. While the model runs, dynamic food-web processes and other effects 
will take place and influence species distributions1. 

Biomass Forcing Time Series 

Ecosim biomass forcing time series inputs can be used to force the biomass of Ecospace. When 
this feature is enabled the spatially averaged biomass predicted by Ecospace will be equal to 
the Ecosim forced biomass from the forcing time series at the current time step. The spatial 
distribution of biomass will still be predicted by the Ecospace dispersal model. 

How it Works 

During the initialization of Ecospace the Capacity Model sets the capacity of each cell based on 
either the Foraging Response or the Habitat Base Foraging settings. Then the Ecopath biomass 
is spatially distributed across the map using the cell capacity and or the migration preference of 
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each cell as a weighting factor.  At the end of the initialization the spatially average biomass of 
Ecospace will equal the baseline Ecopath biomass. 

When the Ecosim biomass forcing is enabled the biomass from the time series will be distributed 
across the map using the current biomass distribution pattern. This maintains the spatial 
distributions predicted by Ecospace but overrides the biomass in a given cell. 

This takes the form, 

where Bijk is the biomass in row i column j for group k, Bfkt is the time series forced biomass for 
group k at time step t,  is the mean Ecospace biomass of group k. 

How to Use It 

Load time series data containing biomass forcing into Ecopath via the Ecosim Time series 
interface. Only time series data define as Biomass forcing (-1) will be used to force the Ecospace 
biomass. This makes the forcing data available to Ecospace but by default it will not be enabled. To 
enable it check the Use Ecosim biomass forcing check box on the Ecospace parameters interface, 
under the Time Series heading. If no forcing data is loaded this check box will be grayed out. You 
can turn individual forcing time series on or off via the Ecosim Time series interface. 

Fishing Effort 

The magnitude of fishing effort is inherited from Ecosim and is spatially distributed with the 
dedicated Ecospace gravity model2. Effort distributions are thus an Ecospace output, as are fishing 
mortality estimates (see 1.4.6). Note that Ecospace does NOT use Ecosim fishing mortalities, as it 
cannot predict where these mortalities might occur. 

Vulnerabilities 

Ecospace will use the vulnerability settings of Ecosim. Low vulnerabilities for a given predator 
imply that it is close to its carrying capacity, hence limiting how much the predator’s consumption 
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can increase if it should become more abundant. Note that vulnerabilities fitted in Ecosim assume 
spatial homogeneity, which becomes a less appropriate assumption for Ecospace maps that 
strongly partition predator and prey. In Ecospace, a species can be confined in small core areas 
depending on their habitat preferences (e.g., defined depth ranges) and area occupancy can 
change dynamically in response to predator and prey dynamics in which, when there is a match 
of distributions of either their predators or the fisheries, the species can have a higher encounter 
rate and mortality. There is currently no option in the software to perform the vulnerability 
parameter fitting, as in Ecosim, using Ecospace dynamics. 

Mediation Effects 

In Ecosim, inter-species mediation effects are applied to the modelled domain as a whole3 4. In 
Ecospace, these effects play out in each individual Ecospace cell. 

Environmental Responses 

Both Ecosim and Ecospace offer the ability to express functional group sensitivities to 
environmental conditions. The sensitivities are defined via environmental response functions 5, 
definitions that are shared between Ecosim and Ecospace. 

In Ecosim, environmental conditions are expressed as time varying forcing functions that 
represent environmental variables for the modeled area as a whole. In Ecospace, environmental 
conditions are expressed as maps that indicate both magnitude and distribution of an 
environmental variable, and these maps can be made time varying via the spatial temporal data 
framework 6. 

There is no satisfactory way to internally convert non-spatial environmental driver forcing 
functions in Ecosim to their spatially explicit counterpart in Ecospace. There is also no satisfactory 
way to ensure that the same environmental conditions are adequately represented in both Ecosim 
and Ecospace. Therefore, the EwE software is not able to transfer applied environmental drivers 
from Ecosim to Ecospace. Users therefore must configure environmental driver data in Ecosim 
and Ecospace separately. 
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Adaption 

The chapter is in part adapted, with permission,  from: De Mutsert K, Marta Coll, Jeroen 
Steenbeek, Cameron Ainsworth, Joe Buszowski, David Chagaris, Villy Christensen, Sheila J.J. 
Heymans, Kristy A. Lewis, Simone Libralato, Greig Oldford, Chiara Piroddi, Giovanni Romagnoni, 
Natalia Serpetti, Michael Spence, Carl Walters. 2023. Advances in spatial-temporal coastal and 
marine ecosystem modeling using Ecopath with Ecosim and Ecospace. Treatise on Estuarine and 
Coastal Science, 2nd Edition. Elsevier. 
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Ecospace Workflow 

There are numerous ways to develop an Ecospace model, all of which have in common that the 
first step should always be to ensure that a spatially-explicit ecosystem models is actually required 
to evaluate the research questions at hand. With that being the case, the same three-step process 
to get started is 

1. develop and balance an Ecopath model; 
2. calibrate the balanced model in Ecosim; and 
3. define the spatial model domain in Ecospace. 

The core of the Ecospace workflow begins with a balanced Ecopath model. Thus, once the 
research questions have been clearly defined, the first step is to develop (or adopt) an Ecopath 
model. See Heymans et al. 1 for the best practices in developing a balanced Ecopath model and 
Ainsworth and Walters 2 for the most common mistakes to avoid when using EwE. After the 
Ecopath model is balanced, the best practice is to use the Ecosim temporal simulations and its 
calibration capabilities as the ‘go-to’ calibration method prior to building an Ecospace model. 
This approach allows one to assess the capabilities of the model to represent past dynamics 
under past forcing conditions (hind-cast calibration) and assess the impact of the strength of the 
prey-predator interactions (or vulnerability parameters) prior to expanding to the more complex 
Ecospace module. This also helps provide an understanding for the main temporal drivers of the 
system and their impacts. The current and primary benefit of using Ecosim to calibrate the model 
is that calibration has yet to be included in Ecospace. There are more informal ways to ‘visually’ 
calibrate the spatial model (see Spatial Model Skill Assessment), but there has yet to be a tool 
developed within the software to systematically calibrate an Ecospace model 3. 

Many recent examples show the implementation of the Ecosim module of EwE for calibration of 
time-dynamic models (e.g., 4 5 6 7 8 9 10 11 12 13 14). 

The general method for calibration using the Fit to Time Series module in Ecosim and detailed 
methods using this tool have been well-documented 15 16. However, when a traditional fit cannot 
be achieved due to lack of time series data, exploratory analyses to determine the uncertainty 
associated with changes in vulnerabilities is recommended (e.g., Rehren et al. 17). 

The primary goal of fitting the Ecosim model to time series data is to evaluate if the model can 
reproduce historical patterns while refining key parameters, such as the vulnerabilities 18. Ecosim 
simulations are especially sensitive to the ‘vulnerability’ settings, which incorporates density-
dependence by representing behavioral ecology responses by prey that can limit predation 
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impacts and access to prey food resources, and expresses how far a group is from carrying 
capacity 19. 

Fitting a model to data is a process that usually involves an iterative approach, using long-term 
fisheries, biological, and environmental data together with vulnerability settings to evaluate which 
combination of data and vulnerabilities minimizes residuals relative to observations calculated 
during the fitting procedure. This calibration process also allow for evaluation of model sensitivity 
to forcing functions and vulnerability setting, and can provide a priori information on how the user 
should conduct a model sensitivity analysis (usually using the built-in Monte Carlo routine plugin). 

The data to incorporate into the calibration process cannot be predefined, and ultimately depends 
on data availability for the modelled ecosystem. A general rule of thumb is to have as long a 
reference period as possible to capture historical disturbance patterns and productivity shifts 
that may have occurred through both natural and anthropogenic fluctuations. Moreover, we can 
reflect data quality and error in the model fitting process. We can weigh the contributions made 
by different species to the goodness of fit term differently to reflect data quality. After defining 
what observational data to use for calibration, the sum of squared model deviations (SS) and 
Akaike Information Criterion (AIC) values should be used to find the most parsimonious model 
configuration that captures the most variation of the historical period in consideration 20 21. 
Calibration in Ecosim is not required for running Ecospace, but if done, the model is more reliable 
and interpretable, and more likely to lead to temporal dynamics in Ecospace for most species and 
functional groups, which are similar to the underlying Ecosim model. 

Adaption 

The chapter is in part adapted, with permission,  from: 

De Mutsert K, Marta Coll, Jeroen Steenbeek, Cameron Ainsworth, Joe Buszowski, David Chagaris, 
Villy Christensen, Sheila J.J. Heymans, Kristy A. Lewis, Simone Libralato, Greig Oldford, Chiara 
Piroddi, Giovanni Romagnoni, Natalia Serpetti, Michael Spence, Carl Walters. 2023. Advances 
in spatial-temporal coastal and marine ecosystem modeling using Ecopath with Ecosim and 
Ecospace. Treatise on Estuarine and Coastal Science, 2nd Edition. Elsevier. 

Notes 

1. Heymans, J.J., Coll, M., Link, J.S., Mackinson, S., Steenbeek, J., Walters, C., Christensen, V., 2016. Best 
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Movement 

In Ecospace, the movement of organisms across space can be realized through dispersal, 
migration and advection 1 2 3 

Dispersal 

Dispersal is the pseudo random movement of wandering. While dispersing, species in Ecospace by 
default have simple random movement. But an option is to have biased movement, with a higher 
chance of moving to a neighboring cell if feeding is better, and the risk of predation is lower. This 
is called Cell fitness, or the ratio between the ability to feed versus the risk of predation in a cell 
4. The main parameter to regulate dispersal is the Dispersal rate of a functional group. This is the 
absolute value of average individual annual movement distances as a result of random movements. 
The default value is 300 km year-1 for all groups apart from detritus groups (with a default of 10 
km/year). General values can be assumed to be of different relative magnitudes (e.g. 3, 30 and 300 
km year-1) representing essentially non-dispersing, and demersal and pelagic groups, respectively. 
It is recommended to use these general assumptions unless there are good reasons to believe 
otherwise. As is sometimes incorrectly quoted, Martell et al. 5 do not provide a way to calculate 
dispersal rates from swimming speeds. Instead, see Bradbury et al. 6. 

 
An individual based model (IBM) to estimate Ecospace dispersal rates from movement parameters 
has been implemented as a Shiny app. See the dispersal app at  https://ecopath.app/ and the 
User Guide chapter. 

Other parameters that influence movement are Relative vulnerability to predation (or grazing) outside their 
preferred habitat, which allows for increasing the strength of the prey-predation interaction outside the 
preferred habitat of a species grouping (Martell et al., 2005). In addition, the Relative movement to cell 
fitness or local fitness (per capita gain from net food intake minus predation mortality) is an experimental 
feature in EwE 6.6. Species move faster when a cell is less fit, trying to find food, avoiding predation, and 
improving chances of running into areas where conditions are better. 

This Relative movement to cell fitness field partially replaces the Relative feeding rate in bad 
habitat, where dispersal rates were assumed to differ between preferred and non-preferred 
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habitats, with higher values within non-preferred habitats than in preferred habitats. Organisms 
outside their preferred habitat may be conceived as less likely to consume as much appropriate 
food as within preferred habitat, due to the unavailability of such food or the danger associated 
with foraging. Organisms in non-preferred habitats will strive to leave these, and attempt to 
return as rapidly as possible to their preferred habitats. Ecospace users can reduce the feeding 
rate of ecosystem components down to 0.01 times the Ecopath baseline (i.e., the Q/B value). This 
mechanism can be turned off by setting the feeding rate multiplier equal to unity (1). Note that this 
mechanism has been integrated with the habitat foraging capacity model (EwE 6.4+). The default 
value for this multiplier is 5.0, the upper limit 10. A value of 1 will make this mechanism inoperative. 
Currently, this only applies to multi-stanza groups when running the IBM model 7; (and see below). 

Migration 

This type of movement concerns directed forced movement unrelated to habitat or feeding 
preferences to represent ontogenetic annual migrations (e.g., 8). A way to incorporate this 
movement is through migration target maps (in EwE 6.5+). Weight maps indicate migratory 
preferred areas for each month. Migration is different to dispersal, but migrating groups disperse 
during migration and when they reach their migration areas. To represent migrating species that 
leave the model area, users can designate a cell to be ‘outside’ and give this cell independent 
dynamics. 

Advection 

Ecospace also includes a rudimentary advection model to capture current drift of organisms 
like phytoplankton that tend to be transported with surface currents. Currents can be entered 
(monthly), can be calculated, or can be driven by an expert model. The advection field is calculated 
from wind/geostrophic forcing patterns for surface currents by solving the linearized pressure 
field and velocity equations across the Ecospace grid. Users can specify which groups are subject 
to advection velocities. Advected movement adds to dispersal and migration. Advection data is 
entered as u and v fields (x and y velocity), in cm/sec, where positive u = east, and positive v = 
south (not north, as is the common convention in current models). 

While the simple built-in advection model is useful for testing purposes, we recommend that users 
obtain advection fields from 3D hydrodynamic models, and import those via the spatial temporal 
data framework for advanced applications. 
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Advection also affects environmental contaminant distributions in the EwE Ecotracer model 9 10 11. 
For an illustrative example of the combined use of Ecospace, advection and Ecotracer see Tierney 
et al. 12. 

Adaption 

The chapter is in part adapted, with permission,  from: 

De Mutsert K, Marta Coll, Jeroen Steenbeek, Cameron Ainsworth, Joe Buszowski, David Chagaris, 
Villy Christensen, Sheila J.J. Heymans, Kristy A. Lewis, Simone Libralato, Greig Oldford, Chiara 
Piroddi, Giovanni Romagnoni, Natalia Serpetti, Michael Spence, Carl Walters. 2023. Advances 
in spatial-temporal coastal and marine ecosystem modeling using Ecopath with Ecosim and 
Ecospace. Treatise on Estuarine and Coastal Science, 2nd Edition. Elsevier. 
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Dispersal Rate IBM 
CARL J. WALTERS AND VILLY CHRISTENSEN 

An Individual-Based Model and Utility for Estimating Diffusive 
Mixing Rates of Organisms Between Spatial Model Cells 

Spatial models typically need to simulate diffusive spread of creatures between spatial model cells 
or grid points.  We usually approximate this spread by estimating instantaneous movement rates 
between adjacent discrete model grid cells; in terms of mathematical diffusion theory, such rates 
are approximations for D/L2, where D (km2/time) is the theoretical diffusion coefficient for the 
diffusion process and L is the discrete cell length in km. 

Instantaneous mixing rates for any particular creature depend on three factors: its swimming 
speed, how frequently it makes turns (changes in direction), and how much change in direction it is 
likely to make each time it turns.  Mixing rates are predicted to increase with increasing swimming 
speed, but to decrease with increasing number of turns per day and increasing variability in the 
movement direction after each turn.  There is no simple theoretical way to integrate these three 
effects into an instantaneous mixing rate estimate except under very restrictive assumptions 
about how the creature changes direction at each turn. 

The Ecospace dispersal estimator Shiny app at Ecopath.app generates estimates of instantaneous 
mixing rates by the simple tactic of simulating movement over one day of a large number of 
individual fish that are initially distributed at random over one spatial model grid cell, while 
counting how many of these individuals cross the model cell boundary at least once over the day. 
The approximate instantaneous mixing rate per day is then just the number of fish that exit the 
cell divided by the number of fish simulated. 

Swimming speed is typically predictable from body size (many organisms swim at about one body 
length per second for some proportion of each day), but the number of turns per day and how 
much direction changes at each turn may vary a lot depending in particular on how the creature 
searches for food, (e.g., whether it turns more frequently or tends to turn more sharply when 
it is in an area of high food concentration).  Absent direct sample data on fine-scale movement 
patterns, you can at least obtain some range of credible estimates for the instantaneous daily 
mixing rate by varying the number of turns (or distance between turns), and how much variability 
there is from turn to turn in the change in direction. 
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For each simulated movement step, each creature is assigned a random movement direction 
measured by the creature’s angle Ɵ in the X-Y plane (see Figure 1), and it moves a distance Dmove 
set by its movement speed and number of turns per day.  Using a wrapped normal distribution, the 
movement angle Ɵ’ for its next move is set as Ɵ’=Ɵ+N(0,sd) where N(0,sd) is a normally distributed 
random deviate with mean 0 and standard deviation sd (radians).  This method of generating 
random changes in direction results in creatures tending to keep going in the same direction if sd 
is small, (e.g., sd=0.2 [11˚ ]), and to make completely random direction changes at each move when 
sd is high, (e.g., sd=2 [115˚˚˚˚˚ ] For each model run, one of the individual movement patterns over 
the day is plotted, and model users are encouraged to do runs with multiple sd values so as to see 
the effect of the sd parameter on predicted movement trajectories.  Note that similar results are 
obtained if there are many daily moves with low sd or fewer moves with high sd. 

Figure 1. Direction of a moving organism at any time is measured by its angle Ɵ 
relative to north, Ɵ=0.0 being due north. Change in direction for its next 
movement to angle Ɵ’ is modeled with a normal distribution (relative probability 
shown in gray around the circle defining possible positions after the next move) 
with mean zero and standard deviation sd. Example shows random new 
movements sampled with standard deviation=0.5 radian (29˚), and a single 
sample realization Ɵ’. 

Note that estimates of instantaneous mixing rates from the IBM simulations can be badly biased 
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downward for creatures that have high daily movement speed S, when the model cell length L is 
small compared to this speed, in particular if S/L is larger than about 0.5, (e.g., a tuna moving 80 
km/day over a model grid of 20 km x 20 km cells has S/L=4).  In such cases, the exit probability 
per day can approach 1.0.  But the daily exit probability is only a good approximation for the daily 
instantaneous movement rate when this probability is very low, 0.05 or less. 

Assumptions and Parameters 

The utility is based on assumptions that, 

• A swimming organism tends to move in a given direction with a swimming speed that is a 
function of its body length. Swim speed is usually a linear function of body length (bl). Typical 
numbers are 1 bl/sec when searching, 2 bl/sec when hunting actively, and 0.5 bl/sec when 
slowing down to feed. The swim speed is, however, species depending, and will be much 
lower for, e.g, ambush predators. 

◦ Parameter: body length (cm). 
◦ Parameter: CV of body length (Coefficient of Variation = standard deviation / mean) 
◦ Parameter: swimming speed (body lengths per second). 
◦ Parameter: CV of swimming speed 

• The organism will change direction occasionally, notably after encountering potential prey 
and after being exposed to predators, so it will, e.g., be fewer turns per hour for a piscivore 
compared to a planktivore. How often does an organism make a turn? Run time is almost 
proportional to number of turns/hour. 

◦ Parameter: number of turns per active hour 
◦ Parameter: standard deviation of turns (in degrees) 

• The organism is active for a number of hours each day. Some species may swim for 24 hours 
per day, with only ultra-brief micro sleeping episodes, others will build a cocoon and sleep 
the night away, and many are only active around dawn and dusk. Hence, the number of hours 
active per day is very species dependent. Run time is almost proportional to number of hours 
active per day. 

◦ Parameter: number of hours active per day. 
◦ Parameter: CV of number of hours active 

• Some organisms may have a home base or range, and a propensity to stay near home 

◦ Parameter: proportion of moves that are towards the home base or range 
• Cell length, Ecospace does not keep track of where species are within cells, therefore the 

relationship between dispersal rate and cell size matters. The cell length parameter is easily 
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available from the base map knowing the latitude and cell size. Use the average of cell height 
and cell width. 

◦ Parameter: cell length (km) 
• If cell size is small and swim speed is high, it may be necessary to simulate only a proportion 

of a day. The output is sensitive to this parameter setting. 

◦ Parameter: Model simulation time (prop. of day) 
• An IBM model, models, well individuals. By default the dispersal of 1000 individual organisms 

is simulated. This typically takes 1-2 seconds on the server (including transmission), so 
reasonably fast. Simulating more fish will take longer and not necessarily change the results. 

◦ Parameter: Number of fish 
• Simulation time: When exit probability > 0.05/day, we recommend you decrease the model 

simulation time. Default is one day. 

◦ Parameter: Model simulation time (proportion of day) 

Figure 2 –  Interface for the dispersal estimator at Ecopath.app. 

The dispersal estimator IBM is implemented as a Shiny app at Ecopath.app‘s Dispersal IBM tab. 
and hosted at a site that hopefully will host also other Shiny apps 1 that may be of benefit for the 
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Ecopath user community. Upon load of the app, it will let 1000 individual organisms (particles) 
move at random according for one day (24 hours) with the default parameter settings, and show 
the resulting Ecospace dispersal rates, a.o. Every time parameters are changed in the app it will 
redo the movements for the (by default) 1000 individual organisms, and it will store the input 
parameter settings along with the estimated parameters. 

Action Buttons 

Generate 20 runs: When clicked, will generate 20 random runs (each with however many 
organisms that is specified in the Number of fish setting. The results for the 20 runs are stored in 
memory, and can be saved with the Save session output button. 

Save session output: By selecting the Save session output, the information from the entire session 
will be saved to a CSV file. If pressed consecutively, it will hold more and more information. The 
stored data will only be reset when the app is reloaded. 

Output 

Distances moved per day (histogram, day-1): Estimated based on input parameter setting and 
averaged over the simulated number of fish (i.e. organisms) simulated. 

Distances moved per day (scatter plot, day-1): Plot shows the distance moved during a day for 
each of the Number of fish organisms. 

Sample fish trajectory (X-Y plot, day-1): The trajectory for the first organisms simulated, drawn 
with uncertainty in input parameters as represented based on the parameter uncertainty. 

Distance between turns (m): Calculated as swim speed (bl/sec) x body length (cm) x 60 (sec/min) 
x 60 (min/hour) x 0.01 (m/cm). 

Exit probability per cell face (per day): Calculated from average probability over each of the 
simulated number of organisms that they exit a cell within the time period simulated. When exit 
probability > 0.05/day, we recommend you decrease the model simulation time. 

Diffusivity (km2/day): Calculated as exit probability / (cell length)2 / model steps per day 

Mix rate for spatial models (year-1): Calculated as 365 x probability of exit / model steps per day 
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Ecospace movement dispersal (km year-1): Calculated as the mixing rate x cell length x π. This is 
the estimated dispersal rate for use in Ecospace. 

Run time (secs): For information only, will provide some guidance for how long extended runs will 
take. 

The R code for the dispersal simulator is available at this link. 

Notes 

1. Let us know if you have an app that may be of interest 
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Land or water? 

The most important layer in Ecospace is the Depth layer that specifies which cells have ecosystem 
dynamics, and which do not. As EwE is mostly used in aquatic environments, the Depth layer uses 
the monikers Land to indicate cells of depths 0 where no ecosystem dynamics take place, and 
Water cells with positive depth values where ecosystem dynamics take place. The terms Land and 
Water are only labels, and can be interpreted freely to build terrestrial or mixed terrestrial/aquatic 
Ecospace models. Depths are implicitly expressed in meters, but any unit can be used as long as 
environmental response functions to depth relate to the same scales. 

EwE version 6.5 and newer feature an Excluded cells layer, which indicates cells that do not have 
ecosystem dynamics without having to turn these cells to land: this permits to keep the Ecospace 
map topography intact while running Ecospace in a part of the Water domain (e.g., excluding some 
shallower areas or enclosed coastal ponds from model dynamics, or areas that fall outside of the 
model domain of a hydrodynamic model that feeds environmental output into Ecospace through 
the Spatial Temporal Framework). 

Ecospace does not explicitly consider dynamics within the water column; besides indicating cells 
with ecosystem dynamics, positive depth values are used for generating recognizable maps and 
can be used for constraining functional groups to specific depth ranges via the HFC model (e.g. 
benthic, demersal, pelagic groups). Ecospace can implicitly represent the main impacts of depths 
without the computational overhead of explicitly representing the water column with a 3D model 
domain by: (a) stratifying food-web components to different depth ranges, (b) making specific 
groups reliant on specific types of substrate or sensitive to environmental drivers aggregated 
over specific depth ranges (e.g., demersal fish being driven by bottom layer temperatures), and (c) 
implicitly parameterizing the Ecopath diet matrix to account for life at specific depths. 

Adaption 

The chapter is in part adapted, with permission,  from: 

De Mutsert K, Marta Coll, Jeroen Steenbeek, Cameron Ainsworth, Joe Buszowski, David Chagaris, 
Villy Christensen, Sheila J.J. Heymans, Kristy A. Lewis, Simone Libralato, Greig Oldford, Chiara 
Piroddi, Giovanni Romagnoni, Natalia Serpetti, Michael Spence, Carl Walters. 2023. Advances 
in spatial-temporal coastal and marine ecosystem modeling using Ecopath with Ecosim and 
Ecospace. Treatise on Estuarine and Coastal Science, 2nd Edition. Elsevier. 
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Excluding Map Cells 
JEROEN STEENBEEK 

Historically, one could only exclude Ecospace map cells from computations by changing such cells 
to be ‘land’. This would yield confusing maps with unrecognizable land contours. In response, the 
concept of excluded cells was introduced to the Ecospace model in EwE release 6.4. Excludes 
cells are defined as cells that do not contain ecosystem dynamics, that are not considered in the 
Ecospace computations, and that are not rendered in the map displays. 

This feature allows accurate display of irregular (e.g., non-square) maps. During a recent project, 
the feature was used extensively but created confusion during model calibration and testing 
stages since it was sometimes not explicitly clear whether cells were empty due to 
misconfiguration of the model or due to excluded cells. 

It was decided to add a feature that could be toggled to explicitly display which cells were 
excluded, and the following changes were made to the EwE software to satisfy this requirement in 
two aspects of the EwE source code: 

1. The EwE user interface has gained the means to toggle display of excluded cells in a few 
locations. 

2. When this option is turned on, the Ecospace input and output maps will always explictly 
indicate which map cells are excluded. 

You can toggle the Always show excluded cells flag in the Maps form of the EwE options interface, 
found in the main menu (Figure 1), as well as in the excluded cell editor in the Ecospace input maps 
interface (Figure 2). The Ecospace input and output maps provide correct visual feedback (Figure 
3 and Figure 4). 
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Figure 1 – Toggling the excluded cells option in the EwE options interface. 
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Figure 2 – Toggling the excluded cells option in the EwE maps interface. The toggle is located in the Excluded 
Cell editor panel (bottom right), while the Ecospace map is showing excluded cells (the bright red area, bottom 
left, in the map). 
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Figure 3 – The Ecospace map input interface responding to the Always show excluded cells setting. Excluded cells 
are rendered in bright red (bottom left triangle of the map). 
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Figure 4 – The Ecospace results maps interface responding to the Always show excluded cells setting 
(bottom-right area of each map). 
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Spatial Data 

Any food web is subject to a range of stressors and environmental factors that may or may 
not change over time and space. Ecospace can include the ecological impacts of a wide range 
of stressors and environmental factors (for instance climate variables, species niches, layout 
of and access to Marine Protected Areas, contaminant distributions, etc.), but the magnitude 
and distribution of stressors and environmental factors are typically defined outside Ecospace 
by expert models. The spatial-temporal data framework (STDF,  see chapter), available in the 
professional version of the software, was added to include time-varying distributions of stressors 
and environmental factors (typically coming from other models) into the running Ecospace model 
(Steenbeek et al., 2013). This has enabled a host of new applications related to the spatial-temporal 
impact of change on the ecosystem. For each Ecospace layer that needs to receive time-varying 
maps, the user must supply one or more maps that represent the distribution and magnitude 
of external data over time. These maps can be provided in a number of Geographic Information 
System (GIS) file formats; the spatial temporal data framework uses on-board GIS engines to read 
and interpret the maps. Each map is time-stamped to tell Ecospace when the data is relevant, and 
any GIS processing steps that are needed to integrate the data are selected. Last, a time series of 
maps is connected to the Ecospace map layers of interest. When the Ecospace model is executed, 
external environmental maps are automatically integrated into the Ecospace model. 

There are a few special complicating considerations to using the spatial-temporal data framework 
(Steenbeek et al., 2021): 

• GIS data processing can significantly alter the quality of data if performed carelessly. The 
choice of rasterization and interpolation algorithms, strategies for dealing with missing data, 
unit conversions, and lack of data standards or poor adherence to these standards, can affect 
the quality of the data that Ecospace will ingest. Automatic data processing of large volumes 
of GIS data is not without risk and should always follow FAIR principles; 

• Different Ecospace layers have different data requirements (Table 1). This poses layer-
specific challenges to GIS processing. The spatial-temporal framework contains the 
necessary processing tools to perform basic conversions to targeted Ecospace layers. 

It is imperative that modelers first perform the GIS conversions outside Ecospace to ensure a good 
understanding of the data that Ecospace will be ingesting, including GIS processing artifacts that 
the conversion process may have created. This process can then be replicated by the STDF. 

The STDF offers the means to bypass its internal GIS engine for data that has been pre-processed 
for a specific Ecospace spatial extent, projection and cell size (Steenbeek et al., 2021). Such data 
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must be provided as ESRI ASCII raster maps (https://desktop.arcgis.com/en/arcmap/latest/
manage-data/raster-and-images/esri-ascii-raster-format.htm). This is the preferred method for 
those that wish to have full control over any GIS processing steps needed to develop the input 
layers. Table 1 provides an overview of the data needs for the various Ecospace layers. 
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Layer Purpose Format Units Observations 

Depth 
Bathymetry, 
identify 
ecosystem 
dynamics cells 

Floating 
point 

meters 
(implied), 
but can 
be 
anything 

Cells with values >= 0 have ecosystem 
dynamics 

Excluded cells 
Excludes cells 
from 
ecosystem 
dynamics 

True/
False - Exclude cells from ecosystem dynamics even 

when depth values are >= 0 

MPA 
Prohibit 
specific fishing 
for a specific 
MPA 

True/
False - Blocks entire cells rom fishing, not cell 

fractions. MPAs can overlap (EwE 6.4+) 

Habitat 
Suitable 
substrate, 
fishing limits 

Floating 
point [0,1] Cell area fraction covered by substrate 

Environmental 
driver 

SST, salinity, 
bottom 
dissolved O2, 
pH, etc 

Floating 
point Any Spatial distribution and magnitude of env. 

conditions 

Relative PP 
Distribute 
primary 
productivity 

Floating 
point [0, ∞> Weight layer for distributing PP. Applicable 

only to autotrophs 

Relative 
contaminants 

Distribute 
environmental 
contaminants 
concentrations 

Floating 
point [0, ∞> Weight layer for distributing base 

environmental contaminant concentrations 

Biomass 
forcing 

Affect 
Ecospace 
biomasses of a 
functional 
group 

Floating 
point [0, ∞> Override (absolute) or multiply (relative) 

biomass distributions of any functional group 

Habitat 
capacity 

Constrain 
niche model 
for a 
functional 
group 

Floating 
point [0,1] Set capacity in HFC model. Multiplicative with 

niche calculations 

Advection Current 
velocities 

Floating 
point cm/s 

u and v vectors from hydrodynamic models. 
Note that the Ecospace u direction is 
non-standard; positive currents flow South. 
Applied to groups identified as advected by the 
user 

Table 1. Ecospace layers and their data needs (reproduced with permission from Coll and Steenbeek, 
2017) 
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Layer Purpose Format Units Observations 

Migration 
Move species 
for reasons 
that Ecospace 
cannot predict 

Floating 
point [0, ∞> Weight layer to specific migration target areas 

(EwE v 6.4+) 

Table 1. Ecospace layers and their data needs (reproduced with permission from Coll and Steenbeek, 
2017) 

Adaption 

The chapter is in part adapted, with permission,  from: 

De Mutsert K, Marta Coll, Jeroen Steenbeek, Cameron Ainsworth, Joe Buszowski, David Chagaris, 
Villy Christensen, Sheila J.J. Heymans, Kristy A. Lewis, Simone Libralato, Greig Oldford, Chiara 
Piroddi, Giovanni Romagnoni, Natalia Serpetti, Michael Spence, Carl Walters. 2023. Advances 
in spatial-temporal coastal and marine ecosystem modeling using Ecopath with Ecosim and 
Ecospace. Treatise on Estuarine and Coastal Science, 2nd Edition. Elsevier. 
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Response Curves 

The species groups and life stages in any Ecospace model will only respond to environmental 
conditions and habitat features as discussed above via group-specific response curves (also known 
as environmental preference functions). The application of these response curves makes a cell 
more or less suitable for feeding by adjusting the size of the Ecosim and Ecospace foraging arenas 
and thus controlling the consumption rate of a species in that cell (Christensen et al., 2014). 

Generally, the response curves are constructed from in-situ monitoring data, lab experiments, 
and through statistical analysis of species occurrences versus observed environmental conditions. 
In many fisheries independent monitoring programs, water quality and habitat data are collected 
at the time of sampling so creating these curves is a straightforward process but using local or 
regional data implies that the response functions will not be able to be used for other ecosystems 
(Coll et al., 2019; De Mutsert et al., 2021, 2017a, 2012). If current monitoring data are not available, 
published relationships between species and environmental parameters can also be a good 
resource. For example, responses to several environmental parameters are available worldwide 
from the free database AquaMaps (Kaschner et al., 2019). The use of AquaMaps response functions 
is ready to use in Ecopath with Ecosim models due to an AquaMaps-EwE link in the form of a plug-
in freely distributed, and has been applied in several EwE applications (Bentley et al., 2020; Coll 
et al., 2020, 2016; Corrales et al., 2018, 2017). However, the limitation of this approach is that the 
response functions show a uniform distribution between the 10th and the 90th percentile, which 
can underestimate the impact of environmental change on consumption and thus deliver overly 
optimistic results. 
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Figure 6 – Different shapes that response functions to temperature can take (reproduced from Serpetti et al., 
2019) 

Other options include using a Gaussian distribution (Bentley et al., 2019, 2017; Serpetti et al., 2017), 
which considers a more sensitive niche envelope but can overestimate the environmental effect. 
Finally, expert knowledge could also be used to develop functional responses to environmental 
conditions, but their application should be well documented in the methods (Bentley et al., 2019; 
Coll et al., 2019; Corrales et al., 2017). Additionally, AquaMaps response functions can be refined by 
using regional rather than global distribution of observations used to calculate the functions and 
building the functions to represent environmental values of a specific region (Ouled-Cheikh et al., 
2022). A sensible approach can be to test the effect of various response shapes since these shapes 
have an effect on the modelling outputs (Burrows et al., 2019; Waldock et al., 2019; Fig. 6). 

There are a few important considerations to keep in mind when applying environmental 
responses: 

• Use environmental responses only when necessary, applying the most important driver to 
the most sensitive groups only, and test how the entire food web responds. Build up 
complexity gradually and only where absolutely warranted to make the ecosystem as a whole 
respond to (changing) environmental conditions; 

• Be wary of auto-correlation between drivers; 
• Be careful not to over-constrain functional groups; 
• Do not assume that a response curve for a multi-stanza group necessarily applies across all 

stanzas. Response curves should be developed for each life stage, given that many species 
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have ontogenetic shifts in environmental preferences (De Mutsert et al., 2021, 2017a). 

Adaption 

The chapter is in part adapted, with permission,  from: 

De Mutsert K, Marta Coll, Jeroen Steenbeek, Cameron Ainsworth, Joe Buszowski, David Chagaris, 
Villy Christensen, Sheila J.J. Heymans, Kristy A. Lewis, Simone Libralato, Greig Oldford, Chiara 
Piroddi, Giovanni Romagnoni, Natalia Serpetti, Michael Spence, Carl Walters. 2023. Advances 
in spatial-temporal coastal and marine ecosystem modeling using Ecopath with Ecosim and 
Ecospace. Treatise on Estuarine and Coastal Science, 2nd Edition. Elsevier. 
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Spatial Distribution 

In Ecospace, a modeled area is represented by a grid of equally sized cells, where each cell has the 
basic Ecosim trophic linkage dynamics and other components of ecosystem dynamics, and cells 
are linked through biomass flows associated with spatial mixing processes. Cells with ecosystem 
dynamics need a number of descriptors to define how specific ecosystem components and fishing 
fleets can utilize the cell. 

In the original 2008 version of the Ecospace model, each cell with ecosystem dynamics would be 
assigned to a single, discrete habitat type, and functional groups would be assigned to preferred 
habitats (Christensen and Walters, 2004; Pauly et al., 2000; Walters et al., 1999). Fishing fleets 
would be allowed to fish over specific habitats, or could be blocked from fishing in no-take zones 
(Walters, 2000). Moreover, relative variations of the primary productivity and of costs of fishing 
across space (but fixed in time) could be incorporated to influence the spatial distribution of the 
food web and fishing effort, while the model accounts for species movement and other behavioral 
aspects. 

In the 2008 version, habitat structures with associated impact on biomass distributions and 
trophic interactions were represented by a binary habitat use pattern, with each spatial cell being 
either entirely suitable – or entirely unsuitable – for species/functional groups. Therefore, the 
original version of Ecospace assumed homogeneous conditions within each spatial cell, and local 
but possibly relevant variations within cells could not be represented (Christensen et al., 2014). In 
addition, a major shortcoming in this original Ecospace configuration was the limited support to 
include environmental variability as the model ran (Steenbeek et al., 2013). 

Functional groups in Ecospace disperse throughout the map based on cell suitability, representing 
the tradeoff between being able to eat and the risk of being eaten, where differences in cell 
suitability define the likelihood of a species moving to a neighbouring cell (Christensen et al., 
2014). In 2013, Ecospace version 6.3 introduced the Habitat Foraging Capacity (HFC) model that 
computes the foraging arena size in a cell (Christensen et al., 2014). The HFC contains two main 
methods, described below, that can be used to define the foraging arena size, or foraging capacity 
which can be used individually or in combination (Fig. 4). 

The Habitat Foraging Capacity (HFC) model consider the cumulative effects of physical, 
oceanographic, and environmental conditions (such as depth, bottom type, temperature, salinity, 
oxygen concentrations and primary production) onto species distributions (Christensen et al., 
2014). The HFC model defines a continuous relative habitat capacity for each functional group in 
each cell (Christensen et al., 2014), and the proportion of a cell that functional groups can use 
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became a continuous value from 0 to 1, allowing for the inclusion of as many environmental factors 
as needed to define the foraging capacity of a cell for a species (Fig. 1). 

Figure 1 – Schematic representation of the Habitat Foraging Capacity Model. The intercept of an environmental 
parameter value (X) with an environmental preference function (F) yields a foraging capacity (Y) for a given 
environmental driver, which multiply to a express the total foraging capacity in the cell for a specific functional 
group (modified from Christensen et al. 2014). 

Habitat Affinity 

The first method is the legacy Ecospace habitat affinity modus, where the user defines habitat 
that typically relate to types of substrate relevant to the ecosystem, and how functional groups 
prefer each different type of habitat. Typically, 5-10 habitat types are used, although there can 
be many more. For each type of habitat (e.g., sand, rock, seagrass, mud, gravel, etc.) there is an 
accompanying habitat map that expresses the fraction of cell coverage by that habitat type on a 
scale of 0 to 1, where 0 indicates no presence and 1 indicates a cell covered entirely by that habitat. 

Per functional group, users can quantify how preferred the habitat is for each given functional 
group that relies on habitats. Preference values range from 0 to 1, where 0 indicates no preference, 
and 1 optimal preference. Per cell, Ecospace can thus have patches of multiple habitats. The 
combined presence of habitats and individual habitat preferences leads to a total habitat 
suitability factor between 0 and 1 for any given functional group, across the map (Püts et al., 
2020; Walters et al., 1999). Note that habitats can also be used to indicate vertical structures (e.g., 
Steenbeek et al., 2020). The sum of habitat areas used by group in a cell should sum to, and not 
exceed 1. 
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Environmental Preferences 

With the introduction of the Habitat Foraging Capacity model (Christensen et al., 2014), Ecospace 
gained a second option to calculate cell foraging suitability through the presence of environmental 
drivers and functional responses to these drivers. The “environmental preferences” model is 
similar to a habitat suitability index model that is widely used in spatial ecology (Rushton et 
al., 2004). Users can define any number of environmental drivers that are known to affect the 
distribution of parts of the modeled food web. For each defined environmental driver (sea surface 
temperature, wave action, low frequency noise, bottom dissolved oxygen, salinity etc.) Ecospace 
incorporates a spatial map that describes how the driver is distributed across the modeled area. 
A functional response curve, unique to each group and shared with Ecosim (see section 1.4.2), 
which defines the environmental effect of the driver to each impacted group also needs to be 
entered. One advantage of the “environmental preferences” model is that the same environmental 
driver data can be used across a number of functional groups, with response curves being used 
to specify group tolerances to, or preferences for, specific environmental conditions. The spatial-
temporal framework added the ability to change the maps with environmental conditions over 
time (Steenbeek et al., 2013). 

The HFC model considers “habitat affinity” and “environmental preferences” and solves most of 
the problems of the old habitat affinity (only) model. With the release of EwE 6.5, the combined use 
of habitats and environmental sensitivities is a per-group setting. This means that users have the 
freedom to control whether the utilization of space by a given group is driven by habitat affinity, 
by environmental preferences, or both (see Fig. 5 for example). 

Figure 5 – Examples of environmental preference maps included in Ecospace. A.) These data represent the 
environmental preference based on percent wetland occurring in each grid cell that was uploaded into the 
Ecospace module on an annual time step. B.) Example of an environmental preference map based on salinity that 
was uploaded into the Ecospace module on a monthly time step. 
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Recommendations 

As the user develops the habitat and environmental driver maps and response curves necessary 
to define how groups use the modeled space, it is advisable to start with the few environmental 
features that are most important for defining the distribution. Complexity can be built gradually, 
with less important environmental features being added subsequently until a realistic biomass 
distribution of groups is achieved. This is to avoid the problem of driver temporal and spatial 
correlation: their simultaneous application can result in an overemphasized effect on species 
distribution (Amodio, 2015; Serpetti et al., 2016). For example, temperature and depth may each 
play a role in establishing the spatial domain inhabited by a species or group, but these two 
environmental features are in many cases not independent. It is not trivial to disentangle these 
environmental effects, and some authors suggest the prior use of multivariate or spatial statistical 
approaches to determine appropriate coefficient weightings (Coll et al., 2019; Grüss et al., 2018) 
or selection and exclusion in case of strong correlation, a common practice for example in GAM 
modeling (Panzeri et al., 2021; Serpetti et al., 2016). 

Adaption 

The chapter is in part adapted, with permission,  from: 

De Mutsert K, Marta Coll, Jeroen Steenbeek, Cameron Ainsworth, Joe Buszowski, David Chagaris, 
Villy Christensen, Sheila J.J. Heymans, Kristy A. Lewis, Simone Libralato, Greig Oldford, Chiara 
Piroddi, Giovanni Romagnoni, Natalia Serpetti, Michael Spence, Carl Walters. 2023. Advances 
in spatial-temporal coastal and marine ecosystem modeling using Ecopath with Ecosim and 
Ecospace. Treatise on Estuarine and Coastal Science, 2nd Edition. Elsevier. 
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Setting Base Effort 
CARL J. WALTERS 

Ecospace attempts to predict the spatial distribution of fishing effort in relation to changes in 
profitability of fishing in different cells and policy changes such as marine protected areas and 
seasonal closures.  It predicts the fishing effort Eijg by gear g in spatial cell i,j at each time step 
by using a gravity 1 or logit choice model, which apportions total effort Eg for the gear using 
proportions by cell pgij 

Here, Agij is an attraction weight for cell i,j that depends on the relative profitability of fishing 
in that cell.  Profitability for cell i,j is predicted from prices and abundances of species taken 
by the gear, spatial cost factors, whether the gear can operate in the habitat type set for the 
cell, and whether or not the cell is open to fishing by gear type g.  Note that the proportions 

must sum to 1.0.  Note also that total efforts Eg can be made to vary over time by supplying relative 
effort multipliers over time for each gear type in Ecosim, where a multiplier value of 1.0 represents 
the Ecopath base fishing impact. 

When moving from Ecopath and Ecosim to Ecospace, it is important to set a base total effort value 
for Eg such that the Ecospace effort allocation calculation (eq. 1) results in overall (over all grid 
cells) fishing mortality rates that are as close as possible to the Ecopath base values Fgk=Cgk/Bk 
for each fishing gear and Ecopath biomass group k, where Cgk is the Ecopath base catch of group 
k by gear g and Bk is the Ecopath base biomass for group k.  Note that replication of the Ecopath/
Ecosim model over the nw active (water) cells in a spatial grid results in total biomasses over the 
grid of nwBk, so base effort needs to be set so as to give total catches over the grid that are as 
close as possible to nwCgk, otherwise Ecospace will predict total fishing mortality rates that differ 
widely from Fgk.  For gears that fish spatially concentrated species (pgij high for only a few cells 
i,j), we cannot simply set total base effort to nw (number of water cells times base effort of unity 
per cell), since allocation of such a high total effort to just a few cells with high pgij can result in 
gross overestimation of by-cell fishing rates Fkij for those few cells.  We also need to guard against 
such over-prediction of fishing mortality rates for groups that use the whole spatial grid, but are 
modelled to have migratory behaviour so as to be spatially concentrated in varying parts of the 
grid in different months of each simulation year. 
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Given the complex profitability calculations used to predict pgij from attractivenesses Agij (1), 
it is not in general possible to choose base efforts Eg so as to exactly predict Ecopath base 
fishing rates Fgk for all gears and species.  For most models, about the best that we can do 
is to choose Eg so that it at least predicts the total Ecopath base catch nwCg, where 

is the total catch by gear g summed over biomass groups that it catches (landings and discards). 
To achieve this prediction, we need to set Eg so that it satisfies the total catch condition, 

Here, Egpgij is the effort allocated to cell i,j, qgk is the catchability coefficient (Ecopath base 
fishing rate per unit of effort) for gear g on group k, and 

is the total catch per effort summed over groups k for gear g in cell i,j.   Simply solving (2) for Eg 
results in the desired base effort: 

Note that if all gravity weights are the same, i.e. biomasses and costs are uniform over the spatial 
grid, each pgij is just 1/nw and each grid cell’s catch is Cgij=Cg, then (6) just predicts Eg=nw.  At the 
opposite extreme, if all fishing by gear g occurs in just one grid cell such that pgij for that cell is 1.0, 
and all biomass available to gear g is also in that one cell (Bijk=nwBk for every k), then Eg will be set 
to 1.0.  For intermediate cases in terms of spatial concentration of attractivenesses and biomasses, 
(6) generally predicts Eg values between 1.0 and nw. 

Application of (6) requires an initial assessment of the biomass distributions Bijk, and of the 
attractivenesses Agij that depend at least partly on the biomass distributions.  Particularly for 
models that include migratory species, reasonable values for these distributions and 
attractivenesses are not available until at least a few time steps into each simulation, after enough 
time to allow for some spatial mixing and oriented movement.  So the convention used in Ecospace 
is to initially set the Eg for each group to the number of spatial cells that the gear is physically 
able to fish, then simulate a few time steps and reset Eg to the value implied by the spatial biomass 
distribution after those steps.  In some cases, it may still be necessary to adopt an iterative 
approach and to use total effort multipliers (Ecospace > Input > Ecospace fishery > Fleet dynamics 
> Tot. eff. multiplier) to increase or decrease efforts for some gears after initial simulation trials 
indicate persistent over- or under-prediction of fishing mortality rates. 
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Notes 

1. Caddy, J.F. 1975. Spatial model for an exploited shellfish population, and its application to the Georges Bank 
scallop fishery. J. Fish. Res. Board Can. 32: 1305–1328. https://doi.org/10.1139/f75-152 
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Model Type Options 

Ecospace has three options for modeling the movement and survival-growth of multi-stanza 
groups – groups that represent ontogenetic stages of a species, such as larvae, juvenile and adult 
fish: the Basic Partial Differential Equations (PDE) model applied to split pools of biomass in the 
original Ecospace model, the EwE6 multi-stanza model and the Individual-Based Model (IBM; 
Walters et al., 2010, 1999). 

Basic PDE 

This is the original implementation of multi-stanza accounting in Ecospace and is included for 
legacy reasons (Walters et al., 1999). This option does not account for size-age structure within 
each life stages of the multi-stanza group, but links one species related to different pools of 
biomass. Instead, it treated each life stage as its own functional group that assumed the size-age 
structure was at equilibrium for the life stage. Because of this, the PDE does not give an accurate 
accounting for numbers at age, and body weight is calculated on a grid averaged value. If a model 
contains multi-stanza groups, it is recommended that one of the other options are used. 

EwE6 Multi-Stanza Model 

The EwE6 multi-stanza model is the default option. This model includes a single spatially averaged 
size-age structure model that is used to populate the Ecospace grid cells. Spatial distributions are 
handled by the diffusion model in the same manner as the non-multi-stanza biomass pool groups. 
Weighted, spatially averaged consumption and total mortality rates are calculated across the map 
for each model time step (Walters et al., 2010). These spatially averaged values update numbers- 
and weights-at-age of the single size-age structure model. Once this is done, the map-averaged 
biomass for each life stage of the multi-stanza group can be integrated from the numbers- and 
weight-at-age. These averaged biomasses are then populated back into the grid cells based on the 
original biomass weighting of each cell. This algorithm maintains the Ecosim style numbers and 
weights at monthly ages accounting, with fecundity rates based on body weight above weight at 
maturity, and size-number dependent monthly egg production used to predict recruitment rates 
to age 0 fish. However, because it is based on spatially averaged values, any local differences in 
consumption and/or mortality rates are lost. For example, the consumption and mortality rates 
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inside an MPA will be the average across the modeled area, not just the values inside the MPA. 
Similarly, local effects on consumption and mortality of habitat restoration will be averaged over 
the model domain (Walters et al., 2010). 

IBM 

In the IBM Ecospace predicts spatial changes in consumption and mortality rates by dividing 
each multi-stanza population into a user-controlled number of packets (a.k.a. cohorts or super-
individuals). Each packet is assumed to represent a group of identical individuals of the same age 
and each packet maintains its own multi-stanza size-age structure. At initialization of a run, each 
packet is populated with the same monthly numbers-at-age and weight-at-age, then uniformly 
distributed over the grid cells with a habitat capacity greater than 0.1. At each monthly time 
step, each packet is tracked independently as it moves around the grid cells. This allows each 
packet to derive its consumption and mortality rates from the conditions in the local cell it 
finds itself in at the beginning of the time step. By doing this, each packet can respond to local 
ecological conditions as it moves through both space and time (Walters et al., 2010). Monthly 
recruitment creates new IBM packets with initial age 1 month, spatially distributed in proportion 
to the distribution of spawning biomass. 

Due to the way the number of packets that is used to represent a single month in a multi-stanza 
life stage is calculated, multi-stanza life stages that span a shorter time frame (or number of 
months), are represented by fewer packets. An implication of this is that if the number of packets 
is too low, the spatial distribution will be unrealistically patchy, and the life stage’s survival-growth 
will be dominated by the ecological conditions of only the few cells that the packets happened 
to find itself in due to random movement. The package multiplier used to scale the total number 
of packets needs to be high enough to give realistic spatial distribution for the shortest-lived life 
stages of multi-stanza groups. However, if it is too high the computational speed may be slow. 
Setting the number of packets is a tradeoff between computational speed and the need to be high 
enough that it will predict realistic spatial distributions (Walters et al., 2010). 

The movement in the IBM model is controlled by the same parameters as the non-multi-stanza 
species base dispersal rate, relative vulnerability to predation in bad habitat, relative movement 
speed to cell fitness, relative dispersal in bad habitat, advection, migration and the foraging 
capacity of neighboring grid cells. The base dispersal rate and grid cell size are the main drivers 
of the IBM dispersal rates with foraging capacity, advection and migration weighting the direction 
of the movement. Monthly movements are a series of incremental steps with each step being no 
larger than half a cell. The direction for each move can only be in one of the cardinal directions 
(N, S, E, W). If a packet cannot escape the grid cell from its current location, because it can only 
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move a maximum of half a cell, then it will move in a uniform random direction in one of the four 
directions. Otherwise, if it can escape the current cell in one move, the probability of it moving in 
any one direction will be a random choice weighted by the foraging suitability of the neighboring 
cells (Walters et al., 2010). 

While a packet can move through multiple grid cells in a time step, the consumption and mortality 
rates are derived from the grid cell it finds itself in at the start of a time step, and these rates 
are not integrated across the cells it traveled through during the time step to get to its current 
location. This assumes the grid cell size and dispersal rates are such that a packet can only move 
over a few grid cells in a time step, or the spatial distribution of food availability and mortality rates 
does not vary greatly over the grid cells a packet traveled through in a single time step. As with 
other Ecospace model configurations, when using the IBM one needs to make sure that the spatial 
resolution of the basemap, the spatial distribution of habitat or foraging capacity and dispersal 
rates capture the behavior of the multi-stanza life stages. 

The initial spawning location of each packet can be set to either recruit where spawned, current 
location of the spawner, or to be moved to randomly selected nursery cells, a grid cell with 
habitat capacity greater than 0.1 for the age 0 life stage of the multi-stanza group. This allows the 
habitat of spawning adults and start-age recruits to be spatially separated in such a way that the 
movement model could not transport them across the grid cells in a single time step. This prevents 
the recruits from incurring unrealistically high mortality rates as they move into better foraging 
capacity. Packets that age from one life stage to the next can also be randomly moved at stanza 
entry into cells that have a foraging capacity of greater than 0.5 for the life stage they are aging 
into. Again, this prevents the life stage from incurring unrealistic mortality rates as it moves into 
areas of better foraging. 

The multi-stanza plus IBM model has not been intensively featured in publications yet (but see 
Espinosa-Romero et al., 2011; Grüss et al., 2016; Püts et al., 2020). There are many potential 
applications that can benefit from these capabilities, including the evaluation of MPAs and MPA 
connectivity, the effects of climate change or the impacts of invasive species. The current IBM 
model application correctly incorporates current velocities to move advected multi-stanza 
packets. This makes Ecospace especially useful for studying protected area connectivity. 

Adaption 

The chapter is in part adapted, with permission,  from: 

De Mutsert K, Marta Coll, Jeroen Steenbeek, Cameron Ainsworth, Joe Buszowski, David Chagaris, 
Villy Christensen, Sheila J.J. Heymans, Kristy A. Lewis, Simone Libralato, Greig Oldford, Chiara 
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Piroddi, Giovanni Romagnoni, Natalia Serpetti, Michael Spence, Carl Walters. 2023. Advances 
in spatial-temporal coastal and marine ecosystem modeling using Ecopath with Ecosim and 
Ecospace. Treatise on Estuarine and Coastal Science, 2nd Edition. Elsevier. 
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Addressing Uncertainty 

General Practices 

It is generally a good practice – if not mandatory – to explicitly acknowledge sources of 
uncertainty in data and modeling exercises, make reasonable attempts to quantify it, and caveat 
the model results as appropriate. 

An ever-increasing body of literature categorizes the various types of uncertainty related to the 
development and operation of ecosystem models (Cariboni et al., 2007; Harwood and Stokes, 
2003; Payne et al., 2016; Spence et al., 2016; Steenbeek et al., 2021). A useful typology is: (1) model 
/ structural, (2) stochastic-, (3) data-, and (4) parameter uncertainty (Gregr and Chan, 2015). 
Model uncertainty occurs due to potential incomplete or inaccurate abstractions embedded in 
the structure of the model. Ensemble modeling approaches can be an effective approach to better 
understanding uncertainty due to implicit architecture of a model: multiple models are used, each 
representing a different method of abstracting and representing the ecosystem, e.g., Scales et al. 
(2016), Spence et al. (2018), Lotze et al. (2019) and Tittensor et al. (2021). Structural uncertainty can 
also be explored using a single model by modifying model equations, for example by aggregating/
disaggregating compartments, changing functional relationships and/or modifying basic function 
process, e.g., linear fishing mortality (Coll et al., 2020; Hansen et al., 2019; Pantus, 2007). Stochastic 
uncertainty occurs due to chaotic or ‘noisy’ process signals, non-stationary patterns and 
relationships between variables (Deyle et al., 2016; Litzow et al., 2018; Walters, 1987), or uncertainty 
in processes represented by the model (e.g., recruitment, (Spence et al., 2016). Data uncertainty 
results from measurement and observation error and can be propagated through a model due to 
the model fitting procedure. Parameter uncertainty arises due to non-unique parameter values 
that the modeler must choose from, as well the large number of parameters typically needed for 
ecosystem models. 

The EwE approach provides some means to execute parameter uncertainty analysis (e.g., (Coll and 
Steenbeek, 2017; Heymans et al., 2016; Steenbeek et al., 2018). As the Ecospace module inherits 
model structure, parameters, and associated uncertainty from both Ecopath and Ecosim, we 
recommend using a formal fitting routine and sensitivity analysis in Ecopath and Ecosim (e.g., 
(Scott et al., 2016) before tackling uncertainty in Ecospace. To assess Ecospace model sensitivity 
due to the underlying parameterization of Ecopath / Ecosim, the Ecosampler module described 
in section 3.2 can be used (Steenbeek et al., 2018). The Ecoranger module in EwE 5 was a pseudo-
Bayesian approach to search for parameters (Christensen et al., 2005; Christensen and Walters, 
2004; Walters et al., 1997), though no Bayesian uncertainty analysis tool is currently built into EwE 
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6. One promising alternative is Bayesian-Species Distribution Models (B-SDM), which implicitly 
considers uncertainty in spatial distributions and environmental niches. This type of model can be 
used in a complementary manner with Ecospace to incorporate uncertainty in plausible habitat 
capacity, response functions or both (see Coll et al., 2019). 

A ‘bound, search, and score’ generalized approach for tackling uncertainty due to data and 
parameter uncertainty may be intuitively familiar to most modelers and help to contextualize the 
various methods, tools, and statistics available to Ecospace users (Fig 9). This simple framework 
captures the general approach used in a previous ad hoc effort to parameterize Ecospace 
(Romagnoni et al., 2015). 

The ‘bound’ step addresses issues related to computational cost associated with running 
Ecospace, a typical challenge with the complexity of most ecosystem models. In Ecospace, this 
must currently be done manually. We recommend selecting Ecospace parameters for sensitivity 
analysis based on: (a) importance to the questions, patterns, or processes being investigated, 
(b) those that are most frequently tuned, and (c) computational limitations and model run time. 
Common non-spatial parameters used to tune Ecospace models are the “vulnerability exchange 
rate”, “base dispersal rate”, “relative vulnerability to predation in bad habitat”, and “effective power 
of fishing fleets”. Key spatial parameters (those that vary between raster cells) may also be bounded 
using the spatial-temporal framework by importing raster data prepared in advance that represent 
habitat capacity (Coll et al., 2019; Steenbeek et al., 2013). 

In Ecospace, the ’search’ step is currently limited to a manual search, since Ecosampler and 
the Monte Carlo routine are not yet able to access Ecospace parameters. However, the spatial-
temporal framework makes it possible to easily run and re-run Ecospace using different spatial 
parameterizations, and the ability to run EwE directly from code greatly facilitates the repeated 
execution of model exercises to perform structural uncertainty analyses. 

‘Scoring’ the Ecospace runs may be done in several ways. A simple approach is to use comparisons 
between Ecospace results from multiple runs. Currently, Spearman’s spatial correlation, which 
can be calculated using the ‘raster’ package in R using the “corLocal” function (R Core Team, 
2018) is popular (Coll et al., 2019; Piroddi et al., 2022; Romagnoni et al., 2015; Subramaniam et al., 
2022), while (Lynam et al., 2017) used Mantel spatial correlation with 999 permutations to test the 
significance level. To best address the task of comparing Ecospace outputs, a spatial-temporal 
statistical measure of similarity, or spatial-temporal cross correlation, is required. Unfortunately, 
spatial cross-correlation statistics in Ecospace are still under development and present 
computational and theoretical challenges (Chen, 2015). In the lack of such statistics, Püts et al. 
(2020) utilized a set of metrics for the temporal (Pearson correlation and root mean squared error) 
and spatial fit (Schoener’s D index) separately, finally combining them using a Taylor diagram. 
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Figure 9 – Diagram of the ‘bound, search, and score’ framework for tackling uncertainty which captures the 
general approaches used to parameterize Ecospace 

Spatially-temporally explicit uncertainty assessments are a challenging priority for future 
development (Steenbeek et al., 2021). The development plans for EwE includes extending the 
parameters that can be perturbed by the Monte Carlo routine (and subsequently sampled by 
Ecosampler) to Ecospace (Steenbeek et al., 2021, 2018). Given the high computational cost of 
running a spatially resolved model such as Ecospace, the parameter search space (i.e. the range 
of the parameters to be explored, and their combinations) must be limited to a local instead of 
a global search (Hansen et al., 2019; Pantus, 2007; Püts et al., 2020), with the caveat of reducing 
the possibility of exploring extreme values and combination of parameters. Iterative, ad-hoc 
process for space reduction (e.g., see Romagnoni et al., 2015) are time-consuming when manually 
implemented, and automated procedures are not available at present. Preliminary understanding 
of parameter space is thus critical to make the analysis tractable. 
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Ecosampler 

Ecosampler is a module within EwE to measure the impact of Ecopath input parameter sensitivity 
on its results (Steenbeek et al., 2018). Ecosampler records samples – alternate mass-balanced 
parameter sets for a food-web model – from the built-in Monte Carlo routine, and replays these 
samples through all of the EwE modules and any loaded plug-in. Ecosampler can capture output 
variation due to base input parameter sensitivity of any computational component including the 
temporal module Ecosim, the spatial–temporal module Ecospace, and plug-ins such as Ecological 
Network Analysis, Value Chain, and Ecological Indicators (Fig. 10). 

Figure 10 – Predicted (solid lines) versus observed (dots) biomass for various functional groups of the model for 
the Israeli Mediterranean continental shelf ecosystem model for the period 1994–2010. Blue shadows represent 
the 5th and 95th percentiles obtained from Ecosampler-perturbed model outputs. Rho and p-values were 
obtained from Spearman’s rank correlation test (modified with permission from Corrales et al., 2017) 

Image attributions? 
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Adaption 
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Ecospace Output 

Ecospace offers a number of facilities to write model outputs to storage for subsequent analysis. 

Basic Ecospace Output 

The most basic form of Ecospace output are spatially-temporally explicit distributions of biomass, 
fishing effort and catches in a range of file formats (Fig. 7). Ecospace can also write maps per time 
step, of computed habitat foraging capacity, contaminant concentrations, and discards, which can 
help to better understand the model’s behavior and address specific management questions. The 
EwE plug-in system (Steenbeek et al., 2016) allows the user to expand the list of standard outputs. 

Be aware that writing output to hard-drive can amount to large volumes of data, especially when 
writing spatial output for every monthly time step. 

image  Image Not Appearing 
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Figure 8 – A: The Mississippi River Delta Model 
partitioned in regions relevant to Louisiana coastal 
managers (reproduced from K. De Mutsert et al., 2016). 

B: using the transect extraction tool to define transects 
for extracting time-varying Ecospace values 
(reproduced from the Transect plug-in user guide) 

Figure 7 – Spatial distribution of biomass of groups in the Delta Management model. Year 0 of the model run is 
compared with year 50 in a future without action (FWOA) and a chosen scenario (PR 6). Reproduced with 
permission from De Mutsert et al. (2017a) 

Regions and Transects 

Ecospace can automatically summarize outputs over the whole model area by group and fleet. In 
addition, it is often useful to have information summarized by specific regions within the model 
area, for example when there are separate ecological regions or management units within the 
model domain (Fig. 8A). This is possible by loading a map with these sub-areas indicated in the 
‘Maps’ interface in the specified ‘Regions’ location of the Ecospace interface. Note that a given cell 
can at most belong to one region. The program then summarizes the output by region as well. 

Additionally, Ecospace can automatically extract information from a predefined transect. 
Transects are defined as input data on top of the Ecospace base map and after the runs are 
finished, values of the transects are extracted according to the depth, biomass, catch and MPAs 
intersected along the transect, per time step (Fig. 8B). 
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Datafiles and R/Py 

Adaption 

The chapter is in part adapted, with permission,  from: 
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Cumulative Impacts 

The impact of various anthropogenic activities and other drivers that influence the spatial 
distribution of organisms in the system can be assessed through Ecospace to understand their 
ecosystem-wide effects. Similarly to other impact assessment tools (e.g., Halpern et al., 2007; 
Halpern and Fujita, 2013; Hammar et al., 2020), formulating the representation of impacts 
undergoes a stepwise approach: 

1. identification of a set of potentially impacting activities (e.g., windfarm construction, artificial 
reef placements, aquaculture settings); 

2. translation of each activity into corresponding stressors, for example noise (Harvey, 2018; 
Serpetti et al., 2021), bottom disturbance (Steenbeek et al., 2020) or nutrients release (Piroddi 
et al., 2011); 

3. condensation of the multiple stressors into a ‘cumulative impact’ metric; and 
4. quantification of each stressor effect, or of the cumulative impact metric, on determinate 

species or for the whole ecosystem, in a determinate area. 

In Ecospace, a straightforward approach for including spatially explicit, and time dynamic, 
cumulative impacts is through the HFC model (section 1.5.1). Layers of stressors, at the same spatial 
resolution of the model, are loaded and associated to functional groups through response curves, 
in the same way as environmental drivers such as depth or temperature. 

When multiple stressors occur in an individual cell, the cumulative impact is represented as 
the product of the individual stressors (Christensen et al., 2014). Predator-prey interactions can 
buffer or enhance the effects of stressors: for example, in an area closed to fisheries due to 
another human activity (e.g. a wind farm and aquaculture site), cetaceans could be displaced by 
the negative effect of the stressor “noise”, but attracted due to increasing food availability driven 
by the fishing closure and the locally higher primary productivity (Serpetti et al., 2021). The actual 
emerging net effect is thus dependent on the cumulative effect of multiple stressors on the prey 
and on the predator, as well as on other dynamics (fishing, protection, environmental drivers), 
resulting in complex and in some cases counterintuitive dynamics (Wedding et al., 2022). 

The application of multiple pressures can be particularly important when assessing Marine Spatial 
Planning options and trade-offs, and the effects of de facto MPAs driven by e.g., renewable energy 
installation (e.g., Alexander et al., 2016; Nogues et al., 2022, 2021; Serpetti et al., 2021; Steenbeek et 
al., 2020). Ecospace can provide a support platform that enables tracking the effects of impacts on 
each trophic group and its propagation through the food web: this is a great added value compared 
to other spatially explicit tools for cumulative impact assessment (Depellegrin et al., 2021), which 
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mostly address direct effects of stressors on ecosystem components, and do not consider trophic 
dynamics. 

It is important to note that simulation of impacts through the HFC model has the effect of 
changing habitat suitability, thus the feeding ability, which changes cell suitability. This, in turn, 
increases the chance that groups relocate to nearby areas that are more suitable. Survival is 
affected when groups cannot relocate fast enough to keep up with changing environmental 
conditions. The HFC model is less efficient in capturing direct localized mortality events such 
as harmful algal blooms, hypoxia, temperature extremes, pollution, or mortality associated with 
shipping and other destructive anthropogenic activities. In these cases, a different solution has 
been recently provided through direct influence of natural mortality (Section 6.6). In EwE version 
6.6 mortality response curves can be included to describe the proportion of biomass killed in 
each grid cell as a function of the stressor value in that cell (e.g., contaminant concentration, 
temperature, dissolved oxygen, Vilas et al. 2020), or by knowing the probability of the occasional 
event occurring (e.g., co-occurrence within cetaceans and shipping tracks and the probability of 
a fatal collision, Harvey 2018). However, long-term impacts of e.g., persistent pollutants within the 
organisms might not be well captured by the habitat capacity model if the mortality associated 
with specific concentrations of these pollutants is not incorporated in the model. 

The assessment of the ecosystem effects of cumulative human activities is a challenging scientific 
task. Many studies have considered the impact of fishing activities and a second or even a third 
factor (such as eutrophication, pollution, aquaculture, loss of habitat, climate change, or invasive 
species), mostly using time-dynamic modeling (Ainsworth et al., 2011; Booth and Zeller, 2005; 
Corrales et al., 2018; Guénette et al., 2006; Serpetti et al., 2017). The assessment of cumulative 
impacts using spatial-temporal dynamic modeling is growing but has thus far been limited by the 
original configuration of Ecospace. Recent developments in Ecospace are allowing an exponential 
increase in such applications (see section 6.) 

Adaption 
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Ecoengineer Plug-In 
JEROEN STEENBEEK 

Introduction 

The Ecoengineer plugin is designed for predicting the spatial spread of functional groups in 
benthic ecosystems with at least one autogenic ecosystem engineer: an animal or plant that uses 
its own body to change an environment and affect the access of other species to resources 1. 
Ideally, the engineering species should be hard in structure. In the accompanying publication 
Sadchatheeswaran et al. 2, mussel and barnacle beds, which dominated the intertidal area 
considered, were used. 

The Ecoengineer plugin for Ecospace, the spatial‐temporal modelling routine of Ecopath with 
Ecosim or EwE (Christensen and Walters 2004), is publicly available with EwE version 6.6.5 and 
onward. 

Using Ecoengineer 

Setting up Ecoengineer dynamics in a EwE model thus requires the following: 

• A balanced Ecopath model, with an Ecosim and Ecospace scenario 
• One or more eco‐engineer functional groups present in the ecosystem model 
• Definition of the empirical relationship between ecoengineer biomass and structural 

complexity 
• Definition of an Ecospace environmental driver map that will receive the amount of 

structural complexity 
• Definition of functional responses for all functional groups that are affected by this new 

environmental driver 

Figure 1 outlines how to achieve this in the EwE desktop software. The steps are described in 
detail, below. 
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Figure 1. Outline of Ecoengineer procedure. 

Preparation: Set Up a Temporal‐Spatial Model 

In EwE, create a balanced Ecopath model of the ecosystem that represents the first year of 
biomass time series of ecosystem engineers. Make sure ecosystem engineers are explicitly 
represented by at least one functional group. Run the model for a set number of years in Ecosim, 
with a time series to drive the biomass of functional groups over time. In Sadchatheeswaran et 
al.3 , the time series was run for 35 years (1980 to 2015), and the initial biomasses of the alien 
ecosystem engineer groups started low and were forced at each annual time step, rather than use 
fitted data, as per the recommendations of Langseth et al.4. The biomasses of the native functional 
groups in the time series can be used to fit the model to observed data. The model is then ready 
for Ecospace, the spatial‐temporal modelling routine. 

In Ecospace, open and name a new scenario that should automatically run for the total number 
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of years dictated in Ecosim. In Maps (Ecospace>Input), create a base map that matches the size 
of the study area 5 6. If possible, also create depth (or zonation) and habitat layers on this map to 
drive functional group biomass to preferred areas on the map, based on observational data. 

Step 1: Enable Ecoengineer Dynamics 

The first step to enabling ecosystem engineer dynamics is to define the empirical relationship 
between engineering species biomass and derived structural complexity. We implemented this 
connection through the Ecospace ‘external data connections’ system (Steenbeek 2021), where the 
Ecoengineer plug‐in acts as an intermediate calculator that calculates structural complexity while 
Ecospace executes 7. 

Figure 2 – Define Ecoengineer as an external data connection 

From the menu bar, go to Ecospace > Define External Data Connections. Under Connect 
to external spatial temporal data select the EcoEngineer driver and press Create. This 
new connection should now be present under the Existing connections. 
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Step 2: Set Up Engineer Biomass – Structural Complexity 
Relationship 

The next step is to parameterize the relationship between the ecosystem engineer biomasses and 
the structural complexity (Figure 3). 

Figure 3 – Configure the external data connection between the ecosystem engineer biomasses and the structural 
complexity. 

Make sure the new connection is selected and press Configure. 

192  |  Ecoengineer Plug-In



First, provide your Ecoengineer set‐up with an intuitive name and an optional description. 

In the Complexity calculations tab, choose an ecosystem engineer in the left frame. In the right 
frame, select a predefined function of how structural complexity changes as a function of 
ecosystem engineer biomass (if suitable). Otherwise define formulae based on observational data, 
by entering parameters for a, b and c of y = ax2+bx+c, where y is structural complexity (cm3) and x 
is engineering biomass (g m‐2). Derivation of these calculations is discussed in Sadchatheeswaran 
et al. 8. Repeat for all ecosystem engineers. 

Step 3: Define Ecoengineer as an Environmental Driver Map 

Once empirical relationships between habitat building biomasses and structural complexity are 
defined, Ecospace needs to be informed of how individual functional groups respond to structural 
complexity. First, a new environmental driver map is needed to receive the spatial‐ and temporally 
varying structural complexity to drive structural complexity‐related functional responses. 

Figure 4 – Define environmental input maps. 
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 In the Menu bar, select Ecospace > Define Environmental Driver maps. Add and name a new 
environmental driver. For illustration, in Figure 4, the driver was named ‘alien complexity’. The 
driver will show up under Environmental drivers in the Map window of Ecospace. 

Step 4: Connect Ecoengineer Driver to the Environmental 
Driver Map 

The environmental driver map, defined in Step 3, must receive the ecosystem engineer calculated 
complexity, defined in Steps 1 and 2. This is achieved by connecting the external driver (defined 
in step 2) to the environmental driver (defined in step 3). This will make the alien complexity map 
vary in response to changing habitat‐building biomasses. 

Figure 5 –  External data connection setup. 

In the Navigator window, select Ecospace > Input > External data. In the main window, there will 
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be several input maps; select Environmental drivers. Click on the column marked Slot 1 in the row 
marked alien complexity (for illustration) (Figure 5). 

In the window that pops up, under available connections, select the Ecoengineer driver that you 
created and configured in steps 1 and 2, and click the right arrow button to connect the driver to 
the alien complexity map. Close the window. 

The Ecoengineer driver is applied properly when a green time series line is present in the external 
data window. 

Step 5: Configure Group Capacity Model Settings 

Make sure that Ecospace niche model, the habitat foraging capacity model, knows which 
functional groups must respond to environmental drivers. 

Figure 6 – Enable Ecospace > Input > Habitat based foraging > Use environmental responses for relevant groups. 

 In the Navigation window, choose Ecospace > Input > Habitat based foraging > Group capacity 
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model. Ensure that the option “use environmental responses” is checked for all functional groups 
that are affected by structural complexity (Figure 6). 

Step 6: Create Foraging Responses 

Next, define how individual functional groups are affected by structural complexity. 

Figure 7 – Definition of habitat based foraging response functions. 

 

In Ecospace > Input > Habitat based foraging, create and define foraging responses that can 
be applied to the relevant functional groups in Apply foraging response window. These foraging 
responses dictate how the foraging arena of a functional group will vary in size as a function of 
changing structural complexity in the Ecospace habitat capacity model 9. 
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Step 7: Apply Foraging Responses 

The last step is to make the functional groups sensitive to environmental conditions, as defined in 
Step 5, so that they respond to structural complexity using the functions defined in Step 6. 

Figure 8 –  Definition of habitat based foraging response functions (next step). 

Make sure that sensitive groups are configured to derive foraging capacity from environmental 
drivers in Ecospace>Input>Habitat based foraging>Group capacity model. 

When Ecospace next runs, this environmental driver will be used to help drive functional groups 
around the map, as dictated by the foraging capacity computed by the functional responses to 
ecosystem engineer‐computed structural complexity. 

Make sure that sensitive groups are configured to derive foraging capacity from environmental 
drivers in Ecospace > Input > Habitat based foraging > Group capacity model (Figure 8). 

When Ecospace next runs, this environmental driver will be used to help drive functional groups 
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around the map, as dictated by the foraging capacity computed by the functional responses to 
ecosystem engineer‐computed structural complexity. 
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Biomass Emitter 
JEROEN STEENBEEK AND MARTA COLL 

How Does it Work 

Dedicated models of Marine Protected Areas (MPAs) can only be used to adequately represent 
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the local effects of MPAs, as these models are created at sufficient spatial scales to allow species 
to thrive and disperse within the MPA. Coarser models do not have the cell resolution needed 
to reflect these dynamics, which has been a limiting factor to deciding on spatial scales of EwE 
models. 

The Biomass Emitter is a lightweight plug‐in to the Ecopath with Ecosim food web modelling 
desktop software, intended to incorporate MPA biomass effects into models with insufficient 
spatial resolution to properly calculate the workings of the MPAs. 

The Biomass Emitter’s plug‐in provides two pathways to incorporate fine‐scale dynamics into 
larger models: 

1. from finer‐scaled models where MPAs are explicitly modelled, or 
2. from empirical rules that emulate the workings of the MPAs in absence of detailed MPA 

models. 

We describe each of these options in the following. 

Using Detailed Models 

Figure 1 – The Biomass Emitter plug‐in transfers biomass trends from regions in fine‐scaled models to those 
same regions in coarse‐scaled models. This enables regional models to integrate local predictions. The emitter 
can apply relative biomass trends (as depicted above) or absolute biomass trends. 
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To the transfer biomass effects of local features, obtained from dedicated fine‐scale spatial 
models, the emitter uses time series of biomass effects for selected functional groups (Figure 1). 
These time series capture either relative or absolute change in biomass within the area of an MPA 
as computed by a dedicated MPA model: 

1. Relative biomass trends for use in the Biomass Emitter are calculated as follows, 

where ∆𝐵t is the relative change in biomass within an MPA area at time step t;  is the mean 

biomass of this group within the same MPA area at time step t extracted from an Ecospace where 
the MPA was active; and  is the mean biomass of the same group within the same MPA area at 

time step t extracted where the MPA was not enforcing any fishing limitations. 

2. Absolute biomass trends can be obtained directly from regional average‐saved data. 

The biomass trends needed to parameterize the Biomass Emitter can be calculated from Region 
Averaged CSV files, a data format natively produced by the EwE software, through a utility 
included with the Biomass Emitter plug‐in (see below). Emission files have the following layout: 

group 1 1 1 … 

target 1 2 3 … 

2015‐01 2 

2018‐01 2 

2020‐01 2 

… 

Table 1 ‐ an example of a biomass emission data file 

Each column identifies biomass fluctuations for a single group and target area over time, where 
the target area can identify either a region number or the sequential index of an MPA in the coarse 
scale model where the data is applied. Time is entered in absolute terms as ‘year‐month’, and 
similar to Ecosim time series, emission values are allowed to be missing. When Ecospace runs, 
for every time step that a biomass emission value is defined, biomasses of the target group in all 
cells that fall within the target area will be multiplied by (relative), set to (absolute) or increased by 
(additive) the emission value. 
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Using Emission Rules 

When local MPA models are not available, and biomass trends thus cannot be obtained from 
localscale dedicated MPA models, the Biomass Emitter offers the ability to include biomass effects 
of the fine‐scaled MPAs as follows: 

where ∆𝐵 is the relative change in pool biomass at time step t; m is the maximum biomass effect 
that the MPA can achieve based on the MPA protection category as defined by e Costa et al. 1; n 
is the cluster size (e.g., the number of connected target cells) of the target MPA. The cluster size 
correction dampens the emission effect when the MPA cluster increases in size, accounting for 
the fact that Ecospace requires at least 9 cells to mathematically represent the workings of an 
MPA. The max cluster size assumption is rather crude, and may need refining in the future. The 
maximum biomass effect m defaults to 5% biomass increase for fully protected areas, 3% biomass 
increase for highly protected areas, and 1% biomass increase for moderately protected areas, per 
month. Values of m can be customized. 

Using the Biomass Emitter 

Settings Page 

Once the Biomass Emitter plug‐in is installed, it can be launched from Navigator > Ecospace > 
Input > Biomass emitters. This brings up main settings page of the plug‐in (Figure 2): 

202  |  Biomass Emitter



Figure 2 –  Biomass Emitter’s main settings interface. 

The settings page is where the biomass emitter is enabled or disabled, where to check for possible 
conflicts, and where one can enter custom values of m (2) for different categories of protection. 
Custom values of m are stored with the system‐wide settings for EwE. 

Using Emission Time Series 

This emission time series configuration page shows all controls for loading (open folder symbol), 
unloading (Reset), and generating (magic wand) model‐derived biomass emission time series 
(Figure 3). Loaded biomass emission time series can be applied to target Ecospace Regions, MPA 
or Habitats, and can be applied as relative (e.g., multiplied onto per‐cell biomasses), absolute (e.g., 
overwriting per‐cell biomasses) or additional (e.g., adding to per‐cell biomasses). 
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Figure 3 – Emission time series configuration page 

For all loaded time series, the interface shows whether target group and area index are valid 
for the currently loaded Ecospace scenario, how many emission values fall within the current 
Ecospace run, and which emission time series are enabled. Emission time series data points are 
matched by absolute dates. Biomass emissions can be applied per time step, presuming that the 
Ecospace time step size is left at monthly defaults. 

The buttons labelled None, All, and Fished are used to quickly enable or disable emission time 
series. Note that the fished option functions differently depending on the type of area the time 
series emissions will be applied to. When applying time series to regions or habitats, the fished 
option will enable all emission time series for fished groups. 

• When applying emission time series to MPAs, the fished option will enable only those time 
series that apply to groups that are fished by at least one fleet that is restricted by the 
indicated MPA. 
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• When applying time series to habitats, the emission amount is scaled to the habitat cell area 
coverage [0,1]. 

Using Emission Rules 

The emission rules page requires users to specify, for each MPA in the loaded Ecospace scenario, 
the level of enforcement and whether a biomass emission rule needs to be applied to that MPA 
(Figure 4). The assigned enforcement level effectively selects one of the pre‐defined m values for 
use in equation 2. Just like time series‐based emissions, emission rules are applied at every time 
step. 

Figure 4 – Rule‐based emission configuration page. 

Note that rule‐based emissions are applied to MPA cells only, and within each MPA, only to those 
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species that are being caught or discarded by fleets prohibited from fishing at the specific time 
step. 

Generating Biomass Emission Time Series CSV Files 

Biomass emission time series CSV files can be created by hand, or can be generated from regional 
average CSV files that Ecospace can auto‐save on demand with a utility provided with the Biomass 

Emitter plug‐in according to the following workflow: 

1. In EwE, load the model for the dedicated MPA, load Ecospace, and enable auto‐saving of 
Region Averaged CSV files; 

2. Define regions for every MPA in the Ecospace model (Menu > Ecospace > Define Regions); 
3. Run Ecospace with protection measures ENABLED (e.g., all relevant MPAs are configured to 

enforce some kind of protection scheme onto at least one fleet in the model for at least one 
month of the year); 

4. If you wish to generate Relative Biomass Emission time series, continue with step 5. If you 
wish to generate Absolute Biomass Emission time series, skip to step 8; 

5. Change the Region Averages folder name so that it starts or ends with “after” (e.g., 
Subregional_01667dd_region_averages_after); 

6. Disable all MPAs, and run Ecospace with protection measures DISABLED; 
7. Change the Region Averages folder name so that it starts or ends with “before” (e.g., 

Subregional_01667dd_region_averages_before); 
8. In EwE, load the model where emissions need to be sent to. Load Ecospace, and launch the 

Biomass Emitter Time Series Builder (either by clicking in the Biomass Emitter plug‐in 
settings page, or by selecting EwE > Menu > Tools > Biomass Emitter Time Series Builder). 
This brings up a form as shown in Figure 5; 
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Figure 5 ‐ Biomass Emitters time series builder interface for 
generating relative (left or top) or absolute (right or bottom) 
time series. 

9. Drop the single region averages folder for creating Absolute Biomass Emission time series, or 
both the “before” and “after” folders for creating Relative Biomass Emission time series, onto 
the target area in the time series builder utility; 

10. Select which target area the emissions need to be sent to. This can be either a region 
number or the sequential number of an MPA; 

11. Select an output folder and file name, and click Save. 

When dropping the folders with region averaged CSV files, the time series builder performs a 
number of checks: 

• Only monthly averaged biomass files for specific regions are processed (e.g., files with names 
such as “Ecospace_Average_Region_*_Biomass.csv”. Files for annual averages, files not 
specific to a region, and non‐biomass averages are ignored; 

• Group names from the fine MPA model (as written into the column headers in the region 
average biomass CSV files) are resolved to groups with the same name in the coarser model 
for which the emission time series are being created. Group name checks are not case 
sensitive, but spelling must be identical; 

Biomass Emitter  |  207



• For relative time series, both before and after folders are checked if they contain averages for 
the same regions. Only then can relative time series be computed. 

Figure 6 shows the biomass emitter time series builder, ready to generate relative biomass 
emission time series, where source regions are mapped to desired target emission regions. 

Figure 6 – Biomass emitter time series builder interface, ready to create a relative time series file where 
source data from region 1 in the original MPA model will be mapped to region or mpa 7 in the target model, 
and data from region 2 to target region 8. 
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Note that the EwE status panel shows a history of generated emission time series files. 

Also note that when the biomass emitter time series builder is launched from the EwE menu, it will 
act as a stand‐alone utility used for generating any number of emission time series files for a EwE 
model in general. When launched from the biomass emitter plug‐in, the time series builder will 
launch to deliver one specific emission file that can be directly integrated into the emitter plug‐in. 

References 

The biomass emitter was built under 2015‐2019 DG Mare funded project SafeNet: Sustainable 
fisheries in EU Mediterranean waters through network of Marine Protected Areas. 
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Spatial Optimizations (Edit) 

EwE6 incorporates two routines for optimum placement of marine protected areas (MPAs) so as 
to maximize a user-defined objective function. This routine is implemented at Ecospace > Tools > 
Spatial optimizations. In order to use this routine you must have defined both an Ecosim scenario 
and an Ecospace scenario, and have verified the behaviour of your model. 

An early version of an Ecospace routine for spatial optimization was developed as part of a thesis 
project at UBC 12. That approach was subsequently expanded and incorporated in EwE along 
with an  additional spatial optimization module, which uses the same objectivity function as the 
updated seed cell, but where the spatial cell selection process is influenced by spatial reference 
layers, typically of conservation interest. 

Two alternative approaches to running the routine have been developed: (i) ‘Seed cell’ selection, 
based on the original approach of Beattie (2001) and Beattie et al. (2002); and (ii) ‘Conservation 
feature’ sampling, an approach, which allows the user to incorporate other forms of spatial 
information in the selection of protected areas. 

All methods for evaluating efficacy of MPAs are crucially dependant on dispersal rates. 

Seed Cell Selection Procedure (‘Seed Cell’ Method) 

This optimization method (user selects ‘Seed cell’ method) is based on a previous study (Beattie 
2001; Beattie et al. 2002), in which we use a very simple optimization scheme to evaluate the 
trade-off between proportion of area protected and the value of the objective function. We have 
modified the previous approach by securing a better program flow, and by changing the objective 
function from considering only profit from fishing and existence value of biomass groups to a 
more detailed objective function described in the EwE textbook chapter on Spatial optimization. 

The procedure takes as its starting point the designation of one, more, or all spatial cells as ‘seed 
cells’, i.e. cells that are to be considered as potential protected cells in the next program iteration. 
The procedure will then run the Ecospace model repeatedly between two time steps, closing one 
of the seeds cells in each run, while storing the ecosystem objective function value. The seed 
cell that results in the highest objective function value is then closed for fishing, and its four 
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neighbouring cells (above, below, left, right) are then turned into seed cells, unless they are so 
already, or already are protected, or are land cells. This procedure will continue until all cells are 
protected. Finally, the routine will return the set of cells to be protected that would maximize the 
objective function. 

The time over which the selection procedure is run is dependent on the application. Typically, an 
ecosystem model is initially developed and tuned using time series data to cover a certain time 
period, e.g., from 1950 to 2005. Subsequently, the model is used in a scenario development mode 
to evaluate, for instance, protected area placement covering the period 2006-2020. 

The major result from the seed cell selection procedure is an evaluation of the trade-off between 
size of protected area, and each of the objectives in the objective function. This can, for instance, 
be used to consider what proportion of the total area to close in subsequent, more detailed 
analysis based on conservation feature layer sampling (see next section). 

Conservation Feature Sampling 

An advantage of the seed cell modelling approach described above is that it allows a 
comprehensive overview of the trade-off between proportion of area closed to fishing, and the 
ecological, social, and economical benefit and costs of the closures. This is done, based on the 
information already included in the EwE modelling approach, with no new information being 
needed. While this may be an advantage from one perspective, it does not allow use of other form 
for information, notably in form of spatial information, e.g., critical fish habitat layers from GIS. 

To address this shortcoming, there is a conservation feature layer optimization routine in 
Ecospace. This approach uses spatial layers of conservation interest to set likelihoods for spatial 
cells being considered for protection. The optimizations are performed using a Monte Carlo 
approach where the conservation feature layers are used for the initial cell selection in each MC 
realization. The Ecospace model is then run, the objective function is evaluated, and the results, 
including which cells were protected, are stored for each run. 

It is important to note that the conservation feature layers are not used to evaluate the objective 
function. The information in these layers is used only to influence initial cell selection. 

The conservation feature layers are defined as raster layers, with dimensions similar to the base 
map layers in the underlying Ecospace model, i.e. they are rectangular cells in a grid with a certain 
number of rows and columns. Each cell in a given layer has a certain importance for conservation, 
expressed, e.g., as the probability of occurrence of an endangered species. For each conservation 
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feature layer l, we initially scale the importance layer values to sum to unity, and then calculate an 
overall cell weighting wc for each cell C from 

where wl are the conservation feature layer weightings, and the Cc,l cell-specific, scaled 
conservation feature layer values. 

Similar to the seed cell selection procedure, we typically develop and tune the model to an initial 
time period, and then use the sampling procedure to evaluate scenarios for protected areas for a 
subsequent time period. 

Ecospace can import raster files with spatial information such as conservation feature layers or 
other Ecospace base map layers. The reading is possible from comma separated text files (.csv), 
ESRI ASCII files (.asc), and ESRI shape files (.shp). The files need to have layers or columns with row 
and column numbers matching the Ecospace model (see below for details). 

Further information can be found in the EwE textbook Spatial optimization chapter, and it is 
strongly recommended you read that chapter before running analysis with the approach. 

Implementing Spatial Optimizations in Ecospace 

The Spatial optimizations form is divided into two sections. Inputs are entered in the top half of 
the form in the Configuration and Map Input tabs. Results are displayed on the bottom half of the 
form on the Progress and Results tabs. 
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Figure 1 – The Spatial optimizations form, Configuration tab. 

Configuration Tab 

Users can choose between two methods of implementing the spatial optimisation routine: Seed 
cell or Importance layer (see _Ref493389844above). Before proceeding with the optimization 
routine, users should first select one of these two options in the Search box on the Parameters 
panel of the form (Figure 11.3). Selection of one of these methods will determine the inputs 
required. 

In both cases, users must set the Start year and End year for the optimization search. If Start year 
is set to 1, the routine will start running Ecospace and evaluating the objective function from the 
first year of simulations. However, in many cases, users will wish to run Ecospace for a period of 
time, perhaps to allow the model to fit historic trends, before optimization begins. It is generally 
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not a good idea to start the optimizations at year 1, as Ecospace as a rule needs to react to initial in-
balance in how groups are distributed spatially. If for instance a predator has little spatial overlap 
with its main prey in an Ecospace scenario, then the biomass of the predator will likely fall initially, 
even under constant fishing pressure, and the prey increase. 

To proceed, set Start year to the first year that the objective function is to be evaluated, e.g., 
if Start year is set to five, Ecospace will run for four years and then start the search routine 
in year five. Set End year to the year in which the search routine is to stop. The appropriate 
length of time over which to run the optimization routine will depend on the time horizon of 
the particular management question and the life span of the species affected by the MPA. When 
running, Ecospace will only run up to the Start year once, 

save all information in memory, then run iteratively from Start year to End year, jump back to Start 
year, and so on. 

In both cases, users can also select an MPA previously defined on the Ecospace Basemap (see also 
Define Ecospace habitats). The cells bordering the MPA will then also be used as seed cells and the 
selected MPA may be modified during the search. Any other MPAs will be unaffected by the search. 

Additionally, if Importance layer is selected, the user defines the minimum and maximum area 
(Min area % and Max area %, with step size Step %, all expressed as percentage of water cells, i.e. 
ignoring land cells) to be set aside as MPA. The percentage area to be protected can be set to a 
fixed value by setting Min area % and Max area % to the same value. Users also set the number of 
Iterations that will be implemented in the Monte Carlo search routine (see above). 

The search routine is initialized using the Run button. It can be stopped using the Stop button. 

NOTE: If you initialize a search then stop the search, you cannot restart it or change input 
parameter values. You must use the New Search button to start a new search. 

Objectives 

The objective function used in the routine is analogous to that used in Ecosim’s Policy optimization 
routine. It is strongly recommended you read Spatial optimization procedures for detailed 
description of the objective function. 

Use the Objectives table (Figure 11.3) to define objective function weights for Net economic value 
(total landed value of catch minus total operating cost); Social value (employment), i.e., a social 
indicator, assumed proportional to gross landed value of catch for each fleet with a different 
jobs/landed value ratio for each fleet; and two ecological objectives: 1. Mandated rebuilding of 
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one group (value of the objective function is measured by departures of biomasses over time 
from target biomass levels specified by entering ratios of target to Ecopath base biomasses); 
and 2. Ecosystem structure, which favours biomasses of large, long-lived organisms. See Policy 
objectives in Fishing policy search and Christensen and Walters (2004b) for more details about 
these objectives. 

Use Boundary weight to adjust the weight given to size/border ratio of the protected area in the 
objective function. This is estimated as protected area size over the total boundary length, and 
captures spatial connectivity of protected areas. 

Note that you may initially need to play with different values for the objective function weight for 
each factor to find ranges that produce contrast in the final value of the objective function. 

You may also need to set extra parameters for these using the two tabs on the Configuration 
panel. Use the Fleet table to set the number of jobs relative to the catch value. The default is 
1 for each fleet, implying that if the catch doubled, the number of jobs would also double. For 
economic objectives, you may wish to adjust the Discount rate and Generational discount rate. 
The discount rate is the annual rate (entered in %) applied to discount the present value of 
future catches relative to present base value. See Ainsworth and Sumaila (2005) for description of 
intergenerational discounting. 

The Group table has two columns: 

Mandated rel. biomass 

Use this column to set a threshold biomass (relative to the biomass in Ecopath) for the species or 
group of interest. 

Structure rel. weight 

When Ecosystem structure is included in the objective function, the search routine favours larger 
biomasses of long-lived organisms, indicated by B/P (i.e., P/B-1). These values are listed in the 
Structure rel. weight column and can be changed if users wish to place more or less weight on 
some groups than indicated by their B/P or if the user wishes to optimize for something other 
than B/P under the ecological objective. 

Map Input tab 

The Map Input tab displays the Ecospace basemap associated with the Ecospace scenario that has 
been loaded. It displays progress of the search and the final results of the analysis. 

Spatial Optimizations (Edit)  |  215



Figure 11.4b –  The Spatial optimizations form, Map Input tab. 

Layers 

The Layers panel is also found on the Map Input tab. Available options will change, depending on 
whether the Seed cell or Importance layer search is selected. Note that the Layers panel has a root 
directory format, which can be collapsed or expanded using the plus and minus icons. Use the eye 
symbols 

to show [  ] or hide [  ] layers on the Map. 
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Seed Cell 

When Seed cell has been selected on the Configuration tab, use the Layers panel (see image below) 
to set seed cells. 

You cannot set Best cells or Current cells, as these are output results, but you can edit their 
appearance (i.e., colour) by clicking once on the symbol (coloured circles in the image below). This 
will open a dialogue box (the Edit layer dialogue box, see image below) where the colour of the 
symbol can be set. You can also change the appearance of Seed cells in this way. Once you have 
set the appearance of seed cells, click OK to close the dialogue box. 

Click to the left of the Seed cells eye symbol to pick up the pen tool [  ]. You can now click on the 
Map to select cell(s) to be used as seed cells. These will be indicated by a coloured circle (blue in 
this example). Note that you can use the Seed button at the top of the panel (see image below) to 
Clear all seed cells or Set all cells as seed cells. 

Note also that if you now click on the Seed cells symbol (blue circle in the image below) the 
Edit layer dialogue box will now display the location of the seed cell(s) in the Description and 
Appearance tab. The Data tab of the Edit layer dialogue box displays the map as a spreadsheet of 
numbered cells corresponding to the cells on the map. Seed cells are indicated by 1 and all other 
cells are indicated by 0. Note that 1s and 0s relate only to the layer currently being edited. These 
data can be exported to a csv file using the Export 

… button on the Data tab. 

Habitats, MPAs and Land can also be modified using the Layers panel. Again, use the eye icon [ 
 ] to 

show or hide layers. Use the pen tool [] to modify location of these layers on the Map. Note that 
you can use the MPA button at the top of the panel (see image below) to Clear all MPAs or Set all 
cells as MPAs. 
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The Layers panel on the Map Input tab (Seed cell configuration). 
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The Edit layer dialogue box. 

Importance layer 

When Importance layer has been selected on the Configuration tab, the Layers panel (see image 
below) is used to set Importance layers (users do not set seed cells). Note that importance layers 
are not used in calculation of the objective function, but rather are used to give greater importance 
to certain cells during random selection of seed cells. There are a number of ways to read in 
data for setting or importing importance layers. See Setting importance layers for full details on 
importing data importance layers. See Spatial optimization procedures for more on Importance 
layers. 

After you have imported the importance layers, they will be displayed in the Layers panel. 
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The Layers panel on the Map Input tab (Importance layer configuration). 

Output 

Progress Tab 

As the search algorithm proceeds, progress is displayed on the Progress tab of the Output window 
(image below). On the left of the Progress tab, relative values of the components of the objective 
function are displayed. On the right, relative values of the components of the objective function 
are shown as a function of number of cells closed. 

220  |  Spatial Optimizations (Edit)



Results Tab 

When the algorithm has finished, results are shown on the Results tab. Results are displayed 
graphically, as on the progress tab, as relative values of the components of the objective function, 
and are displayed as a function of the number of cells closed. Results are also shown in tabular 
form at the right of the Results panel and as MPAs on the Map Input panel. 

Results can be filtered in three ways. 

• You can hover with the mouse over the final results graph to display results at that location 
on the graph (vertical orange line below). Results at this location are displayed in tabular 
form on the right of the panel. 
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• You can also use the Area closed (%) window, above the graph, to select results to display. 
• You can also use the Best (%) window on the Results tab to filter which results are displayed 

on the map (e.g., if 10% is selected, only results that produced the top 10% of objective 
function values will be displayed). 

Final filtered results can be saved to csv file using the Save… button. The final filtered results 
can be converted to MPAs on the base map using the Convert to MPA button. This will result in 
MPAs with the highest count in the selected Best (%) being placed on the Basemap for the current 
Ecospace scenario. 

Original MPAs can be reset using the Reset MPAs button. 
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Setting Importance Layers 

When Importance layer has been selected on the Spatial optimizations form, the Layers panel on 
the Map Input tab is used to set Importance layers. Importance layers are used to give greater 
importance to certain cells during the random selection of seed cells as part of the Spatial 
optimization procedure. 

NOTE: Values in importance layers have no effect on calculation of the objective function (see 
Spatial optimizations procedures). There are a number of ways to read in data for setting 
importance layers, listed here. 

Reading in Importance Layers 

• To read in importance layers, make sure you have first, loaded an Ecosim and Ecospace 
scenario, and opened the Spatial optimizations form. After setting input parameters and 
selecting Search type: Importance layer on the Configuration tab, go to the Map Input tab. 
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The Layers panel on the Map Input tab of the Spatial optimizations form (Importance layer 

configuration). 

• In the Layers panel, double click on the layer for which you want to import data (highlighted 
in the image above). This will open the Edit layer dialogue box. You can use this dialogue box 
to edit the description and appearance (i.e., display colour) of the importance layer. 

IMPORTANT NOTE: You must also assign the layer a Weight on the Description and Appearance 
tab (see image below). Importance values are normalised within each importance layer. Therefore 
the Weight assigns relative importance of layers relative to one another. 
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The Edit layer dialogue box (Description and Appearance tab), before data entry. 

• Next, click on the Data tab (image below). The tab contains a spreadsheet with exactly the 
same row and column configuration as the Ecospace Base map. Numbers entered into the 
cells on the Data tab represent relative importance weights for each cell within the layer. 
Note that the routine will normalise all values on the sheet, so only relative values are 
required (i.e., units are unimportant). 

NOTE: There are two methods to enter data into the Data tab. 

In the first method, copy and paste cells directly from a spreadsheet into the cells on the Data 
tab. Note that the data must be in exactly the same configuration as the cells in the base map. 
Assign greater importance to the cells of conservation interest (e.g., marine mammal breeding 
habitat; fish nursery areas; known habitat of rare species). Assign zero importance to cells of no 
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conservation interest and land cells. After entering data this way, close the dialogue box and return 
to the Spatial optimizations form. 

In the second method, Ecospace can read in raster files with spatial information such as 
importance layers or other Ecospace base map layers. It is possible to read from comma separated 
text files (.csv), ESRI ASCII files (.asc), and ESRI shape files (.shp). 

To use this method, first click on the Import … button on the Data tab. This will open the Import 
layer data dialogue box. Proceed to Step 4 below. 

The Edit layer dialogue box (Data tab), before data entry. 

• Click on the Open icon [ ] on the Import layer data dialogue box (image below) and 
navigate to the location of the data file. 

NOTE: at the bottom right of the Open dialogue box, there is a pull-down menu labelled Comma 
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separated text file (see bottom image below). Use this pull-down menu to select the type of file 
(.csv, .asc, .shp) you will be importing. Click Open to open the file you wish to import. 

IMPORTANT: To correctly import shape files, files must have row and column attributes identified 
and must have the same dimensions as the base map. 

Use Cell row identifier and Cell column identifier to select the attributes of the rows and columns 
in the shape file. Note that shape files may have several layers (e.g., see image below). These will be 
displayed in the Mappings panel of the dialogue box. 

Select OK to close the Import layer data dialogue box. Select OK again to close the Edit layer 
dialogue box. Imported layer(s) will now be visible on the Layer panel of the Map Input tab. 

Click here to return to the Spatial optimizations documentation. 

The Import layer data dialogue box. 
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The Open dialogue box. Note the Comma separated text file pull-down menu at the bottom right. 

Notes 

1. Beattie, A., 2001. A new model for evaluating the optimal size, placement, and configuration of marine 
protected areas. M.Sc. University of British Columbia, Vancouver. 

2. Beattie, A., Sumaila, U.R., Christensen, V., Pauly, D., 2002. A model for the bioeconomic evaluation of 
marine protected area size and placement in the North Sea. Natural Resource Modeling 15, 413–437. 
https://doi.org/10.1111/j.1939-7445.2002.tb00096.x 
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Ecological indicators: EcoIND 

Ecological indicators are useful tools to analyze and communicate changes in ecosystems and for 
evaluating environmental status (Coll and Steenbeek, 2017). The ECOIND plug-in added to the EwE 
modeling approach, is applicable to Ecopath, Ecosim and Ecospace models. ECOIND calculates 
a series of widely-used ecological indicators in a standardized way, including biomass-based, 
catch-based, trophic-based, size-based and species-based indicators. The plug-in includes a new 
taxonomy input database and species traits, where each functional group can be broken down into 
its composing species, and species traits can be added to characterize each species (Table 2). 

ECOIND broadens the EwE modeling approach into biodiversity and conservation-based 
frameworks to contribute to integrated ecosystem analyses, also in a spatial-temporal mode 
(Table 3). ECOIND also adds the ability to analyze input uncertainty on output results, from 
Ecopath, Ecosim and Ecospace, by linking the indicators’ plug-in with the Monte Carlo routine 
(see section 3 below). This plug-in can be easily modified to add new indicators and species traits 
to the computations, which can be used to provide indicators dedicated to specific management 
contexts, such as the Marine Strategy Framework Direction (MSFD) of the EU (Piroddi et al., 2015). 

Indicator Description Units a.1978 b.2010 b/a 

Total C Total Catch (C) (a) t·km-2·year-1 3.97 2.52 0.63 

Fish C Catch (C) of all fish species (a) t·km-2·year-1 3.75 1.92 0.51 

Invertebrate C Catch (C) of all invertebrate species (a) t·km-2·year-1 0.23 0.59 2.63 

Invertebrates / 
Fish C Catch (C) of invertebrates over fish (a) 0.06 0.31 5.12 

Demersal C Catch (C) of demersal species (a) t·km-2·year-1 0.23 0.59 2.63 

Pelagic C Catch (C) of pelagic species (a) t·km-2·year-1 3.95 2.21 0.56 

Demersal / 
pelagic C 

Catch (C) of demersal over pelagic species 
(a) 0.06 0.27 4.71 

Predatory C Catch (C) of predatory organisms with 
trophic level ≥ 4 (i) t·km-2·year-1 0.11 0.16 1.42 

Discards Total discarded catch (i) t·km-2·year-1 0.28 0.27 0.96 

Table 3 B. Biomass based: Ecological indicators included in ECOIND plug-in where a. are present 
values of the Mediterranean food web model in 1978 and b. in 2010, and b/a is the ratio of values from 
2010 in relation to 1978 (modified with permission from Coll and Steenbeek, 2017) 
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Indicator Description Units a.1978 b.2010 b/a 

TL catch Tropic level (TL) of the catch (i) 3.07 3.12 1.02 

MTI Marine trophic index, trophic level (TL) of the catch 
(including organisms with TL ≥ 3.25) (i) 3.78 3.91 1.03 

TL co. Trophic level (TL) of the community (including all 
organisms) (i) 1.44 1.39 0.97 

TL co. 2 Trophic level (TL) of the community (including organisms 
with TL ≥ 2) (i) 2.42 2.40 0.99 

TL co. 
3.25 

Trophic level (TL) of the community (including organisms 
with TL ≥ 3.25) (i) 3.69 3.91 1.06 

TL co. 4 Trophic level (TL) of the community (including organisms 
with TL ≥ 4) (i) 4.12 4.11 1.00 

Table 3 C. Trophic-based: Ecological indicators included in ECOIND plug-in where a. are present 
values of the Mediterranean food web model in 1978 and b. in 2010, and b/a is the ratio of values from 
2010 in relation to 1978 (modified with permission from Coll and Steenbeek, 2017) 

Indicator Description Units a.1978 b.2010 b/a 

ML of fish co. Mean length (ML) of fish in the community (a) cm 16.74 17.66 1.06 

ML of fish C Mean length (ML) of fish in the catch (C) (a) cm 12.09 15.85 1.31 

MW of fish co. Mean weight (MW) of the fish in the community (a) kg 170.99 164.19 0.96 

MW of fish C Mean weight (MW) of fish in the catch (C) (a) kg 89.11 158.30 1.78 

MLS of fish co. Mean life span (MLS) of fish in the community (a) year 4.47 4.61 1.03 

MLS of fish C Mean life span (MLS) of fish the catch (C) (a) year 3.34 4.52 1.35 

Table 3 D. Size-based: Ecological indicators included in ECOIND plug-in where a. are present values of 
the Mediterranean food web model in 1978 and b. in 2010, and b/a is the ratio of values from 2010 in 
relation to 1978 (modified with permission from Coll and Steenbeek, 2017) 
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Indicator Description Units a.1978 b.2010 b/a 

Intrinsic Vul. 
Index 

Intrinsic Vulnerability Index of the catch 
(a) 49.29 47.97 0.97 

Endemics B Biomass (B) of endemic species in the 
community (a) t·km-2 1.E-04 2.E-04 1.73 

Endemics C Endemic species in the catch (C) (a) t·km-2·year-1 2.E-08 6.E-07 33.07 

IUCN species B Biomass (B) of IUCN-endangered species 
in the community (a) t·km-2 1.07 0.72 0.67 

IUCN species C IUCN-endangered species in the catch 
(C) (a) t·km-2·year-1 0.09 0.14 1.61 

Mammals, birds & 
reptiles B 

Biomass (B) of marine mammals, seabirds 
and reptiles (a) t·km-2 0.42 0.29 0.71 

Mammals, birds & 
reptiles C 

Catch (C) of marine mammals, seabirds 
and reptiles (a) t·km-2·year-1 0.42 0.29 0.70 

Table 3 E. Species based: Ecological indicators included in ECOIND plug-in where a. are present values 
of the Mediterranean food web model in 1978 and b. in 2010, and b/a is the ratio of values from 2010 in 
relation to 1978 (modified with permission from Coll and Steenbeek, 2017) 

Adaption 

The chapter is adapted, with permission, from: 

De Mutsert K, Marta Coll, Jeroen Steenbeek, Cameron Ainsworth, Joe Buszowski, David Chagaris, 
Villy Christensen, Sheila J.J. Heymans, Kristy A. Lewis, Simone Libralato, Greig Oldford, Chiara 
Piroddi, Giovanni Romagnoni, Natalia Serpetti, Michael Spence, Carl Walters. 2023. Advances 
in spatial-temporal coastal and marine ecosystem modeling using Ecopath with Ecosim and 
Ecospace. Treatise on Estuarine and Coastal Science, 2nd Edition. Elsevier. 

 
1 https://www.un.org/bbnj/content/background 
2 https://iaac-aeic.gc.ca/050/evaluations/proj/80054 
3 https://ditto-oceandecade.org/ 
4 https://marine.copernicus.eu/news/ocean-and-its-digital-twin-whats-copernicus-marine 
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Geospatial Considerations 

Configuring Ecospace requires making choices and trade-offs to best address the research 
questions at hand. One will have to decide on grid cell size, the factors that drive the spatial 
distribution of ecosystem components, how to implement fisheries measures and fishing effort 
allocation, whether currents and migratory patterns are important for the question asked by the 
model, etc. These decisions are guided by functional group and fishing fleet structure, but are 
often limited by the resolution and quality of available spatial (and temporal) data. Here we provide 
some general guidelines to making these decisions. 

The choice of the spatial domain to set the Ecospace basemap is the first step in the configuration 
of the model. As a rule of thumb, it should correspond to the domain used for the 
parameterizations of the Ecopath and the Ecosim models. 

The choice of grid cell size is more challenging. Ecospace operates on a uniform raster grid 
of cells, where cell size directly determines the number of rows and columns that Ecospace 
will compute over. Higher number of cells generally mean more detail in model output but also 
increased demands in computational time and required memory, and do not necessarily provide 
better predictions. In general, the choice of cell size should be fine enough to answer research 
questions – but not finer. Other questions that need to be answered include: How do species 
relevant for the research questions utilize space, and what features affect their distributions? Are 
the ecological mechanisms that you want to address relevant considering the spatial extent of 
the modeled area? Are focal groups moving fast or slow? What are the spatial extents of fisheries 
management options? Are currents and/or migration patterns important? Do you have data of 
sufficient spatial detail to parameterize your Ecospace model? The answers to these kinds of 
questions may yield a range of sensible cell sizes. As an indication, most Ecospace maps fall within 
the 25×25 to 100×100 cell range (though an Ecospace map does not have to be square). A pragmatic 
approach is to use three sets of resolutions for Ecospace: one at the cell size that makes the most 
sense to the user, one set twice as coarse for rapidly building and testing the Ecospace scenario, 
and one set with cells that are twice as fine as the optimal cell size to assess whether a finer spatial 
scale significantly increases model predictive power. The coarse resolution offers quick runtime 
advantages and may help support some treatment of uncertainty. When satisfied, duplicate the 
entire Ecospace model, supply it with the intermediate resolution maps, and fine-tune as needed. 
This step is then repeated with the highest resolution maps to validate if this further improves the 
model. 

Geospatial projection may be another consideration. If not instructed otherwise, Ecospace 
assumes that its grid is expressed using a World Geodetic System projection (WGS). Ecospace 
assumes that the Ecospace cell size is expressed in decimal degrees, and translates this to cell 
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length in km at latitude, thus accounting for cell width tapering with latitude. Ecospace uses 
these cell lengths to translate species dispersal rates to actual movement (see Movement section, 
here below). If this default behaviour is undesired, for instance, when modeling an area using 
a local map projection where cell tapering is negligible (e.g., at lower latitudes) or when the 
coordinate system is expressed in meters, one can set Ecospace to Assume square cells, which 
makes Ecospace treat its grid as a uniform grid without cell tapering and where the user is 
responsible for entering the cell length (in km) to correctly drive species movement. 

Accounting for Effects of Latitude in Ecospace Models 

Ecospace models are typically developed for grids of latitude-longitude spatial cells, with 
biomasses represented as densities (e.g., t km-2) within each cell. But for models of high latitude 
grids or grids that span a wide range of latitudes, cell widths over which biomass densities are 
predicted can vary considerably. 

Thus, for cell i,j where i is map row (latitude) position and j is longitude position, relative width 
(width/height, Wi) across the top of the cell varies with map row i as: 

where Lati is latitude in degrees at the cell top; thus Cos(Lati) varies from 1.0 at the equator to 
about 0.7 at 45 degrees north or south latitude to 0 at the poles. The Ecospace cell tapering logic 
assumes that the Ecospace map is projected to the World Geodetic System (WGS 1984) coordinate 
system with latitude and longitude are expressed in decimal degrees. 

Variation in Wi requires three corrections in Ecospace calculations: 

• dispersal rates across north-south cell faces need to be multiplied by Wi to account for 
differences in the odds of randomly moving creatures crossing those faces as opposed to 
east-west faces; 

• fishing effort Ei,j allocated to each spatial cell using gravity models needs to be proportional 
to Wi, while fishing mortality rates need to vary with effort density (effort/Wi); and 

• catch and discards from each cell need to be set to the model predicted catch per area times 
Wi. 

The first and third of these corrections are trivial to implement (simply scale mixing rates m 
by Wi for north-south cell faces, multiply catches and discards Ci,j by Wi). The effort allocation 
and effort density calculations require a bit more care. 

For Ecospace fishing mortality rate calculations, fishing mortality rate needs to be set proportional 
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to the effective effort density per unit area Ei,j predicted for each spatial cell. At each time step, 
we make that prediction by assuming a total fishing effort Et for the step, then allocating that 
total over the cells using a logit choice or gravity model with the attractiveness of each cell being 
proportional to the profitability (revenue/cost per unit effort) of fishing in that cell, pi,j. The total 
effort for each cell also needs to be adjusted for relative cell area as measured by Wi. That is, the 
total effort ETi,j that is allocated to each cell should be calculated as, 

But the effort density Ei,j per unit area varies as Ei,j=ETi,jWi, implying that the gravity prediction 
of effort density should be, 

Using this model, two cells with equal profitability will be allocated the same effort density 
(calculated with the same denominator in the last equation, but the cell with larger Wi will then 
give higher total catch when catch per area is multiplied by Wi (correction factor 3 above). 

Note that application of (3) requires care in setting the total effort Et so as to make total fishing 
mortality rates over the spatial grid have the same averages as assumed in the Ecopath/Ecosim 
model setup. In past Ecospace versions, we have not been careful in setting Et, assuming it to 
be ngEcosim where ng is the number of water spatial cells fished by gear g. This calculation of 
Et needs to be modified (Ecospace routine SetEffortParameters) by summing total effort over Wi 
times base effort per cell, so as not to generate total efforts that are unrealistically high. This 
is implemented via a Total efficiency multiplier for each fleet. The basic assumption for fleets in 
Ecospace (as described above) is that each functional target group is distributed across the map, 
and that the baseline effort (from Ecopath) is distributed across cells. If the effort is concentrated 
in a few cells only, this will result in a very high fishing effort being allocated to such a target group. 
In such a case the Total efficiency multiplier should be reduced from the unity level. A check for 
this is that with constant effort a fleet should not deplete a target species, other things being 
equal. 

Adaption 

The chapter is adapted, with permission, from: 

De Mutsert K, Marta Coll, Jeroen Steenbeek, Cameron Ainsworth, Joe Buszowski, David Chagaris, 
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Villy Christensen, Sheila J.J. Heymans, Kristy A. Lewis, Simone Libralato, Greig Oldford, Chiara 
Piroddi, Giovanni Romagnoni, Natalia Serpetti, Michael Spence, Carl Walters. 2023. Advances 
in spatial-temporal coastal and marine ecosystem modeling using Ecopath with Ecosim and 
Ecospace. Treatise on Estuarine and Coastal Science, 2nd Edition. Elsevier. 
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Geospatial Projections 
JEROEN STEENBEEK 

The Ecospace module of the (EwE) software applies the ecological dynamics of a marine food web 
across a grid of cells. Traditionally, this grid is geo-referenced to decimal degrees longitude [-180, 
180] and latitude [-90, 90], where cells taper at higher latitude ranges – the common WGS84 or 
EPSG:4326 projection. In its functional groups dispersal calculations Ecospace automatically takes 
this into account. 

To enable environmental driver data input to Ecospace to be mapped to a local UTM spatial 
projection with highest positional accuracy, these calculations need to be modified. 

Re-projecting the UTM data to the traditional Ecospace projection would cause irrevocable 
changes to driver data since UTM grid cells do not perfectly align nor perfectly overlap with the 
Ecospace grid. Driver data would thus not arrive in its accurate form in Ecospace, calling for 
modifications as described in this chapter. 

The following changes have been made to the EwE software to satisfy this requirement in three 
aspects of the EwE source code: 

1. The Ecospace model has gained an Assume square cells flag. When this flag is turned off, 
Ecospace will operate in traditional fashion assuming cell tapering by latitude, and assumes 
that cell coordinates and dimensions are specified in decimal degrees. When turned on, 
Ecospace assumes that its grid is geo-referenced to a relatively small local area where cells 
can be considered square, and cells coordinates and dimensions are specified in meters. This 
required changes to the EwE database format, and changes to Ecospace dispersal 
computations and sailing cost calculations, which both perform key distance calculations 
that need to take different geo-spatial projections into account. 

2. The Ecospace user interface has been adjusted to correctly translate between cell size 
(stated in projection units) and cell length (stated in km, used for functional group dispersal 
purposes). 

3. Ecospace data import and export routines have been adjusted to use the correct map 
projection units. 

Users can toggle the square cells flag in the Edit Basemap form, found in the Ecospace menu, 
where map units and the cell length / cell size translations change with the value of the Assume 
Square Cells flag (Figure 1). The Ecospace map provides correct location feedback to the mouse 
cursor when hovering over the Ecospace map (Figure 2). 
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Figure 1 –  Toggling the Assume Square Cells setting to switch between WGS84 / EPSG:4326 projections (when 
the setting is turned off) and a local UTM projection (when the setting is turned on). 
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Figure 2 – The Ecospace map interface providing geo-spatial location feedback for a local UTM grid in the EwE 
status bar, at the bottom left. 
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Spatial-Temporal Data 

A spatial-temporal data framework (STDF) has been added to Ecospace to facilitate dynamic 
data exchange into the running model (Steenbeek et al., 2013). Development of this framework 
was greatly facilitated by the modular design of EwE version 6 (Steenbeek et al., 2016). In the 
framework, external data integration into the model is divided into three layers: data access, data 
conversion and data integration (Fig. 2). 

To obtain output of Ecospace in GIS formats, the pathway for data integration is effectively 
reversed. Once the output data are passed through a conversion process, data are made available 
to the user and can then be saved to an external location (Fig. 3). 

Figure 2 – The modular design of the spatial-temporal framework in Ecospace, depicting how 
external GIS data are integrated into EwE (reproduced with permission from Steenbeek et al., 
2013) 
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Figure 3 – The modular design of the spatial-temporal framework in Ecospace, depicting how 
external data is output (reproduced with permission from Steenbeek et al., 2013) 

The new capabilities added to Ecospace allow the user to fully develop spatial-temporal dynamic 
modeling simulations, considering spatial food-web dynamics and changes in environmental 
conditions and human activities over time and space. The current configuration of the HFC model 
of Ecospace has a flexible structural design, which allows the inclusion of spatial-temporal data 
in different steps of the HFC model according to data availability and ecological hypothesis and 
management scenarios (Fig. 4). 
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Figure 4 – Modularity of the Habitat Foraging Capacity model (HFC). Every functional group has a base input 
capacity layer that can be overridden by external niche distributions. In addition, habitat affinities and 
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preferences for environmental functions can be applied to redefine habitat foraging capacity within a species 
niche. This configuration is a per-group setting (modified from Coll et al., 2020) 

Adaption 

The chapter is adapted, with permission, from: 

De Mutsert K, Marta Coll, Jeroen Steenbeek, Cameron Ainsworth, Joe Buszowski, David Chagaris, 
Villy Christensen, Sheila J.J. Heymans, Kristy A. Lewis, Simone Libralato, Greig Oldford, Chiara 
Piroddi, Giovanni Romagnoni, Natalia Serpetti, Michael Spence, Carl Walters. 2023. Advances 
in spatial-temporal coastal and marine ecosystem modeling using Ecopath with Ecosim and 
Ecospace. Treatise on Estuarine and Coastal Science, 2nd Edition. Elsevier. 
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Spatial‐Temporal Data Framework 
JEROEN STEENBEEK 

Purpose 

This chapter provides guidelines for configuring, and running external time series of maps in 
Ecospace, the spatial‐temporal module of the Ecopath with Ecosim (EwE) food web modelling 
approach. 

Availability 

The spatial temporal data framework is under continous development, and currently is only 
available under an EwE professional license, both to support the ongoing development and 
because setup of the framework is a requiring undertaking often requiring support. We do, 
however, seek to lower the learning curve through this chapter. 

For more information about licensing, please see https://ecopath.org/go-pro/ 

Using the Spatial Temporal Framework 

The spatial temporal framework is a plug‐in to the Ecopath with Ecosim food web modelling 
approach 1 2 3, built with the sole purpose to dynamically insert (time varying) spatial data that is 
external to the EwE model into Ecospace map layers 4. 

The framework integrates with the EwE6 user interface in several locations as shown in Figure 1. 
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Figure 1 –  EwE6 user interface with indications of the presence of the external spatial data facilities: (1) an item 
in the EwE navigation tree, (2) a configuration option in the Ecospace menu, (3) a blue database icon beside each 
map layer in the Ecospace map interface to indicate this layer is connected to external data, and (4) a the 
number of external data connections summarized in the EwE status bar. Type your text box content here. 

Defining Connections 

A ‘connection’ is the link between an Ecospace map layer and a repository of maps (or time series 
of maps) that are not stored within the EwE model. Connections are defined by the EwE user, and 
can be shared across computer systems. 

Connections are managed from the central Define external spatial temporal connections screen 
(Figure 2), which is accessible from several locations throughout Ecospace. Here, one can create 
and delete connections of different types, manage in which file the connections are stored on the 
local machine, export connections and their data for reuse or sharing with others, and control 
whether the framework is allowed to dedicate background processing time to index the spatial 
and temporal overlap of external data with the current Ecospace scenario. 
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Figure 2 –  Define external spatial temporal connections screen 

Existing connections are briefly summarized. The Used column states if the connection is actually 
applied to one or more Ecospace layers. The Status column uses icons to explain whether the 
connection has errors (Red X), has only partial spatial overlap with the modelled area (Orange !), 
or entirely covers the modelled area (Green checkmark). The warning icon  is also used to notify 
that data compatibility has not been assessed yet, which can be done by enabling indexing or by 
running Ecospace, in case each used connection is automatically validated. 

To define a new connection: 

• Go to Menu > Ecospace > Define external data connections… 
• Select the type of connection to create. Presently, four file‐based connection types are 

supported, 
(1) a time series of ASCII files that must be prepared to match the spatial extent and cell size 
of a dedicated Ecospace scenario; 
(2) a time series of spatial files that will be made fit for inclusion in Ecospace by the 
DotSpatial / GDAL GIS engine encapsulated in the spatial temporal data framework; 
(3) a file with X,Y,Z,T time series values provided in CSV file format, where (X,Y) coordinates 
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can either indicate (column, row) or (longitude, latitude); and 
(4) a single spatial file. 

• Press Create…. A new connection is defined, and the Configure external data connection 
view opens up (Figure 3) to allow its content to be modified. 

Figure 3 – Configure external data connection screen, where users configure a 
time series of external maps 

The configuration process of file‐based connections is straightforward: 

• Enter a name that identifies its content, keeping in mind that you may have a large number of 
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connections to sift through. To illustrate, the Mediterranean modelling exercise used for 
illustration in this chapter featured 150 different connections per scenario. 

• Enter a description to state data source, spatial and temporal resolution, data pedigree, and 
other details, considering one may have many connections to manage. 

• Optionally, select the Ecospace variable the connection is limited to. This does NOT assign 
the connection; it only limits where this connection is available in the EwE user interface. 

• Press Browse to select which files belong to the connection browse to the folder where the 
files reside, and select and insert the desired files. The files list will populate in response. 
Note that each file represents a map in time. times can be entered by hand, or can be set 
automatically, either by entering a start date (year/month) and monthly interval, or by 
reading the time step from a fixed position in the file names. Seasonal data rotates the first 
year of data until the indicated end date. 

• Press OK    

Assigning External Data to Ecospace 

To make external connections operational in Ecospace, do the following: 

• Go to Navigator > Ecospace > Input > External data… The External data view opens up (Figure 
4), and displays all Ecospace map layers that can receive external data. The toolbar offers 
options to limit the number of layers on display, with filters by layer type, and only viewing 
layers with active connections. The external data interface also shows a time line that 
reflects the temporal overlap of external data with the Ecospace scenario. 
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Figure 4 – External data view, which provides an overview of which Ecospace layers have external data assigned 
to them. 

Every map layer has up to six slots for assigning connections. To assign external data to a layer, 

• Click the first available slot in the layer that you wish to drive with external data. 
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Figure 5 – Define connections interface, where an external data connection is assigned to a single Ecospace map 
layer. 

This opens up the interface Assign connections (Figure 5), 

• Select a connection from the list of available connections 
• Click the use button (Green arrow pointing right) to assign the connection. A configuration 

panel opens with additional options. Available options depend on the type of connection that 
was selected, and the type of Ecospace layer the connection is applied to. Some Ecospace 
layers may require data to be scaled, for instance, and for those layers you will need to 
provide a scalar. The configuration panel also summaries compatibility of assigned external 
data with the current Ecospace scenario. 

• Click Configure to review or change the configuration of the connection (as explained above). 
• Select an Integration method if applicable – these are geospatial macros that convert data to 

the desired Ecospace layer needs. 
• Enter a scaling method if applicable 
• Enter a scaling factor, which can be left at default 1 if data in the Ecospace scenario is the 

same as the first month of external data. 
• Calculate the scaling factor to scale the first year of external data scales to an Ecopath base 
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value (this is highly recommended when driving the Relative PP layer, for instance). 
• Press Close to make the external data connection stick, and save the model. 

Figure 6 – The external data view with External data assigned to drive the content of the Ecospace Relative PP 
layer. 

Running Ecospace with External Data 

When Ecospace is executed as normal, the EwE status panel will show a notification every time 
external data is accessed, and also whether integration into the intended Ecospace layer was 
successful. These notifications are also written to an extensive log file, which is saved in the 
directory where the EwE model is located. This file can be helpful for troubleshooting external 
data connection issues. 
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Figure 7 – Run Ecospace interface and the EwE status panel. The status panel informs users when Ecospace has 
attempted to integrate external data into the running model. 

If Ecospace has encountered any issue with external data during a run, it will notify the user that 
issues were encountered. As the Ecospace run missed some needed external data it should not be 
trusted, and the status panel and/or spatial log file will provide clues as to why needed spatial data 
was not found. 

Configuration Files 

All spatial temporal data connection definitions are stored in configuration files. At any given 
moment, EwE operates on only one configuration file that defines available external data 
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connections. This central storage allows external connections to be reused between Ecospace 
modelling exercises, and provides a means to organize how much data is visible to a specific 
modelling exercise. 

Configuration files are managed in Menu > Tools > Options > External data… Here, one can create 
or delete configuration files (in .xml format), add an existing configuration file to EwE, and set the 
active configuration file. 

Figure 8 – The form where you can switch external data configuration files. Use this only when you run multiple 
projects at the same time, each requiring numerous external data connections. 

Once a connection is applied to an Ecospace layer, the definition of the connection is stored within 
Ecospace, while the data remains outside the model. 

It is advisable to use separate configuration files for different models, as the number of external 
spatial temporal data connections can become overwhelming. 
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Sharing External Data 

The export external spatial data interface, which can be launched from all locations in the EwE 
user interface where external data connections are managed, creates new configuration files from 
selected external data connection definitions, and optionally their data. All exported data is placed 
in a user selected folder. 

Figure 9 – The Export external data interface 

To share external data connected to your model with another computer or colleague, 

• Open the export external spatial data view, for instance through Menu > Tools > Options > 
External data > Export 

• Enter a descriptive file name (such as “External data Med 0.01667dd”) 
• Select Choose to browse to the a location where the exported data can be placed 
• Select which connections to export. The “Used” button selects all connections assigned in 
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Ecospace; the “All”button selects all available connections as defined the current 
configuration file. 

• Check “Export local data as well” 
• Click Export. Please be patient, this may take a while. 

Once the export process is complete, share the data as follows, 

• Copy the entire exported folder with your model to make it available or place the exported 
folder on a shared network drive. 

To incorporate shared data into EwE, 

• Go to Tools > Options > External data 
• Click Add 
• Browse to the shared configuration file 
• Press Open and the configuration file will be added to EwE 
• Press Set Current to make this the active configuration file 
• Load Ecospace. 

When an Ecospace scenario is loaded, the spatial temporal data framework automatically resolves 
conflicts in external data connections against the current configuration file. 

Notes 

1. Christensen, V., Walters, C.J., 2004. Ecopath with Ecosim: methods, capabilities and limitations. Ecological 
Modelling, Placing Fisheries in their Ecosystem Context 172, 109–139. https://doi.org/10.1016/
j.ecolmodel.2003.09.003 

2. Heymans, J.J., Coll, M., Link, J.S., Mackinson, S., Steenbeek, J., Walters, C., Christensen, V., 2016. Best 
practice in Ecopath with Ecosim food-web models for ecosystem-based management. Ecological 
Modelling, Ecopath 30 years – Modelling ecosystem dynamics: beyond boundaries with EwE 331, 173–184. 
https://doi.org/10.1016/j.ecolmodel.2015.12.007 

3. Steenbeek, J., Buszowski, J., Christensen, V., Akoglu, E., Aydin, K., Ellis, N., Felinto, D., Guitton, J., Lucey, S., 
Kearney, K., Mackinson, S., Pan, M., Platts, M., Walters, C., 2016. Ecopath with Ecosim as a model-building 
toolbox: Source code capabilities, extensions, and variations. Ecological Modelling, 40th Anniversary of 
Ecological Modelling Journal 319, 178–189. https://doi.org/10.1016/j.ecolmodel.2015.06.031 

4. Steenbeek, J., Coll, M., Gurney, L., Mélin, F., Hoepffner, N., Buszowski, J., Christensen, V., 2013. Bridging the 
gap between ecosystem modeling tools and geographic information systems: Driving a food web model 
with external spatial–temporal data. Ecological Modelling 263, 139–151. https://doi.org/10.1016/
j.ecolmodel.2013.04.027 
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Sharing External Spatial Datasets 
JEROEN STEENBEEK 

The Ecospace module of EwE has gained capabilities to be driven by external spatial-temporal 
datasets. These external data sets cannot be embedded within a EwE model database because they 
tend to be model-derived datasets that frequently update, and that are of prohibitive file size. The 
process of connecting to these data is detailed in Steenbeek et al. 1(2013), see chapter. 

To enable sharing of temporal spatial data by, e.g., scientists at different institutes in different 
locations, this system has been extended to offer support for shared use of the same model with 
accompanying external spatial data via cloud-based transfer media. 

Changes to EwE 

The Ecospace model stores definitions of available spatial-temporal data series in a local 
configuration file 2. Sharing this configuration file is impractical when a local system contains 
dataset definitions for a suite of Ecospace models: support was needed to only selectively share 
relevant data for a given modeling exercise. To enable this, the following changes have been made 
to the EwE6 software, 

1. An export function was added to EwE6 that make it possible to copy a selection of dataset 
definitions to a local folder with a local configuration file. Whereas datasets on a local system 
are indicated by absolute file paths, the exported datasets refer to their files via local paths, 
making this export folder highly suitable for transfer to another computer. 

2. An option has been added to allow for switching to a different configuration file – either 
locally created configuration files particular to a given modeling exercise, or shared 
configuration files obtained via a cloud-based file transfer system – which provides Ecospace 
with access to the external spatial-temporal data connections described in the configuration 
file. 

EwE6 model databases already carried all information needed to connect an Ecospace layer to 
external data sets 3. However, this information just contained technical details internal to the 
model, and was too sparse to assist troubleshooting when expected data sets could not be located. 
The following changes were therefore made to the EwE6 software: 
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1. EwE6 model databases now also store the configuration of data sets, but not the actual data 
due to its prohibitive size. 

2. When Ecospace loads this information it tries to resolve these data sets. If a local computer 
does not know these data sets, the data sets are instantiated from the data stored in the 
model, and the user is warned that the data set may be incomplete. Having access to the 
complete configuration information, a user can figure out what external data is needed to 
reassemble the model configuration by requesting a data set export from the original model 
author, and then linking to these data. 

Using these Developments 

It is possible to export data sets from several locations in EwE, such as the main Ecospace menu 
and the interface where external datasets are defined (Figure 1). 

Figure 1 – Where to find the Export data sets option. 

When this option is selected a dedicated interface is displayed. Here users can decide which data 
sets to export for transfer to another computer, such as all data sets or only those used by the 
current model (Figure 2). Note that this interface is still in its infancy and may need further work to 
allow for selection of an export directory, to display export progress, and to display export result 
information. 
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Figure 2 – Data set export interface. 

The EwE6 status panel notifies about where where the data sets have been exported to. When 
clicking this link, you are brought to the export directory, which in its entirety can be transferred 
to another computer, or can be shared via a cloud-based service such as Dropbox. The Export 
folder contains directories with file content for individual data sets where applicable, and a 
“ewe_datasets.xml” configuration file for these files (Figure 3). 

Figure 3 – Example contents of a data set export folder. 
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Once the exported data sets are transferred to another computer they can used by EwE. For this, 
a user switches the local configuration to the exported data sets via the spatial temporal data page 
in the main EwE options interface (Figure 4). Ecospace now shows the data sets as usable for the 
model (Figure 5). 

Figure 4 – Linking to a set of exported data sets that has been received from another user. 
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Figure 5 – The imported data sets displayed in Ecospace, ready to be used. 

Notes 

1. Steenbeek, J., Coll, M., Gurney, L., Mélin, F., Hoepffner, N., Buszowski, J., Christensen, V., 2013. Bridging the 
gap between ecosystem modeling tools and geographic information systems: Driving a food web model 
with external spatial–temporal data. Ecological Modelling 263, 139–151. https://doi.org/10.1016/
j.ecolmodel.2013.04.027 

2. Steenbeek et al. 2013, op. cit. 
3. Steenbeek et al. 2013, op. cit. 
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Spatial Model Skill Assessment 

Spatial Fitting 

When fitting a model to data, two main processes are involved: the modification of parameters to 
better-fit observational data (called model calibration), and the comparison of predicted results 
with independent observations to validate results (or model validation). These processes are 
frequently done together to evaluate the performance of a model. With increasing spatial data 
available, the separation between calibration and validation should ideally become standard 
practice in Ecospace modeling. 

Advancing Towards Calibration of Ecospace 

Contrary to the temporal model Ecosim, Ecospace model calibration is still rarely systematically 
executed due to the complexity of parameters involved, the need for large space-time datasets, 
and lack of computing power 1[/footnote]. The majority of Ecospace users are manually tuning 
key parameters to obtain reliable distribution of species on the basis of visual inspection and 
confrontation with available spatial data. Some advances have been made by running Ecospace 
outside the user interface, using R or Python, to systematically evaluate parameter sensitivities 
and search for values that improve model fit 2Vilas, D., 2022. Spatiotemporal Ecosystem Dynamics 
on the West Florida Shelf : Prediction, Validation, and Application to Red Tides and Stock 
Assessment. University of Florida. https://doi.org/10.1038/s41598-023-29327-z[/footnote]. In 
addition to tuning Ecospace parameters (as described in previous sections), also several Ecosim 
parameters could be changed during the tuning process. For example, vulnerability multipliers 
are calculated based on biomasses averaged over the entire spatial domain. When a fitted Ecosim 
model is migrated into Ecospace the calibrated vulnerability multipliers of some species might 
be too high for species that are confined to limited domains (restricted depth range, specific 
substrates, etc.) in Ecospace due to its spatial overlap with that of its predators and of the 
main target fishery. In cases such as these, Ecosim vulnerability multipliers (by predators or by 
predator-prey interactions) need to be manually tuned to reach the temporal-spatial stability of 
these species. 

When dispersion rates are low, they might help to concentrate a species into stable hot spots or 
conversely, when high, dispersal rates might allow excessive dispersal of biomass in the domain. 
Consequently, higher dispersal rates tend to lead to models that better fit observational data but 
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that can become ecologically unrealistic. The dispersion rate also influences the resulting effects 
of MPAs, since high dispersal might predict large spill-over from areas of protection and hamper 
biomass rebuilding thus reducing the benefits for highly exploited species. Iterative testing the 
effects of the parameter values such as dispersal rates and vulnerabilities on spatial distribution of 
species (based on simple visual inspection) under e.g. MPAs setting can be done manually as part 
of the calibration process 3. 

Another component of spatial calibration is adjusting the response curves to environmental 
drivers (e.g., temperature, depth, dissolved oxygen) to better represent the aggregation of species, 
i.e., to resemble the aggregation in favorable areas in terms of environmental conditions 4. Species 
distributions obtained from species distribution models or SDMs 5 can be used to either force 
the habitat capacity of a species 6 or can be used to compare with Ecospace model outputs for 
validation purposes: this is often done off-line, which allows for testing of the efficacy of tuning 
done manually, while not using optimization routines to create a better fit 7. 

To tune the cost of fishing and the distribution of fishing effort in Ecospace, distance from ports 
can be compared with, for example, analysis of Vessel Monitoring Systems (VMS) or Automatic 
Information System (AIS; 8). Furthermore, administrative boundaries (EEZ boundaries), gear 
specific costs and habitat preferred for fishing (e.g., trawling avoiding rocky areas) are additional 
parameters that can improve accuracy of fisheries distribution over space. However, some specific 
spatial behavior of fishermen not directly related to the abundance and value of target species 
(e.g., fishery ground fidelity) might be quite difficult to represent. Overall, lacking better features 
to reproduce fishers’ behavior, Ecospace assumes that all fleet elements have complete knowledge 
of distribution of the target species. Connecting Ecospace to an explicit fisheries behavior model 
is a development of interest for the future. 

Spatial Validation 

Validation is the process of assessing whether a parameterized and calibrated model effectively 
performs as it should. In other modelling context, traditionally the data pool is split in a set only 
used for calibration, and another set only used to finally validate the model with a proportion that 
can range from 50-50 to 80-20. Alternatively, completely different sets of data can be used for 
the validation. The validation serves as a proof of model skills. Such formal exercise is not often 
performed in Ecospace, while in the context of progressive application of EwE and Ecospace in 
operational context it is ideal to deliver a systematic validation of the models, and some examples 
of how this has been done are provided below. 
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Hotspot Analysis 

The use of existing telemetry data on particular species of interest is one data source that has been 
under-utilized in developing validation methods for spatial-temporal models. Ecospace includes a 
plug-in called the XY Hotspot Tool, which allows the user to include the frequency of detection 
of species from telemetry data and calculates the error between predicted and observed between 
telemetry data and Ecospace output maps. One unpublished example of this approach, called the 
XY Hotspot Analysis, was tested on Spotted Seatrout (Cynoscion nebulosus) in Lake Pontchartrain, 
Louisiana, USA. From 2012 to 2014, the movements of 211 Spotted Seatrout were monitored using 
an acoustic array composed of 90 autonomous receivers. The “pings” recorded on the receivers 
were converted to biomass using a novel methodology and then using various GIS interpolation 
techniques, species distribution maps were created at monthly time steps. Then, using the XY 
Hotspot tool, the prediction error between the maps output by the Ecospace model and the maps 
developed using the telemetry data were calculated (Figure 1). 

image 
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Figure 1 – Lake Pontchartrain, Louisiana, USA. Resulting predictive error raster map, which indicates 
the degree of agreement between modeled output of Spotted Seatrout (Cynoscion nebulosus) and GIS 
rasters developed from in situ telemetry data. The black dots indicate the telemetry receiver distribution 
in the lake. The blue colors indicate negative predictive errors (the model underestimated biomass, red 
colors indicate positive predictive errors (the model overestimated biomass), and the yellow or beige 
colors indicate predictive zeros close to or at zero, indicating agreement between the two datasets. 
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Using Regional Observations to Validate Distribution Patterns 

Figure 2 – Comparison of predicted absolute southern flounder biomass (solid lines) distributed into regions 
(coastal study area or CSA 1, 2, and 3) of the total model area over time to observed southern flounder biomass 
(dotted lines) in those same regions during the same time. The sum of squares error (SSE) provides a metric of fit 
between the two. 

Validation often requires two datasets covering the same area (one for model creation, one for 
model validation), which is rare to have, e.g., two monitoring programs covering the same area. 
However, when a dataset has not been initially used to determine the spatial distribution of 
species, it can be used to validate distribution patterns. This is often the case with EwE models. 
Survey data that cover the whole model area can be used to create a representative snapshot of 
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the ecosystem (the Ecopath model). By creating regions within the Ecospace model area, averaged 
output of subsections can be generated. Time series of this output can be compared with survey 
data time series from field sites within that same subsection (see De Mutsert et al. 9 10 for 
examples). Goodness-of-fit metrics can be applied outside of the model interface. This is an easy 
non-spatial solution to validate how the habitat capacity framework distributes species based on 
habitat affinity and environmental preferences when spatial features are included in the model 
with response curves (Figure 2). 

image 

Multi-Model Comparisons 

Statistical analysis of species occurrences and their relationships with associated environmental 
factors is used to predict how likely a species is to occur in unsampled locations as well as future 
conditions. However, environmental factors alone may not be sufficient to account for species 
distribution. Other ecological processes including species interactions (such as competition and 
predation) and the impact of human activities, may affect the spatial distribution of a species. 
Novel techniques have been developed to take a more holistic approach to estimating species 
distributions, such as Bayesian Hierarchical Species Distribution model (B-HSD model) and 
mechanistic food-web models using the HFC model. Coll et al. (2019) used both species 
distribution and spatial food-web models to predict the distribution of European hake (Merluccius 
merluccius), anglerfishes (Lophius piscatorius and L. budegassa) and red mullets (Mullus barbatus 
and M. surmuletus) in an exploited marine ecosystem of the Northwestern Mediterranean Sea. 
They explored the complementarity of both approaches, comparing results of food web models 
previously informed with species distribution model results, aside from their applicability as 
independent techniques. The study showed that both B-HSD and E-HFC model results were 
positively and significantly correlated with observational data. Predicted spatial patterns of 
biomasses showed positive and significant correlations between modeling approaches and were 
more similar when using both methodologies in a complementary way: when using the E-HFC 
model previously informed with the environmental envelopes obtained from the B-HSD model 
outputs, or directly using niche calculations from B-HSD models to drive the niche priors of the 
Ecospace HFC 11. 

Adaption 

The chapter is adapted, with permission, from: 

Spatial Model Skill Assessment  |  265



De Mutsert K, Marta Coll, Jeroen Steenbeek, Cameron Ainsworth, Joe Buszowski, David Chagaris, 
Villy Christensen, Sheila J.J. Heymans, Kristy A. Lewis, Simone Libralato, Greig Oldford, Chiara 
Piroddi, Giovanni Romagnoni, Natalia Serpetti, Michael Spence, Carl Walters. 2023. Advances 
in spatial-temporal coastal and marine ecosystem modeling using Ecopath with Ecosim and 
Ecospace. Treatise on Estuarine and Coastal Science, 2nd Edition. Elsevier. 

Notes 

1. Romagnoni, G., Mackinson, S., Hong, J., Eikeset, A.M., 2015. The Ecospace model applied to the North Sea: 
Evaluating spatial predictions with fish biomass and fishing effort data. Ecological Modelling 300, 50–60. 
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Input and Data 
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Ecotracer is a useful tool within the Ecopath and Ecosim (EwE) modelling approach to track 
radioisotopes, contaminants, persistent pollutants, or stable isotopes through a food web model. 
After achieving a mass‐balanced Ecopath model, Ecotracer can be used with the Ecosim (time 
dynamic) or Ecospace (spatial‐temporal dynamic) to track the flow of the pollutant through the 
modelled ecosystem. 

EwE uses a mass‐balance approach, and the flows of a contaminant due to predator/prey 
interactions are tracked within the underlying Ecopath model. However, Ecotracer also needs 
parameters for groups based on a kinetic toxicology approach to estimate initial conditions. 
However, similar to Ecopath, Ecotracer can become dynamic through either the use of Ecosim 
or Ecospace to follow the changes of a contaminant that has different temporal inputs or to 
variations in temporal spatial concentrations in the water column. 

The Ecotracer interface involves a number of input parameters (e.g., BI) and some that are 
calculated internally by the program, (e.g., gains from diet). Ecotracer’s interface can be loaded 
from the task bar or from the side‐menu. The interface is divided into three parts: the side panel 
(navigator) to choose Ecotracer or one of the other components of EwE; the interface for input for 
the environment; and input data for the functional groups based on the Ecopath model (Figure 1). 
The fields for the environment and the functional groups, their description and units are described 
below. 

Figure 1 – Screen capture of the Ecotracer routine showing the access to the user interface on the side panel 
(green), the areas for environmental data (blue) and functional group (red) inputs. The input data user interface 
can also be accessed through the toolbar at the top of the interface. 
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Navigator 

The side panel allows easy access to the different routines within the EwE modelling framework. 
After creating a balanced Ecopath model, the Ecotracer routine can be selected in this area. 
Ecotracer parameters must be selected and a name can be given to the scenario. Also, it is 
necessary to select either ‘enable contaminant tracing for Ecosim’ if the model is only being run 
forward in time or ‘enable contaminant tracing for Ecospace’ if the model is spatialized using the 
Ecospace. The selection of which is dependent upon the underlying model and whether there are 
time or spatial‐temporal dynamics that are of interest. 

Troubleshooting: if you do not get a response in Ecotracer and you have entered a direct 
absorption rate for primary producers; ensure that Ecosim or Ecospace have the contaminant 
tracing box checked. 

Environment 

The simplest case for the environment is if the model area has a near uniform concentration. If this 
is the case then one concentration can be used for the initial concentration of the environment. If 
there are differences in time, but the spatial area is treated as being homogenous in concentration, 
then the base inflow rate can be changed using a csv file that represents either absolute or relative 
changes to the initial environmental concentration. If there are spatial‐temporal variations in 
environmental contaminants in the model area, then a professional license for EwE is needed. 
Through the Spatial Temporal Data Framework (STDF 1, see chapter Spatial‐Temporal Data 
Framework), monthly maps of contaminant concentrations can be inserted into Ecotracer, 
enabling modellers to incorporate historical and/or projected environmental contaminants into 
Ecotracer. Brief instructions how to use the STDF with Ecotracer are provided as an annex at the 
end of this manual. 
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Figure 2 – Close‐up view of the interface for environmental parameters for Ecotracer. Environmental inflow 
forcing function (highlighted in green) requires a csv file (see Table 1), whereas the contaminant concentration 
driver file (highlighted in red) uses a series of ASCII files for each grid cell used in Ecospace, and requires the 
EwE pro license for the spatial‐temporal framework. 

Initial concentration: concentration in the water. Currently, there is no explicit depth 
representation in Ecospace and to be consistent with the biomass units (i.e., t∙km‐2) in Ecopath 
the units are expressed per km2 with the units commonly being mass for most contaminants (e.g., 
g∙km‐2) or becquerels for radioisotopes (i.e., Bq∙km‐2). Therefore, units expressed in terms of unit 
per volume (e.g., μg∙L‐1) must be converted to the spatial resolution used. 

Base inflow rate: the amount entering the environment each year (e.g., g∙km‐2∙year‐1). Obviously 
a base inflow rate for a one time release of, for instance, a hazardous chemical would not need 
a base inflow rate. However, to maintain background levels under equilibrium conditions a base 
inflow rate is needed to account for uptake and/or physical decay rates of the contaminant. 

Base volume exchange loss: the rate at which a contaminant is lost to the environment (year‐1). 

File for Base Inflow Rate: this is intended to be used when the environment receives a uniform 
increase. This is a .csv file that is arranged to implement changes to the environment on a relative 
or absolute scale through time (Table 1). 

Table 1: Environmental inflow forcing function file that changes the relative base inflow rate 
from 1 to 3.40 over ten years; pool indicates the environment; and type 2 signifies a relative rate 
to the original environmental concentrations. 
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File for Point source Release: the point source release is another way of implementing changes to 
the environment on a spatial‐temporal scale in conjunction with Ecospace. It requires a series of 
ASCII files to implement the changes in a spatial cell through time and is a feature of the EwE pro 
license. 

Maximum number of time steps: Ecotracer numerically solves the equations at a higher 
resolution (i.e., more time steps) than Ecopath, Ecosim and Ecospace, which all have monthly time 
steps in order to reach a stable solution using an explicit integration method. The number of time 
steps is important for some contaminants that have relatively high physical decay rates. Therefore, 
the time steps and the number of calculations are increased to accurately trace the contaminant 
within Ecotracer, but Ecotracer integrates itself with the monthly time steps of Ecopath, Ecosim 
and Ecospace. 

Biota 

For ease of computation within the Ecotracer program, Ecotracer uses the amount of substance 
(e.g., Bq or g). However, for output (see next chapter) you can choose between the amount in a 
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group (e.g., Bq) or biomass concentration (e.g., g∙t‐1). When validating model output to field sample 
data, it is likely that you will be comparing the biomass concentrations. All functional groups do 
not need to have starting concentrations, but they should have estimates of direct uptake rates, 
otherwise the resulting biomass concentrations will only reflect dietary uptakes based on the diet 
compositions entered for the Ecopath model. While this may not be important for top piscivores 
due to the fact that their diets mostly determine their contaminant load, it may affect the lower 
trophic levels of the food web where direct uptake rates may be more important than diet, and are 
the only entry way for primary producers. Dietary uptake is not entered as part of the Ecotracer 
routine as it is determined from the diet matrix, the consumption rate, the unassimilated amount, 
and the proportion of contaminant excreted. 

Figure 3 – Close‐up view of the interface for functional group parameters for Ecotracer. The direct absorption 
rate (ui; highlighted in red) indicates that primary producers are generally the first compartment that are 
involved in the transfer of a contaminant through the food web model. The amount taken up by predator/prey 
interactions are defined by parameters in the underlying Ecopath model and by the diet matrix, and are 
accounted for internally by EwE. Note that the Initial concentration is the total amount in the functional group 
(see text for details). 

Initial conc: the amount (e.g., Bq) in a group at the start of the model period (i.e., t = 0). Groups 
with no data from sample surveys can have a starting amount of zero. 

Concentration in immigrating biomass: the concentration of a contaminant (Bq∙t‐1) in a 
functional group that is entering the model area under consideration. 

Direct absorption rate: represents the amount of a contaminant that a functional groups takes 
up from the environment (km2∙t‐1∙year‐1). It represents the proportionality coefficient between 
the direct uptake rates (e.g., Bq∙year‐1), and the biomass (t) and environmental concentration (e.g., 
Bq∙km‐2). Generally, the primary producers must have a direct absorption rate, and it is useful to 
determine the direct absorption rate for other groups otherwise the resulting concentrations will 
only be due to trophic interactions (i.e., dietary items). Also, direct absorption rates are important 
for simulating changes in environmental concentrations through time. 

Metabolism rate: the rate (year‐1) of losses due to the transformation of the contaminant of 
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concern into another form (e.g., methylmercury to ionic mercury). These represent losses to the 
system. 

Decay rate: the instantaneous physical decay rate constant (i.e., λ; year‐1) of radioisotopes and 
represents losses to the system. 

Proportion of contaminant excreted: this is the proportion (0‐1) of the contaminant that is 
excreted back into the environment and stays in the system. It is equivalent to 1 – assimilation 
efficiency. 

Excretion rates: excretion rates (year‐1) are also described in Walters and Christensen 2, but at 
this time are not represented in the user interface. If they are small relative to the surrounding 
environment they may not be important. However, in comparison to the metabolism rate there is 
an important difference. Excretory products stay within the system (i.e., they are available to be 
taken up again by biota), whereas the metabolism of contaminants are lost to the system because 
they are changed into something else. 

Attribution 

This work has been funded by the Institut de Radioprotection et de Sûreté Nucléaire (IRSN) 
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1. Steenbeek, J., Coll, M., Gurney, L., Mélin, F., Hoepffner, N., Buszowski, J., Christensen, V., 2013. Bridging the 
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with external spatial–temporal data. Ecological Modelling 263, 139–151. https://doi.org/10.1016/
j.ecolmodel.2013.04.027 

2. Walters & Christensen. 2018, op. cit. 
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Figure 1 – Full view of the Ecotracer output interface composed of the navigator, side panel and graphing area. 
The graph area, in this example shows that the amount of contaminant in the environment is generally constant 
through time. It is also possible to select more than one group by using the control or alt key. The Navigator pane 
has a Status and Remarks area at the lower left, which allows you to determine what changes have been made 
and to find the directory path for output files generated after a simulation. The Side panel has details for the 
environment and functional groups, plotting data type, and a for auto‐saving results after each simulation run. 
In the show data section, the label concentration is the amount of contaminant and the concentration/biomass 
is the concentration. 

The interface for the output of the data involves the navigator, a side panel and a graph area (Figure 
1). Ecotracer output is selected from the navigator to display the side panel and the graph area. 
Data on the side panel involves choosing the data that is to be displayed on the graph area, the 
type of contaminant data displayed, the data displayed on the graphing area, the specific routine 
run button, and whether or not the data is automatically saved. Once data has been entered into 
the input interface, the simulation is initiated from the output interface either through the Run 
Ecosim or Run Ecospace buttons on the side panel to the graphing interface. 

The graphical interface displays how the contaminant in the environment and in each functional 
group changes through time. There is a choice between having the functional groups trace the 
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contaminant by the amount (e.g., Bq) in the group or by the biomass concentration (e.g. Bq∙t‐1). The 
environmental concentration is essentially an area density (e.g., Bq∙km‐2). Under an assumption 
of environmental equilibrium, the environmental concentration on the graph should show a flat 
line. Under no changes to the functional groups underlying parameters (e.g., fishing mortality), the 
concentration in each group (e.g., Bq∙t‐1) should also be represented by a flat line. 

For radioisotopes under assumed equilibrium conditions, the amount lost by radioactive decay 
would have to be added in as a base inflow rate to maintain equilibrium. Although equilibrium 
conditions may not be realistic, it is definitely a good way to see if the model is behaving properly, 
and may be a good assumption if the environmental concentrations do not change much due to a 
radioisotope having a long half‐life, or when long‐lived animals (e.g., whales) are not represented 
in the model as they would not be affected by historical environmental concentrations. The 
inverse of the P/B (unit: year-1) ratio is an indication of the average longevity of the groups in the 
model (B/P, unit: year). 

Output files in Ecosim can be saved to a directory by selecting auto‐save results. In Ecospace, it is 
necessary to open Ecospace parameters on the navigator panel and then select the files under the 
auto‐save dialogue box. In most cases, the biomass maps and the contaminant concentration map 
need to be selected. This is because the concentration map is for the amount and therefore it is 
necessary to compute the concentration (e.g., Bq∙t‐1) from the two sets of data. The path directory 
for output files can be found in the status window. However, usually for the first run of a scenario 
it is useful to not save the data and examine the output by hovering over the concentration data on 
the graph; point‐values can be shown by right clicking on a line on the graph and selecting Show 
point values. After adjustments have been made to basic input parameters (Ecopath or Ecotracer) 
if required, and the point values are in the desired range of expected output values, it is then 
worthwhile to save the output files. 

Currently post‐processing of the output files must be done in another program such as Microsoft 
Excel or R. Models that only use Ecosim for time dynamics will have a single output file containing 
a single column of output for each functional group, and 12 rows of data for each year with the 
cells containing the amount in the group. Models using Ecospace have CSV output files for each 
species that cover one time step for one species with the columns representing the longitudinal 
grid of the map and the rows the latitudinal grid working from the top left cell to the bottom right 
cell. 

Changes in concentration for the environment and functional groups other than those resulting 
from changes in environmental concentrations result from the kinetic interactions as described 
earlier. Functional groups with no starting concentrations will have increasing concentrations, and 
groups with starting concentrations may have changes through time as a result of their losses 
and gains at each time step. However, differences between a functional group’s model output and 
those with a starting amount based on field collected samples can also be affected by biases in 
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sampling (i.e., sampling not being representative of the population concerned) or by incorrect 
Ecopath or Ecotracer parameters. The biomass of a group may also change through time most 
commonly due to trophic interactions or changes in fishing mortalities if these are represented in 
the model. Thus, the resulting biomass concentrations can be a function of changes in the amount 
of contaminant in the functional groups and changes in the underlying state variables (biomass) 
through time. 

Ecotracer is a useful computer simulation tool to gain knowledge on the transfer of pollutants in 
an ecosystem. We have attempted to give a practical guide to colleagues who are interested in the 
use of the EwE ecosystem modelling framework a better understanding on the technical use of 
the routine, and the interfaces used. We hope this inspires people from various backgrounds to 
engage and gain a better understanding of how contaminants behave in an ecosystem. 

Attribution 
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Environmental distributions of contaminants can be made time‐varying through the spatial 
temporal framework (STDF). Incorporating monthly changing patterns of contaminant 
concentrations into Ecotracer is a three‐step process: 1) Prepare maps in a GIS; 2) define external 
data connections in EwE; and 3) connect an external data connection to drive the contents of the 
Ecospace contaminants layer. 

Prepare Maps in a GIS 

Although the STDF contains a GIS engine that converts GIS data to the Ecospace grid (Steenbeek 
et al. 1), it is highly recommended that ecosystem modellers perform this step in a dedicated GIS 
software to minimize GIS processing artifacts. 

The step to prepare maps in a GIS entails the necessary steps to convert contaminant distributions 
over time into discrete, monthly ESRI ASCII maps that match the exact dimensions, cell size, 
spatial extent, and geospatial projection of the base map in an Ecospace scenario. 

The Ecospace base map can be extracted from a loaded Ecospace scenario as follows: 

• Click Navigator > Ecospace > Input > Maps 
• Double‐click the Depth layer at the right‐most panel 
• In the Edit layer interface that appears, select the Data tab. In the Data tab, select Export > 

To ASCII… 

The actual steps to convert contaminant distributions to monthly Ecospace maps can require a 
number of GIS operations, depending on the format and content of the original contaminant data. 
Operations may require: 

• Reprojecting to the Ecospace base map (most likely WGS84 / epsg:4326) 
• Temporal clustering 
• Clipping 
• Kriging (point data) and/or resampling (vector data) 
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• Exporting to the ESRI ASCII format. 

Define External Data Connections in EwE 

Once one or more time series of monthly ASCII maps have been prepared, Ecospace needs to 
know where to find these time series on the local machine. Do the following, 

• Click Menu > Ecospace > Define external data connections… 

Figure 1 – To define a new spatial‐temporal data connection, select the type of the 
connection and click . From this interface one can also reconfigure external data 
connections that were previously created. 

• In the Define external data connections interface, select connection type A series of 
Ecospace ASCII maps over time and click Create (Figure 1). This will define the time series, 
and will bring up the Configure external data interface to configure the new time series 
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(Figure 2). 
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Figure 2 – The interface to configure a specific external data connection (e.g, a time series of maps). Each 
time series has a name to uniquely define the series in the Ecopath with Ecosim user interface, an optional 
description, a variable that only serves to limit where the external data connection appears in the Ecopath 
with Ecosim user interface, and a series of timetagged maps that, in this particular figure, reflects historical 
concentrations of 137Cs in the water off of Fukushima, at monthly time steps, since March 2011. 
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• In the Configure external data interface, enter a unique name to identify the time series in 
the Ecopath with Ecosim user interface. 

• It is advisable to use the description to describe where the maps time series came from. 
• The variable field serves to limit where the external data connection appears in the EwE user 

interface. For contaminants, leave this field at its default value (No variable). 
• Now add the actual maps to the external data connection. Click Browse and navigate the 

folder that contains the maps. Select all the maps, and click Open. The maps will appear in 
the Configure external data interface. 

• This interface has limited abilities to parse the date from map file names. Please check the 
Time column and ensure that each map has a correct time tag. You can modify time tags by 
hand, or with the tools provided in the Set file times section. 

• Once all maps are correctly time‐tagged, close the Configure external data. The newly 
configured time series of external maps will appear in the Define external data 
connections interface. 

• Close this interface too. 

Ecospace now has the information to locate and integrate time series of external ASCII 
contaminant maps into the running model. 

Connect the External Data to the Contaminants Layer 

Now at least one time series of contaminants in seawater has been defined, this time series needs 
to be connected to drive the contents of the Ecospace contaminants map layer. Do the following, 

• In the Navigator, open Ecospace > Input > External data (Figure 3) 
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Figure 3 – The External data interface where previously defined external data connections are applied to 
Ecospace layers. 

 
• Under input maps, locate the environmental contaminants map. One can also use the 

on‐screen filter options to reduce the number of visible input maps 
• In the row for the environmental contaminants map, click the cell Slot 1 to assign an external 

connection here. This brings up an interface dedicated to configuring how external data is 
integrated into Ecospace (Figure 4) 
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Figure  4 – Configuring the integration of an external time series of maps into Ecospace, in this case to the 
environmental contaminants layer. Applied external time series are shown as “Connected”. The selected 
connection can be configured, which includes entering a scaling factor to ensure that external data matches 
the magnitude of data currently in the Ecospace environmental contaminants layer. As described in 
Steenbeek et al., the Calculate option scales the average map mean for the first full year of external data to 
the map data loaded in Ecospace. 

• Here, from the list of available connections, select the connection that you wish to apply, and 
click the Apply (green arrow pointing right) button. The connection now appears under the 
list of Connected external data connections. 

• An important aspect is to set a proper scale to ensure that the tracer (e.g., 137Cs) 
concentrations as obtained from external data is properly scaled to the units expected by 
Ecospace. 

• Click Close. 
• Run Ecospace. 
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Overview of EWE Plug-ins 

 

286  |  Overview of EWE Plug-ins



Plugin name Concept Developer Status Category 

Apply Environmental Responses 
Plugin EII EII Prototype UI Extension 

Aquamaps Importer Plugin JRC EII Released Data integration 

Ecological Indicators (EcoIND) EII EII Released Derived 
computations 

Ecosampler Plugin EII EII Released Automation 

Ecotroph plugin Agrocampus 
Ouest 

Agrocampus 
Ouest Released Derived 

computations 

Ecosim Flow Diagram Plugin NOAA NOAA Released Derived 
computations 

Import Export Layers Plugin EII EII Released Data import and 
export 

Merge Split Groups Plugin GEOMAR EII Released Data integration 

Model From Ecosim Plugin UBC UBC Released Data export 

MPA Dynamics Plugin UBC EII Released Automation 

MSE Plugin CEFAS CEFAS Released Automation 

Multi-Sim Plugin DFO Released Automation 

Network Analysis SAMS UBC Released Derived 
computations 

Prebal Plugin UBC UBC Released Derived 
computations 

Remarks Plugin EII EII Released UI Extension 

Results Extractor Plugin CEFAS CEFAS Released Data export 

ShapeGrid Plugin UBC UBC Released UI Extension 

Stepwise Fitting Plugin SAMS SAMS+ EII Released Automation 

Transect Extraction Plugin CEFAS EII Released Data export 

Value Chain UBC UBC Released Derived 
computations 

WoRMS Plugin UBC EII Released Taxonomy search 

FLEM File Reader Plugin UBC UBC Released Data import 

CouplerLib Plugin CEFAS CEFAS + UBC Prototype Model 
interoperability 
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Plugin name Concept Developer Status Category 

Depth Adapter Plugin UBC UBC Internal Data import 

EcoEngineers Plugin UCT EII Project 
deliverable 

Derived 
computations 

Ecospace MonteCarlo Plugin UBC UBC Prototype Automation 

Ecospace NGOMEX Results 
Writer Plugin George Mason UBC Project 

deliverable Data export 

Ecospace ICM Results Writer 
Plugin CSIC EII Project 

deliverable Data export 

Ecospace Sensitivity Analysis 
Plugin UBC UBC Prototype Derived 

computations 

enaR Plugin CNRS EII Prototype Automation 

CSV Map Reader Plugin UBC EII Prototype Data import 

Depletion Recovery Plugin CSIC UBC Project 
deliverable Automation 

Ecospace Fit Plugin UBC UBC Prototype Derived 
computations 

Ecospace Spinup Plugin UBC EII EwE Pro Automation 

FishBase Search Plugin FishBase EII Prototype Taxonomy search 

Import Diets Plugin CSIC EII Prototype Data import 

Key Run Comparison CEFAS UBC Prototype Data import 

Network Analysis R SAMS EII Discontinued Data import 

OBIS Search Plugin JRC EII Prototype Taxonomy search 

Resilience Plugin IPMAR EII Discontinued Derived 
computations 

SAUP Taxon Search Plugin SAUP UBC Prototype Taxonomy search 

Spatial Temporal Data 
Framework Plugin UBC UBC + EII EwE Pro Data import and 

export 

FishMIP2 EII EII Project 
deliverable 

Data import and 
export 

SailCost Plugin UBC UBC Project 
deliverable 

Derived 
computations 

Habitat Capacity Paper Plugin UBC UBC Project 
deliverable Various 
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Plugin name Concept Developer Status Category 

Mejs Hasan Extensions Plugin NOAA EII Project 
deliverable Various 

MSE Batch Plugin UBC UBC Project 
deliverable Automation 

Roberts Bank Plugin UBC UBC Project 
deliverable 

Data import and 
export 

Spatial SS Plugin UBC UBC Prototype Derived 
computations 

MSP Tools Plugin EII EII + BUAS Released UI Extension 

Last Updated in 27 September 2022 
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enaR SCOR Files from Ecospace 

The enaR SCOR file writer can be activated via by making sure the enaRPlugin is included in your 
version of EwE. You can see your loaded Plugins via the EwE’s main menu Tools/Options and 
selecting the Plugins. 

Figure 1 – EwE Plug-ins manager. 

The enaRPlugin will add a menu item to the EwE main menu to toggle file saving on or off 
Ecospace/Save enaR file = On or Off 
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Figure – 2enaR file save menu option. 

The SCOR files will be written to your default output directory, which can be set via the Tools/
Options/File management then setting the Output location. When the plugin is run it will create 
a new directory structure under the default output with the… /{Ecospace scenario 
name}/ena_data/Timestep=000x. Each time step the model is run for will get its own directory. 
Within the timestep directories there will be a file for each Ecospace cell. The naming convention 
for the cell files is ‘nnn{row number}-nnn{column number}-{Ecopath Model Name} –{Ecospace 
Scenario Name}.txt” 

i.e. “0001-0001-Ecopath_Baie_de_Seine_enaR-Test-1.txt” For the first row and column of an 
Ecopath model call “Ecopath_Baie_de_Seine” with the Ecospace scenario “enaR-Test-1”. Rows 
and columns are one base from the upper left hand corner. 
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Glossary 

Anchovy Bay 

Anchovy Bay is a popular tourist attraction due to its century-old fishing port and its newer 
whale-watching industry. The fisheries have declined over the last decades, and have shifted 
from a focus on groundfish to being dominated by shrimp and pelagic fisheries. 

EwE 

The Ecopath with Ecosim (EwE) approach and modeling framework 

Foraging Arena Theory 

Foraging arena theory assumes that predator-prey interactions occur at the scale of hours 
and metres through various behavioural and physical mechanisms potentially restricting prey 
exposure to predation and intensify competition between predators 

Instantaneous rate 

Instantaneous rate is the rate of change of a quantity at an exact moment in time, or at an 
instant. It is the limit of the average rate of change over an infinitesimally small time interval, 
as the time interval approaches zero. The instantaneous rate can be thought of as the slope of 
the tangent line to the curve representing the quantity being measured at a specific point in 
time. In calculus, the instantaneous rate is represented by the derivative of the function with 
respect to time. 

Zero order cycles 
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Versioning history 

We are continuously seeking to improve this open textbook. Please submit your suggestions, 
recommendations, and/or corrections to EII. 

This page lists major changes to this book with major changes marked with a 1.0 increase in the 
version number and minor changes marked with a 0.1 (or lower) increase. 

Version Date Change 

0.1 2023/09/26 • Imported the 2008 EwE6 User’s Guide as a foundation/placeholder for 
this updated User’s Guide 

1.0 2023/x/x • First version of this User’s Guide was published through 
pressbooks.bccampus.ca 
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